ClearQuest – How do I

The ClearQuest “How do I” covers: (Last updated 16-Mar-12)

- **Installation** – silent installs, client for Eclipse, etc...
- **Environment** – default ports, email, etc...
- **Databases** – moving and renaming, etc...
- **Schemas** – export and import, etc...
- **Designer** – copying and pasting list view elements, etc...
- **State Transition Matrix** – Modifying, state types & state transition, etc...
- **Records** – history, action_timestamp, etc...
- **Hooks** – messagebox, global, etc...
- **Methods** – full-text searching, etc...
- **Audit Trail Package** – using and disabling, etc...
- **LDAP** – ClearQuest support, etc...
- **Security groups** - setting requiredness field to mandatory, etc...
- **Queries** – New full text searching, creating – export and import, etc...
- **Charts and reports** – run ClearQuest web, etc...
- **Crystal Reports** – alignment issues, etc...
- **Problems & issues** – LDAP, e-mail, etc...

Table of contents

THE CLEARQUEST “HOW DO I” COVERS: (LAST UPDATED 12-NOV-09)........................................................................................................... 1

TABLE OF CONTENTS.................................................................................................................................................................................. 1

INSTALLATION......................................................................................................................................................................................... 4

1. How do I – understand why all IBM and Rational services must be stopped prior to performing an upgrade......................................................... 4
2. How do I – understand why Rational ClearQuest v7.1 and v7.1.0.1 full-text search settings are not preserved during an upgrade .......................................................... 4
3. How do I – understand why ClearQuest Eclipse RCP client for 7.0.1.x cannot be updated on 64-bit Windows platforms................................................................. 5
4. How do I - install ClearQuest from an external media source prompts for Disk 2 .......................................................... 6
5. How do I - install ClearQuest on a platform that does not use the GUI ...................................................................................... 6
6. How do I – understand the ClearQuest Support for Windows XP SP3, Windows Vista SP1 and SUSE Linux Enterprise Server 10 SP2.................................................................................................................... 7
7. How do I – understand knowledge Collection: Rational ClearQuest 7.1 installation issues ............... 7
8. How do I – understand about third party vendor licenses required for each ClearQuest license ....... 9
9. How do I - manually uninstalling ClearQuest 7.1 on Microsoft Windows ....................................... 9
10. How do I - understand the System Requirements for ClearQuest 7.x.................................................. 10
11. How do I - install ClearQuest UNIX with no user intervention (Silent install) ................................ 14
12. How do I – configure a checklist for the ClearQuest 7.0 Client for Eclipse ................................ 14
13. How do I - deploy and configure IBM Rational ClearQuest 7.0 on Linux ......................................... 16
14. How do I – understand the migration utilities for Rational Quality Manager........................................... 29
15. How do I - run tests in parallel using ClearQuest Test Manager.............................................................. 30
16. How do I – understand the sample response files for IBM Rational ClearQuest........................... 30
17. How do I – understand the TestFix information for ClearQuest 7.x .................................................................................. 30
18. How do I – understand the knowledge collection: Rational ClearQuest 7.1 installation issues........ 31
ClearQuest – How do I

19. How do I – understand the RationalAdminUser user account usage in ClearQuest and Rational Administrator .......................................................................................................................... 32

ENVIRONMENT ................................................................................................................................. 33

20. How do I – understand that changes to user and group administration do not appear in the user database in Multisite ........................................................................................................ 33
21. How do I – understand the ClearQuest 7.1.x client Feature Comparison Matrix .................................. 33
22. How do I – understand Eclipse RCP clients ..................................................................................... 40
23. How do I – understand which API the CQTOOL command for 7.1 uses ........................................... 42
24. How do I – understand optimistic and pessimistic record locking in ClearQuest ............................... 42
25. How do I – use ClearQuest over a WAN ....................................................................................... 42
27. How do I – understand about securing the ClearQuest full-text search service and administration console ................................................................................................................................. 45

28. How do I – understand the issue unable to switch to a valid database within ClearQuest Web .... 49
29. How do I – understand why the calendar selects the wrong month in Web client ....................... 50
30. How do I – change the result set default limit in ClearQuest Eclipse RCP client .......................... 50
31. How do I – understand the Support Policy for ClearQuest with Clusters Database .................. 50
32. How do I – create a global config.pl file setup for the Base ClearCase - ClearCase V2 Integration 51
33. How do I – use of the CQCC_AUTO_ASSOCIATE environment variable in the ClearCase config.pl file 51
34. How do I – understand supported Java versions for ClearQuest .................................................. 51
35. How do I – launch ClearQuest from the command prompt using an argument to bypass the login screen .................................................................................................................................. 52
36. How do I – encrypt database password with Oracle and DB2 ........................................................ 52
37. How do I – understand Error: An error was detected in the middle of upgrading database .......... 53
38. How do I – understand the default ports used by Rational ClearQuest ........................................ 53
39. How do I – understand that ClearQuest 7.0 uses Unicode (UTF-8) for e-mail notification messages 54
40. How do I – set up Round-Trip E-Mail in ClearQuest ..................................................................... 54
41. How do I – understand the times and dates are displayed incorrectly in ClearQuest issue ........ 55
42. How do I – understand where to find information on Rational ClearCase server central caching for ClearQuest transactions in 7.0.1 ........................................................................................ 56
43. How do I – configure the ClearQuest Request Manager service to restart automatically after failure 56
44. How do I – understand about Base ClearCase integration with Rational ClearQuest new centralized cache manager features .................................................................................................. 58
45. How do I – understand the further details regarding the configuration of MAPI on E-Mail notification for ClearQuest Web ................................................................................................. 68
46. How do I – understand about ClearQuest 2003 Mailreader support with MAPI and Microsoft Outlook .................................................................................................................................. 69
47. How do I – configure the MAPI protocol for email with ClearQuest ................................................ 69

DATABASES ........................................................................................................................................ 70

48. How do I – understand about accessing a Microsoft SQL Server database in another domain ...... 72
49. How do I – find sample response files for IBM Rational ClearQuest ............................................. 74
50. How do I – access a test database from the ClearQuest Web Java client ....................................... 74
51. How do I – move ClearQuest databases ....................................................................................... 75
52. How do I – understand the required steps after moving databases without using ClearQuest tools 75
53. How do I – rename the logical database name in ClearQuest ...................................................... 76
54. How do I – index the History table for ClearQuest ...................................................................... 76
55. How do I – Index the History table to increase performance (pre v7.0) ......................................... 77
56. How do I – understand why you must use unique default tables spaces for each of the ClearQuest database Oracle login accounts .................................................................................77
57. How do I – understand why a ClearQuest License is not consumed when a user is logged in via External API Script .................................................................................................................. 77
58. How do I – understand ClearCase and ClearQuest UCM Integration and support for multiple ClearQuest dbsets ........................................................................................................... 78
59. How do I – about PDSQL and how to use it .................................................................................. 78
60. How do I – rename a dbset in for Rational ClearQuest on UNIX-based systems ...................... 79
61. How to unlock a ClearQuest database that has been locked ........................................................ 79

SCHEMAS ......................................................................................................................................... 82

62. How do I – create a Project Record with the ALM Schema .......................................................... 82
63. How do I – export and import ClearQuest schemas ....................................................................... 82
ClearQuest – How do I

64. How do I – understand IBM Rational ClearQuest general schema design performance .............................................. 83

CLEARQUEST DESIGNER .................................................................................................................. 87
65. How do I – understand the availability of the classic Designer in ClearQuest 7.1 ............................................. 87
66. How do I – understand “Potential performance issues with the Rational ClearQuest 7.0 Designer tool” 87

67. How do I – understand the list View IDs are retained when copying and pasting List View form elements issue ............................................................................................................................................. 88

STATE TRANSITION MATRIX ........................................................................................................... 88
68. How do I - modify State Transition Matrix and keep records containing old States and Actions .... 88
69. How do I – understand State Types and State Transitions ................................................................. 89
70. How do I – understand ClearQuest State Diagram Rules .................................................................................. 90

RECORDS ............................................................................................................................................. 91
71. How do I - make sure the parent record is not closed if its child records are still open .................. 91
72. How do I - show the maximum history.action_timestamp for each record ................................. 92
73. How do I - copy an entire record type in ClearQuest ................................................................. 92
74. How do I - display the ClearQuest Record ID with its UCM title and associated change set .... 92
75. How do I – understand why importing incomplete record history can break the History package and Export function ........................................................................................................................................ 93
76. How do I – understand the steps to Export and Import records in ClearQuest ................................................. 93

HOOKS ............................................................................................................................................... 93
77. How do I – create a dynamic pick-lists, dependent choice lists, in ClearQuest ............................ 93
78. How do I – understand the execution order of hooks in ClearQuest .................................................. 94
79. How do I - use MsgBox in Perl hook code ................................................................................... 95
80. How do I – understand about Global Hook Cloning in ClearQuest ..................................................... 95
81. How to send an e-mail notification programmatically using Perl ...................................................... 95

METHODS............................................................................................................................................ 96
82. How do I - copy an entire record type in ClearQuest ........................................................................... 96
83. ' .......................................................................................................................................................... 96

AUDIT TRAIL PACKAGE .................................................................................................................. 96
84. How do I – use the IBM Rational ClearQuest AuditTrail & eSignature Packages ......................... 96
85. How do I - disable the Audit Trail package in ClearQuest ............................................................... 101
86. How do I – understand why using the renaming Submit action and then applying Audit Trail package might cause the ClearQuest Designer to crash ....................................................... 102

LDAP SUPPORT .............................................................................................................................. 102
87. How do – understand reporting on which users are enabled for LDAP Authentication .............. 102
88. How do I - connect to an alternate LDAP host ........................................................................ 103
89. How do I – understand about LDAP Authentication of users in Active Directory Sub Domains using the Global Catalog ........................................................................................................ 103
90. How do I – use LDAP support for secure sockets layer (SSL) in ClearQuest ............................ 104
91. How do I – understand the errors when setting up LDAP authentication for ClearQuest with Active Directory ............................................................................................................................................ 104
92. How do I – understand the steps to Configure LDAP with SSL Connection .............................. 105

SECURITY GROUPS ............................................................................................................................ 105
93. How do I - use of Hook Code to control group access to tabs on a form in ClearQuest .......... 105
94. How do I - set the field requiredness of a security context group to mandatory ....................... 105
95. How do I - setup security context for multiple, different groups ................................................ 107

QUERIES/SEARCHING ...................................................................................................................... 107
96. How do I – understand that full-text search does not extend to attachments ........................... 108
97. How do I - understand the unhandled exception and Java core dump, when indexing for full-text search ............................................................................................................................................. 108
98. How do I – understand the usage of command line interface 'cqtool run_query' in ClearQuest 7.1 109
99. How do I - create a dynamic filter query that would filter on multiple owner login names ....... 109

The Dynamic filter window is now launched and a tab is created for each "Owner.login_name". Type the different Owner name in each tab and select OK. ...................................................... 109

100. How do I - create a query listing active users .............................................................................. 110
101. How do I - export or import more than one query at a time in ClearQuest .................................. 110
102. How do I - create a query on the Duplicates and Duplicate Of fields ........................................ 110
103. How do I – understand Aging Charts - criteria for selection ..................................................... 111
104. How do I - restrict users from editing public queries ................................................................... 111

CHARTS AND REPORTS ....................................................................................................................... 111
ClearQuest – How do I

106. How do I - run Charts and Reports UNIX with ClearQuest Web ............................................ 113

CRYSTAL REPORTS/BIRT .................................................................................................................. 113
107. How do I – understand about the additional support resources for BIRT or Eclipse..................... 113
109. How do I – understand the frequently Asked Questions for Crystal Reports in ClearQuest 7.1 .. 114
110. How do I – understand the incorrect alignment and format of Crystal reports in ClearQuest 7.0 Eclipse client........................................................................................................................................ 116
111. How do I – create a report with running totals in Crystal Reports........................................... 116
112. How do I – understand about the supported Crystal Reports versions for ClearQuest............... 116
113. How do I – understand the formatting problems when exporting a CQ report to Microsoft Word format 117

PROBLEMS & ISSUES .......................................................................................................................... 117
114. How do I – understand why you are unable to clean oplogs produced by full-text search without MultiSite............................................................................................................................................. 121
115. How do I – understand about slow performance in ClearQuest Web 7.1 with Oracle databases121
116. How do I – understand the possible causes and solutions for a 403 error thrown while setting up IBM Rational Quality Manager with the IBM Rational ClearQuest bridge connection.................................. 122
117. How do I – understand the ClearQuest LDAP commands fail when referral chasing is turned on issue 122
118. How do I – understand the resolve E-Mail notification in ClearQuest is not working when port 25 is blocked issue ........................................................................................................................................... 123
119. How do i – understand why the To Groups used by e-mail rules must contain e-mail addresses123
120. How do i – understand the import Tool fails to import the duplicate relationships between defect records issue........................................................................................................................................ 123
121. How do i – understand the changing a reference list when updating multiple records will take all child record values from the first record and add them to the others issue ................................. 124
122. How do i – understand the Error: ClearQuest Eclipse Client Requires a ClearQuest license ...... 124
123. How do i – understand the ClearQuest Submit Date is not capturing the time of day issue...... 124
124. How do i – understand why a ClearQuest installation on RedHat Linux 5 fails............................... 125
125. How do i – understand the remote execution of Robot scripts through CQTM ........................... 125
4.1. How do i – understand that the ClearQuest 7.1 record import is missing information that was collected in previous versions.................................................. 126

Installation

1. How do i – understand why all IBM and Rational services must be stopped prior to performing an upgrade

The install documentation explicitly mentions that the ClearQuest services need to be stopped prior to performing an upgrade. However, all the IBM and Rational Web platform services (including IBM HTTP Server and the WebSphere® Servlets) must also be stopped, as they share common components that may be upgraded as well. Failure to shutdown all the necessary services can result in problems with the installation of the updated program.

Answer
Stop all IBM and Rational services to prior to performing an upgrade.

2. How do i – understand why Rational ClearQuest v7.1 and v7.1.0.1 full-text search settings are not preserved during an upgrade

If you configure and enable the ClearQuest full-text search feature with ClearQuest v7.1 or v7.1.0.1 and then upgrade ClearQuest to v7.1.0.1 or v7.1.0.2, the full-text search feature will not work.

Symptom
Users will see the following error message when they try to search:

ClearQuest v7.1.0.1 client:

Internal error: Status 500; Condition null; Message: Error from RPC server: Internal error: An unknown error occurred during full-text search XML result processing

ClearQuest v7.1.0.2 client:
ClearQuest – How do I

Internal error: Status 500; Condition null; Message: Error from RPC server: Internal error: An unknown error occurred during full-text search execution.
Contact your ClearQuest administrator to verify that the search engine server is properly configured and running.

Cause
This issue is caused by a defect in the IBM Installation Manager. The Installation Manager does not preserve two files during a ClearQuest upgrade.

Resolving the problem
Before an upgrade

To prevent this problem, back up and restore the following two files before you upgrade ClearQuest:

Windows:
- C:\ProgramFiles\IBM\RationalSDL\common\CM\profiles\cqsearchprofile\config\cells\<***Cell>\applications\cqtsdbcrawler.ear\deployments\cqtsdbcrawler\cqtsdbcrawler.war\WEB-INF\web.xml
- C:\ProgramFiles\IBM\RationalSDL\common\CM\profiles\cqsearchprofile\config\cells\<***Cell>\nodes\<***Node>\servers\server1\server.xml

UNIX:
- /opt/ibm/RationalSDL\common\CM\profiles\cqsearchprofile\config\cells\<***Cell>/applications/cqtsdbcrawler.ear\deployments/cqtsdbcrawler/cqtsdbcrawler.war\WEB-INF\web.xml
- /opt/ibm/RationalSDL\common\CM\profiles\cqsearchprofile\config\cells\<***Cell>/nodes\<***Node>/servers/server1/server.xml

After an upgrade

If you have already upgraded ClearQuest, follow these steps to fix the problem:

1. Run setSolrHome.py to re-establish your index location. (For more information, see Establishing the location of the index.)
2. Edit the web.xml file to re-enable Update mode Record Extractor. (For more information, see Configuring continuous indexing.)

3. How do I – understand why ClearQuest Eclipse RCP client for 7.0.1.x cannot be updated on 64-bit Windows platforms

You are unable to update the ClearQuest Eclipse RCP client for 7.0.1.x. The free disk space is reported as "unknown".

Cause
This issue was identified as a product defect under APAR PK74823.

Diagnosing the problem
This occurs on 64-bit versions of Microsoft® Windows® XP (x64), and Windows 2003.

Resolving the problem
This is determined to be a limitation in this client for 7.0.x. The version of Eclipse utilized by the client does not support 64-bit platforms. Starting in ClearQuest 7.1, the client uses a newer Eclipse version that supports 64-bit. Additionally, starting in that release you no longer need to manually update the Eclipse RCP client using the Eclipse interface.

WORKAROUND
To workaround this issue, start the RCP client in compatibility mode by following these steps:

1. Right-click the ClearQuest shortcut in the IBM Rational > Rational ClearQuest program group in the Windows Start Menu and select "Properties"
2. In the resulting window switch to the "Compatibility" tab
3. Select the checkbox labeled "Run this program in compatibility mode for" and choose "Windows XP" from the associated drop-down menu
4. Click OK
5. Start the RCP client and perform the update following technote 1279012
ClearQuest – How do I

6. Once you have completed the update, disable compatibility mode by following steps 1-4, this time de-selecting the checkbox from step 3.

4. How do I - install ClearQuest from an external media source prompts for Disk 2

When you extract the ClearQuest installation files onto a flash drive or DVD, you will be prompted for Disk 2 during the installation process. This occurs in both standard and release area installations, even if all of the files are on the source drive.

Cause
This issue was identified as a product defect under APAR PK42565. It was determined to be a limitation of the Microsoft Standard Installer.

Resolving the problem
To workaround this problem, consider the following alternatives for storing the installation files:

- Use an external hard drive.
- Use a network storage location for a release area.

Copy the files to the local computer.

5. How do I - install ClearQuest on a platform that does not use the GUI

You must use the silent installation process to install IBM Rational ClearQuest on platforms that do not use the graphical user interface (GUI).

Answer
These platforms are:
- HP PA-Risc

Note: For platforms that do use the GUI, follow the installation instructions provided in the IBM Rational ClearQuest Information Center: http://publib.boulder.ibm.com/infocenter/cqhelp/v7r1m0/index.jsp.

To silently install Rational ClearQuest:

1. If the ESD image is not available through a UNC or NFS path:
   a. Copy the ESD Image onto the local machine.
   b. Unzip the ESD image. The path to the ESD image is denoted as esd_image_root

   Note: A DVD image is an ESD image that is unzipped.

2. If the ESD image is available through a UNC or NFS path, copy the file esd_image_root/product_response_platform.xml onto a writeable disk.

3. Open and read the license agreement files located in

   <varname>esd_image_root</varname>/license_agreements. xx indicates the language of the file. The files are:
   * LA_xx
   * L_I_xx
   * non_ibm_license
   * notices

4. Open the response file, product_response_platform.xml.

5. If you agree to the license agreement, change the value for the acceptLicense key to true.

   <agent-input acceptLicense="true">

6. Change the value for the repository location key to 'esd_image_root/diskTag.inf'.

   <server>
   <repository location='esd_image_root/diskTag.inf'/>
   </server>

7. Follow the comments within the response file to configure your product's installation.

8. Open the file esd_image_root/InstallerImage_$platform/install.xml. Find the version key and copy the value. You use this value in the next step. For example:

   <install>
   <offering id='com.ibm.rational.clearquest.platform' version='7.1.0.00-7-1-NR-D09MMDD'/>
   </install>

9. Open the response file. In the <install> command, update the version attribute for the offering key with the value copied from the install.xml file. If the version attribute is not listed for the offering key in the response file, you must add it.
ClearQuest – How do I

<install>
<offering profile='IBM Rational SDLC' version='7.1.0.00-7-1-NR-D09MMDD'
id='com.ibm.rational.clearquest.platform' features='com.ibm.rational.clearquestunix.core,...'/>
</install>

10. If IBM Installation Manager is not installed, you must install it. If an older version of Installation Manager is installed, it must be upgraded. To install Installation Manager that is bundled along with the product or to upgrade the current installed version of Installation Manager, follow the instructions below.
   a. Add the repository location for Installation Manager into the downloaded response file:
   <repository location='esd_image_root/InstallerImage_${platform}'/>
   b. Open esd_image_root/InstallerImage_${platform}/install.xml
   c. Copy the install instruction below into your response file:
   <install>
   <offering features='agent_core,agent_jre' id='com.ibm.cic.agent' version='1.3.0.20090211_1046'/>
   </install>
   d. An example of part of a response file after adding the repository location for Installation Manager:
   <server>
   <repository location='esd_image_root/diskTag.inf'/>
   <repository location='esd_image_root/InstallerImage_${platform}'/>
   </server>
   e. An example of part of a response file after adding the offering keys for Installation Manager:
   <install>
   <offering features='agent_core,agent_jre' id='com.ibm.cic.agent' version='1.3.0.20090211_1046'/>
   <offering profile='IBM Rational SDLC' version='7.1.0.00-7-1-NR-D09MMDD'
id='com.ibm.rational.clearquest.platform' features='com.ibm.rational.clearquestunix.core,...'/>
   </install>

11. Run the command:
esd_image_root/InstallerImage*/install --launcher.ini esd_image_root/InstallerImage*/silent-install.ini -silent -input product_response_platform.xml -log logfile

To display progress text to the console add -showVerboseProgress to the command.

6. How do I – understand the ClearQuest Support for Windows XP SP3, Windows Vista SP1 and SUSE Linux Enterprise Server 10 SP2

This technote provides you with information about the support of Microsoft® Windows® XP SP3, Windows Vista™ SP1, and SUSE® Linux® Enterprise Server (SLES) 10 SP2 for IBM® Rational® ClearQuest®.

Content
ClearQuest versions 7.0.0.3 and 7.0.1.2 introduce support for these operating systems:
- Microsoft Windows XP - Service Pack 3 (SP3)
- Microsoft Windows Vista - Service Pack 1 (SP1)
- SUSE Linux Enterprise Server 10 - Service Pack 2 (SP2)

More information on the current supported platforms and system requirements for ClearQuest can be found in technote 1144624.

7. How do I – understand knowledge Collection: Rational ClearQuest 7.1 installation issues

This technote is intended to supplement the individual product release notes, placing emphasis on important issues that you must be aware of prior to installation.

TABLE OF CONTENTS

All Platforms: Issues affecting all platforms
Windows: Issues affecting Windows platforms
Linux: Issues affecting Linux platforms
Solaris: Issues affecting Solaris platforms
General Information: Installation Information
# ClearQuest – How do I

<table>
<thead>
<tr>
<th>Title</th>
<th>Weblink</th>
</tr>
</thead>
<tbody>
<tr>
<td>All Platforms</td>
<td></td>
</tr>
<tr>
<td>Unable to find a valid license if redundant license servers are specified without a port number during installation</td>
<td>1326944</td>
</tr>
<tr>
<td>Manage Licenses is empty or does not list Rational Team Product in Installation Manager</td>
<td>1328034</td>
</tr>
<tr>
<td>Languages shown on the language selection screen during an installation may not apply to all of a product's components</td>
<td>1327478</td>
</tr>
<tr>
<td>ClearQuest Web Server requires a CM Server</td>
<td>1327152</td>
</tr>
<tr>
<td>Uninstall ClearQuest Eclipse feature plugins before ClearQuest installation</td>
<td>1328354</td>
</tr>
<tr>
<td>Supported Rational integrations with ClearCase and ClearQuest</td>
<td>1329304</td>
</tr>
<tr>
<td>Windows</td>
<td></td>
</tr>
<tr>
<td>Installation of ClearCase or ClearQuest with .NET Integration fails when regedit.exe is not in the PATH environment variable</td>
<td>1327946</td>
</tr>
<tr>
<td>Modifying ClearCase to remove CM Server or uninstalling ClearQuest, RequisitePro, or ProjectConsole fails when Global Monitoring is installed</td>
<td>1327882</td>
</tr>
<tr>
<td>Unable to uninstall or modify a Team Product when files are active</td>
<td>1326602</td>
</tr>
<tr>
<td>Error: The installation directory &quot;C:\Program Files\IBM\RationalSDLC&quot; exists and contains files.</td>
<td>1326166</td>
</tr>
<tr>
<td>Installation of Team Products fails on a machine with Microsoft Terminal Server configured as an Application Server</td>
<td>1321678</td>
</tr>
<tr>
<td>Launchpad exits with an error when run from a UNC path on a Windows 2008 server</td>
<td>1327716</td>
</tr>
<tr>
<td>Reinstall Visual Studio .NET integration after installing a new version of Microsoft Visual Studio .NET</td>
<td>1327132</td>
</tr>
<tr>
<td>Unable to install IBM HTTP Server using a directory with double-byte characters</td>
<td>1326940</td>
</tr>
<tr>
<td>Installation Manager fails to remove files after an uninstallation</td>
<td>1328226</td>
</tr>
<tr>
<td>Unable to connect to database after upgrade</td>
<td>1326627</td>
</tr>
<tr>
<td>Error: File init_masterschema_22.sql not found when creating a new schema repository</td>
<td>1326629</td>
</tr>
<tr>
<td>The Next button is disabled when installing ClearCase and ClearQuest at the same time</td>
<td>1351485</td>
</tr>
<tr>
<td>albd_server.exe cannot find license2.dll on Windows 2000 Advanced Server</td>
<td>1324767</td>
</tr>
<tr>
<td>Linux</td>
<td></td>
</tr>
<tr>
<td>Installing with UMASK set to 77 allows only root to use the product</td>
<td>1326395</td>
</tr>
<tr>
<td>ClearQuest Web site configuration settings cannot be migrated during installation</td>
<td>1323427</td>
</tr>
<tr>
<td>Error: Action GskitAction (install /opt/ibm/RationalSDLC) failed</td>
<td>1327106</td>
</tr>
<tr>
<td>Unable to install ClearQuest if the directory /opt/rational/common exists</td>
<td>1328000</td>
</tr>
<tr>
<td>E-mail Notification is not enabled after installation</td>
<td>1327127</td>
</tr>
<tr>
<td>Solaris</td>
<td></td>
</tr>
<tr>
<td>Installation fails when UMASK is set to 77</td>
<td>1326391</td>
</tr>
<tr>
<td>Installation fails with java.io.IOException: Exit status -1 from command: pkgadd -a ./admin -n -d . gsk7bas</td>
<td>1326526</td>
</tr>
<tr>
<td>Installing with UMASK set to 77 allows only root to use the product</td>
<td>1326395</td>
</tr>
<tr>
<td>ClearQuest Web site configuration settings cannot be migrated during installation</td>
<td>1323427</td>
</tr>
<tr>
<td>Error: Action GskitAction (install /opt/ibm/RationalSDLC) failed</td>
<td>1327106</td>
</tr>
<tr>
<td>E-mail Notification is not enabled after installation</td>
<td>1327127</td>
</tr>
<tr>
<td>General Information</td>
<td></td>
</tr>
<tr>
<td>Sample response files for IBM Rational ClearQuest</td>
<td>1348204</td>
</tr>
</tbody>
</table>
8. **How do I – understand about third party vendor licenses required for each ClearQuest license**

**Required Vendor Licenses**
You need one back-end vendor database license for each ClearQuest license, when using:

- Microsoft® SQL Server,
- Oracle®, and
- IBM DB2®

**No Required Vendor Licenses**
Individual back-end vendor licenses are not required for:

- Microsoft Access, and
- SQL Anywhere

*Note:* SQL Anywhere support is discontinued as of ClearQuest version 2003.06.16.

9. **How do I - manually uninstalling ClearQuest 7.1 on Microsoft Windows**

Certain situations arise that result in the inability to uninstall ClearQuest version 7.1 using Installation Manager. However, the process in this technote can be used to perform a manual uninstall.

**Answer**

*Note: You should skip steps 1 through 4 if ClearQuest Web or CM Server components are not installed. Also skip these steps if other version 7.1 or 7.0.2 Rational products are still installed on the system that are sharing the Web services. This includes RequisitePro (RequisiteWeb), ProjectConsole Web, and ClearCase Web.*

1. Stop the CM Server services.
   a. Open a command prompt.
   b. Change directory to `<clearquest install directory>\common\CM\profiles\cmprofile\bin`
   c. Run `stopserver.bat server1`
   d. Change directory to `<clearquest install directory>\common\eWAS\bin`
   e. Run `wasservice.exe -remove cmprofile`

2. Uninstall Websphere Application Server (WAS),
   a. Change Directory to `<clearquest install directory>\common\eWAS\uninstall`
   b. Run uninstall.exe
   c. Follow the InstallShield prompts to uninstall WAS. Make sure to check the box ‘delete all profiles’.

3. Uninstall IBM HTTP Server (IHS).
   a. Change directory to `<clearquest install directory>\common\IHS\uninstall`
   b. Run uninstall.exe
   c. Follow the install shield prompts to uninstall IHS.

4. Uninstall the IHS Update Installer.
   a. Change directory to `<clearquest install directory>\common\IHS_updateinstaller\uninstall`
   b. Run uninstall.exe
   c. Follow the install shield prompt to uninstall the IHS Update Installer.
ClearQuest – How do I

5. Remove the ClearQuest installation directory.
   a. Execute the command rmdir /q /s <clearquest install directory>
   b. If this fails, skip this step and continue.

6. Delete the registry entries for clearquest
   a. Click Start > Run. Run the command regedit.exe
   b. Delete the registry keys HKEY_LOCAL_MACHINE\software\Rational Software\ClearQuest
      and HKEY_CURRENT_USER\Software\Rational Software\ClearQuest
   c. If there are no other Rational Products installed, delete the keynd
      HKEY_LOCAL_MACHINE\Software\Rational Software\Licensing\2.0

7. Reboot the machine

8. If the install directory removal failed in step 5, try to remove the install directory once again. If this fails, rename the directory

10. How do I – understand the System Requirements for ClearQuest 7.x

GLOSSARY:
Hardware: The Hardware upon which ClearQuest is supported.
Operating System: The operating system which ClearQuest is supported.
Revision: Operating System Patch or Service Release or selected Version on which ClearQuest is supported

ClearQuest 7.x Client, Client for Windows, Eclipse plug-in and ClearQuest Web Server for Microsoft® Windows® environments:

<table>
<thead>
<tr>
<th>Hardware Platform</th>
<th>Operating System</th>
<th>Revision</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Client</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>iSeries xSeries</td>
<td>Microsoft Windows Vista™ Supported Editions: Business, Enterprise, and Ultimate</td>
<td></td>
<td>Both 32 and 64-bit are supported. Full client support in CQ 7.0.1 Limited support in CQ 7.0.0.1 Fix Pack See technote 1252020 for known issues with 7.0.0.1 Note: CQ Web Server not supported</td>
</tr>
<tr>
<td>x86-32</td>
<td>Microsoft Windows XP Professional</td>
<td>SP1, SP2</td>
<td>32 bit support only Note: CQ Web Server not supported</td>
</tr>
<tr>
<td>x86-64 1</td>
<td>Microsoft Windows 2000 Professional</td>
<td>SP4</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Server</th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>iSeries xSeries</td>
<td>Microsoft Windows 2003 Standard Server R2, 2003 Enterprise Server R2</td>
<td></td>
<td>Requires CQ 7.0.1 Both 32 and 64-bit are supported.</td>
</tr>
<tr>
<td>x86-32</td>
<td>Microsoft Windows 2003 Standard Server, 2003 Enterprise Server</td>
<td>SP1 SP2*</td>
<td>* SP2 Requires CQ 7.0.1 Both 32 and 64-bit are supported.</td>
</tr>
<tr>
<td>x86-64 1</td>
<td>Microsoft Windows 2000 Server, Adv Server</td>
<td>SP4</td>
<td>32 bit support only</td>
</tr>
</tbody>
</table>

Footnote 1: x86-64 includes AMD64™ and EM64T™ (Xeon).

ClearQuest 7.x Client, Eclipse Plug-in and ClearQuest Web Server for Linux® environments:

<table>
<thead>
<tr>
<th>Hardware Platform</th>
<th>Operating System</th>
<th>Revision</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>iSeries pSeries</td>
<td>Red Hat Enterprise Linux 4</td>
<td>Initial through Update 4</td>
<td>Update 4 Requires CQ 7.0.1</td>
</tr>
</tbody>
</table>
ClearQuest – How do I

**PowerBlades xSeries**

Support Editions: WS, ES, AS

(Initial). CQ 7.0 and 7.0.0.1 support Initial and Update 1

**Red Hat Enterprise Linux 5** is not yet supported. RFE RATLC01002549

Additional setup notes for CQ Web 2

---

### Supported Editions: WS, ES, AS

- **IBM AIX 5.3 Power 4**
- Requires Minimum Maintenance Level (ML) 1

- **IBM AIX 5.2 Power 4**
- Requires Minimum Maintenance Level (ML) 2

- **IBM AIX 5.1 Power 4**
- Requires Minimum Maintenance Level (ML) 7

---

**SUSE Enterprise Linux 10**

- SP1

**Red Hat Enterprise Linux 4**

- Update 4

CQ Web Server only Requires CQ 7.0.1

**Red Hat Enterprise Linux 5** is not yet supported. RFE RATLC01002549

Additional setup notes for CQ Web 2

---

### Supported Editions: WS, ES, AS

- **IBM AIX 5.3 Power 4**
- Requires Minimum Maintenance Level (ML) 1

- **IBM AIX 5.2 Power 4**
- Requires Minimum Maintenance Level (ML) 2

- **IBM AIX 5.1 Power 4**
- Requires Minimum Maintenance Level (ML) 7

---

**SUSE Enterprise Linux 8**

- SP4

### Additional notes:

- Footnote 1: x86-64 includes **AMD64** and **EM64T** (Xeon).
- Footnote 2: Preparing RHEL 4 for the installation of WebSphere Application Server V6.0.1 and V6.0.2 products, reference 1267118.

---

### Footnotes:

- Footnote 1: x86-64 includes AMD64 and EM64T (Xeon).
- Footnote 2: Preparing RHEL 4 for the installation of WebSphere Application Server V6.0.1 and V6.0.2 products, reference 1267118.
ClearQuest – How do I

<table>
<thead>
<tr>
<th>ClearQuest – How do I</th>
<th>you must apply APAR YY41942</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>HP PA-RISC</strong></td>
<td>HP-UX versions 11.i v1 (11.11) and 11.i v2 (11.23a), GoldQPK11i and Bundle11i</td>
</tr>
<tr>
<td></td>
<td>HP client and server support on PA-PISC platforms added in IFIX01 for 7.0.0.0 (see Fix Pack 1 (7.0.0.1)) Support for Oracle 9i, Oracle 10 (32 bit) and DB2 8.1.x &amp; 8.2.x</td>
</tr>
<tr>
<td><strong>HP IPF (Itanium)</strong></td>
<td>11iv2 (11.23)</td>
</tr>
<tr>
<td></td>
<td>HP Itanium 11iv2 (11.23) is only supported as a database server platform for DB2 and Oracle Note: Not supported as a ClearQuest client platform HP Itanium 11iv3 (11.31) is not yet supported. RFE RATLC00994931</td>
</tr>
</tbody>
</table>

**Eclipse versions for the ClearQuest Client for Eclipse:**

<table>
<thead>
<tr>
<th>Version</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Eclipse</td>
<td>3.2.2</td>
</tr>
<tr>
<td></td>
<td>3.2</td>
</tr>
<tr>
<td></td>
<td>3.1.x</td>
</tr>
<tr>
<td></td>
<td>3.0x</td>
</tr>
</tbody>
</table>

**Plug-in support for IDE integrations:**

<table>
<thead>
<tr>
<th>Product</th>
<th>Version</th>
<th>Revision</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Microsoft Visual Studio (.NET)</td>
<td>2005 (8.0)</td>
<td>SP1</td>
<td>SP1 support requires CQ 7.0.1</td>
</tr>
<tr>
<td></td>
<td>2003 (7.1)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>2002 (7.0)</td>
<td>SP2</td>
<td></td>
</tr>
<tr>
<td>IBM Rational Software Development Platform</td>
<td>7.0</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>6.0</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Hosted development environments:**

<table>
<thead>
<tr>
<th>Product</th>
<th>Product version / Operating System</th>
<th>Revision</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows Terminal Services</td>
<td>Microsoft Windows 2003 Enterprise Server SP2 and R2</td>
<td></td>
<td>Support requires CQ 7.0.1 Review 1150000</td>
</tr>
<tr>
<td></td>
<td>Microsoft Windows 2003 Enterprise Server SP2</td>
<td></td>
<td>Review 1150000</td>
</tr>
<tr>
<td></td>
<td>Microsoft Windows 2000 Advanced Server SP4</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Citrix</td>
<td>Citrix MetaFrame 3, 4, MetaFrame XP</td>
<td></td>
<td>CQTM support requires Fix Pack 3 (7.0.0.1) Review 1117437</td>
</tr>
<tr>
<td>VMware</td>
<td>ESX, GSX, Workstation</td>
<td></td>
<td>Review 1180182</td>
</tr>
<tr>
<td>Virtual PC</td>
<td>2004</td>
<td></td>
<td>Review 1228619</td>
</tr>
</tbody>
</table>

**Supported Database Servers for a ClearQuest 7.x Environment**

**Note:** All database versions and editions (both 32 and 64 bit) are supported on Windows, AIX, Solaris and Linux operating systems according to vendor platform requirements unless otherwise noted. Databases on HP-UX are supported as noted in the table below. **Note:** Mainframe database support for DB2 databases on Linux x86 - RHEL 3 (Update 6) and 4 (Update
ClearQuest – How do I

3) IA-32 for S/390® zSeries® (server for DB2 only), pSeries® (server for DB2 only), AMD64 and EM64T.

<table>
<thead>
<tr>
<th>Database Product</th>
<th>Product version</th>
<th>Revision</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Microsoft SQL Server</td>
<td>SQL Server 2005</td>
<td>SP1</td>
<td></td>
</tr>
<tr>
<td></td>
<td>SQL Server 2000</td>
<td>SP2, SP3, SP4</td>
<td></td>
</tr>
<tr>
<td></td>
<td>SQL Server 7</td>
<td>SP4</td>
<td></td>
</tr>
<tr>
<td>Oracle</td>
<td>Oracle 9.2</td>
<td></td>
<td>HP Itanium 11iv2 (11.23) is a supported database server platform for Oracle 9i</td>
</tr>
<tr>
<td></td>
<td>Oracle 10.x</td>
<td></td>
<td>HP Itanium 11iv2 (11.23) is a supported database server platform for Oracle 10g</td>
</tr>
<tr>
<td>IBM DB2</td>
<td>UDB 9.1</td>
<td></td>
<td>Requires CQ 7.0.1 HP Itanium 11iv2 (11.23) is a supported database server platform for DB2 9.1</td>
</tr>
<tr>
<td></td>
<td>Restricted Enterprise Edition v9.1</td>
<td></td>
<td>Requires CQ 7.0.1 Note: Bundled Enterprise Edition</td>
</tr>
<tr>
<td></td>
<td>DB2 Express-C v9.1</td>
<td></td>
<td>Requires CQ 7.0.1 See technote 1238520 for limitations in the Community version of DB2-Express</td>
</tr>
<tr>
<td></td>
<td>UDB 8.1.x</td>
<td></td>
<td>HP Itanium 11iv2 (11.23) is a supported database server platform for DB2 8.1</td>
</tr>
<tr>
<td></td>
<td>UDB Components for Rational Products v8.1</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>UDB 8.2.x</td>
<td></td>
<td>HP Itanium 11iv2 (11.23) is a supported database server platform for DB2 8.2</td>
</tr>
<tr>
<td></td>
<td>UDB Components for Rational Products v8.2</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>DB2 Express-C v8.x</td>
<td></td>
<td>See technote 1238520 for limitations in the Community version of DB2-Express</td>
</tr>
<tr>
<td>Microsoft Access</td>
<td>2003</td>
<td>SP1</td>
<td>Supported as a non-production database for all Windows operating systems.</td>
</tr>
<tr>
<td></td>
<td>2002</td>
<td>SP1, SP2</td>
<td></td>
</tr>
</tbody>
</table>

ClearQuest 7.x Supported Web Browsers

<table>
<thead>
<tr>
<th>Web Browser</th>
<th>Browser Version</th>
<th>Revision</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>FireFox</td>
<td>2.0</td>
<td></td>
<td>Requires CQ 7.0.1</td>
</tr>
<tr>
<td></td>
<td>1.07 and 1.5.x</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Mozilla</td>
<td>1.6 and 1.7</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Microsoft InternetExplorer</td>
<td>6</td>
<td>SP1, SP2</td>
<td></td>
</tr>
<tr>
<td></td>
<td>7</td>
<td></td>
<td>IE 7 support</td>
</tr>
</tbody>
</table>
11. How do I - install ClearQuest UNIX with no user intervention (Silent install)

To install ClearQuest 2003 on UNIX with no user intervention, follow these steps:

1. Log in as user root.
2. Change directories into the release area, to the install subdirectory.
3. Run the following command:

   ```bash
   ./install_release -echo_cmd_only -force
   ```

   This will run through all the questions needed to complete an installation, but will stop before any action is taken.

   **Note:** The `-force` option is added because if you are trying this on a system that already has ClearCase installed, it's likely that a regular installation will detect that everything is already up to date, and thus fail to ask you anything.

   When the script stops, it will display the complete installation command with full switches that reflects the options that the user selected.

   For example:

   ```bash
   ```

   You can run this command to install the product, but first, you need to add the `-no_query` switch to the end of the command line.

   If you do not add this switch, you will be asked at least 2 questions to confirm the list of selected products and to confirm installation of the product.

   **Note:** The script will first attempt to shutdown ClearQuest just like any other installation. If the shutdown fails, it may not be able to complete the installation, thus user intervention will be required. Aside from that, running this command with the addition of the `-no_query` option will run through a complete installation of ClearQuest on UNIX with no user intervention.

12. How do I - configure a checklist for the ClearQuest 7.0 Client for Eclipse

The following instructions summarize the steps necessary to install and configure the ClearQuest® 7.0 client for Eclipse. For complete instructions, refer to the IBM Rational ClearQuest and ClearQuest MultiSite Install and Upgrade Guide.

The ClearQuest Client for Eclipse is supported on Eclipse versions 3.0.x and 3.1. However, the Rational ClearQuest Test Manager feature is supported only on Eclipse version 3.0.2.

**Note:** The ClearQuest Client for Eclipse does require a full install of the ClearQuest Client. The ClearQuest Plug-in is stored locally as part of the client installation. An updated version of the plug-in is also available when using the IBM Installation Manager and Rational Functional Tester.

**Summary for Eclipse 3.2**

The ClearQuest Client for Eclipse 7.0.0.1, Plug-in only, is supported in Eclipse 3.2. The installation of the ClearQuest 7.0.0.1 Plug-in with Rational Functional Tester (RFT) 7.0.0.1 has been simplified by the newly added support for the IBM Installation Manager. See download document 4014742 for RFT for instructions on installing the ClearQuest 7.0.0.1 Plug-in with the IBM Installation Manager.

**Summary for Eclipse 3.1 with IBM Installation Manager**

The installation of the ClearQuest 7.0.01 Plug-in with Rational Functional Tester (RFT) has been simplified by the newly added support for the IBM Installation Manager. See download document 4014742 for RFT for instructions on installing the ClearQuest 7.0.0.1 Plug-in with the IBM Installation Manager.

**Summary for Eclipse 3.1 without IBM Installation Manager**
The ClearQuest 7.0.x Plug-in can still be installed without the IBM Installation Manager using the following instructions:

   **Note:** For instructions to install Eclipse, see the Documentation and Help available at, [http://www.eclipse.org/documentation/main.html](http://www.eclipse.org/documentation/main.html)
   1. Select **All versions** to find the 3.1 version.
   2. Under **Latest Releases** section, click on 3.1.
   3. Under **Eclipse SDK** section, Click on the **ftp** link to download the SDK.
   4. After the download is complete, unzip into an new eclipse directory such as C:\eclipse.

   1. Click on the download package for **emf-sdo-xsd-SDK-2.1.1.zip** to download the EMF runtime.
   2. Extract the files to your **Eclipse** directory.
   3. When Eclipse and EMF downloads are complete, start your Eclipse client.

C:\eclipse\eclipse.exe

3. Install the ClearQuest plug-in.
   1. In Eclipse, click **Help > Software Updates > Find and Install.**
   2. In the window that opens, select **Search for new features to install** and click **Next**.
   3. Click **New Local Site**.
   4. Navigate to the \eclipse directory in C:\Program Files\Rational\ClearQuest\eclipse and click **OK**. (On Linux and the UNIX system, navigate to /opt/rational/clearquest/eclipse).
   5. Select the check box next to the local site that you just created and click **Finish**.
   6. After clicking **Finish**, a window opens in which you can modify the display name for the site if you choose.
   7. Verify that the check box next to Rational ClearQuest is selected. **Note:** If you choose to continue with all the plug-ins selected, some of them may require additional configuration. For more information regarding the **Rational ClearQuest Test Manager** plug-in, see Chapter 16, **Using Rational ClearQuest Test Manager in the IBM Rational ClearQuest and ClearQuest MultiSite Install and Upgrade Guide**.
   1. The **IBM Rational ClearQuest Common Base Event Log Handler** plug-in requires the plug-in TTPP 3.0.0, which can be downloaded from [http://www.eclipse.org/ftp/home/downloads/drops/3.3.0.html](http://www.eclipse.org/ftp/home/downloads/drops/3.3.0.html). The **Rational ClearQuest OLE Attachment Support** plug-in does not require any additional configuration. This plug-in is only available on Windows.
   8. Click **Next** after you have selected your plug-ins.
   9. Click to **Accept the terms in the license agreement** and click **Next**. If you do not accept the license agreement, the installation terminates.
   10. Verify the optional plug-ins and clear any that you do not want to install. Click **Next**.
   11. Accept the default installation location and add any additional install locations if necessary. Click **Finish**.
   12. If you receive any warnings about installing an unsigned feature during the installation process, select **Install**.
   13. After the installation finishes, restart Eclipse for the changes to take effect.
   14. After Eclipse restarts, switch to the **ClearQuest** perspective. Select **Window > Open Perspective > Other** and select **ClearQuest** from the window that opens.

### Summary for Eclipse 3.0.2

   **Note:** For instructions to install Eclipse, see the Documentation and Help available at, [http://www.eclipse.org/documentation/main.html](http://www.eclipse.org/documentation/main.html)
   1. Select **All versions**
   2. Under **Latest Downloads** section, click link for **archived builds**, to find the 3.0.2 version.
   3. Under **Archived Releases** section, click on 3.0.2
   4. Under **Eclipse SDK** section, click on download package for Windows.

   1. Click on the download package for **emf-sdo-xsd-SDK-2.0.2.zip** to download the EMF runtime.
   2. Extract the files to your **Eclipse** directory.
   3. When Eclipse and EMF downloads are complete, start your Eclipse client.

C:\eclipse\eclipse.exe

3. **Install the ClearQuest plug-in.**
   1. In Eclipse, click **Help > Software Updates > Find and Install.**
   2. In the window that opens, select **Search for new features to install** and click **Next**.
   3. Click **New Local Site**.
   4. Navigate to the \eclipse directory in C:\Program Files\Rational\ClearQuest\eclipse and click **OK**. (On Linux and the UNIX system, navigate to /opt/rational/clearquest/eclipse).
ClearQuest – How do I

5. Select the check box next to the local site that you just created and click Finish. Note: After clicking Finish, a window opens in which you can modify the display name for the site if you choose.

6. Verify that the check box next to Rational ClearQuest is selected. Note: If you choose to continue with all the plug-ins selected, some of them may require additional configuration.

7. For the Rational ClearQuest Test Manager plug-in, see “Using Rational ClearQuest Test Manager” on page 163. Note: The IBM Rational ClearQuest Common Base Event Log Handler plug-in requires the plug-in TPTP 3.3.0, which can be downloaded from http://www.eclipse.org/tptp/home/downloads/drops/3.3.0.html. Note: The Rational ClearQuest OLE Attachment Support plug-in does not require any additional configuration. This plug-in is only available on Windows.

8. Click Next after you have selected your plug-ins.

9. Click to Accept the terms in the license agreement and click Next. If you do not accept the license agreement, the installation terminates.

10. Verify the optional plug-ins and clear any that you do not want to install. Click Next.

11. Accept the default installation location and add any additional install locations if necessary. Click Finish.

12. If you receive any warnings about installing an unsigned feature during the installation process, select Install.

13. After the installation finishes, restart Eclipse for the changes to take effect.

After Eclipse restarts, switch to the ClearQuest perspective. Select Window > Open Perspective > Other and select ClearQuest from the window that opens.

13. How do I - deploy and configure IBM Rational ClearQuest 7.0 on Linux

This guide explains how to install and configure IBM® Rational® ClearQuest® Version 7.0 on the Linux® platform. Although ClearQuest 7.0 provides comprehensive solutions for Linux, as well as for Microsoft® Windows®, deploying and configuring it on Linux is somewhat more difficult. Also, users must upgrade to the current version of ClearQuest to access the existing database. You will also learn how to deploy the ClearQuest Web component on IBM® WebSphere® Application Server rather than on the ClearQuest Web application and get troubleshooting tips for connecting to the database created or configured by previous versions of ClearQuest. This article is intended for readers who have some similar experience on Windows.

Getting started

The IBM® Rational® ClearQuest® Version 7.0 for Linux® installation package is somewhat different from the Microsoft® Windows® version. There are no administration tools, such as the Maintenance Tool, User Administration, and ClearQuest Designer, in the Linux installation package. Therefore, to deploy ClearQuest on Linux, it is necessary to set up a Windows platform for administration purposes.

For the backend database for ClearQuest, we set up an IBM® DB2® database on Linux to use in examples for this article. It is important to be aware that ClearQuest 7.0 includes a driver to access a DB2 server, rather than using the DB2 client that was mandatory in previous releases.

Setup used in these examples

The examples used in this article are based on this setup:

- Databases for ClearQuest 7.0 have been created on Linux and configured through the ClearQuest 7.0 administration tools within Windows. Table 1, which follows, shows the connection information.
- Two existing DB2 databases have been created, in Windows, and configured by the previous ClearQuest previous version, 2003.06.19. The connection information for those is also listed in Table 1.
- IBM WebSphere Application Server is installed on the same Linux machine where ClearQuest 7.0 will be deployed, in this directory: /opt/IBM/WebSphere
- The installation package was not unpacked into the /images/CQ7Install/linux_x86 location, where there are two subdirectories: clearquest and common
- A Rational License issue that existed previously has been resolved. Thus, in preparing examples for this article, we used the remote license server.

<table>
<thead>
<tr>
<th>Platform</th>
<th>Variables</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Linux</td>
<td>Schema repository database name</td>
<td>DB4CQSHR</td>
</tr>
<tr>
<td></td>
<td>User database name</td>
<td>DB4CQUSR</td>
</tr>
<tr>
<td></td>
<td>User account (also DB2 instance name)</td>
<td>db2inst2</td>
</tr>
</tbody>
</table>
ClearQuest – How do I

<table>
<thead>
<tr>
<th></th>
<th>Port for IBM DB2 connection</th>
<th>50001</th>
</tr>
</thead>
<tbody>
<tr>
<td>Microsoft Windows</td>
<td>Schema repository database name</td>
<td>s_cqtm</td>
</tr>
<tr>
<td></td>
<td>User database name in DB2</td>
<td>ur_cqtm</td>
</tr>
<tr>
<td></td>
<td>User account</td>
<td>tester</td>
</tr>
<tr>
<td></td>
<td>Port for DB2 connection</td>
<td>50000 (default)</td>
</tr>
</tbody>
</table>

Deploy ClearQuest 7.0 on Linux
First, set up the installation package in a release area using the command prompt.

Set up a release area
1. Navigate to this directory: /images/CQ7Install/linux_x86/clearquest/install
2. Issue this command: /site_prep
3. At the prompt for the ClearQuest license host, enter the license server address.
4. At the prompt for the HTTP port for Rational Web Platform, use the default value: 80
5. Leave the account name for Rational Web Platform as "nobody."
6. Leave the group name for Rational Web Platform as "nobody."
7. At the prompt to enable e-mail notification, select No.

Note:
The values set in Steps 4, 5 and 6 are not relevant in this article. Simply accept all the default ones to continue the process.

Install ClearQuest components
1. Navigate to /images/CQ7Install/linux_x86/clearquest/install, and issue the .install_release command to begin installation.
2. At the prompt to choose installation methods, select 1: Local Install
3. Enter 1 to accept the license agreement.
4. At the prompt to choose installation operations or models, choose 2: Full-copy
5. Specify the installation folder: /opt/rational for examples in this article
6. Accept the default value for Pathname to the network-wide release directory, which should be the same as what had been set in the release area setup process.
7. At the prompt to select the components to install (see Figure 1), choose these items: ClearQuest and ClearQuest Server. Do not specify 3, ClearQuest Web Application, because you will configure IBM® WebSphere® Application Server for such functionality.

Figure 1. Select components to install
```
1 : ClearQuest
2 : ClearQuest Server
3 : ClearQuest Web Application
a : Select all
f : Finish selection
x : Toggle expanded descriptions
r : Reset selections
q : Quit
```

8. When you have completed the previous steps, you will see asterisks beside items 1 and 2 (see Figure 2) to indicate those items as your choices. Select f: finish selection.

Figure 2. Installation preview
```
* 1 : ClearQuest
* 2 : ClearQuest Server
3 : ClearQuest Web Application
a : Select all
f : Finish selection
x : Toggle expanded descriptions
r : Reset selections
q : Quit
```

9. Specify the License Server at the prompt.
ClearQuest – How do I

10. At the prompt to enable e-mail notification, select No.
11. At the prompt, select Yes to continue installation.
12. Accept the default value for ClearQuest database registry directory. If it does not exist, just accept the default value to create it.
13. Wait until the installation is finished, without errors.

Modify environment variables
1. Before running ClearQuest, it is necessary to add the entries shown in Listing 1 to the Linux login environment in the /root/.bashrc file.

Listing 1. Modify the system environment

```bash
#ClearQuest
export TZ=PRC
export LD_ASSUME_KERNEL=2.4.19
export LD_LIBRARY_PATH=/opt/rational/clearquest/linux_x86/shlib
export MOZILLA_FIVE_HOME=/nowhere
./opt/rational/clearquest/cq_setup.sh
```

2. Log out and log in again to make those variables effective, and then issue the clearquest command to launch ClearQuest on Linux.

Configure the database connection on the ClearQuest client
1. In ClearQuest client, click File > Database > Manage Connections to display the ClearQuest Connection Management panel (Figure 3).

2. In the ClearQuest Connection Management panel (Figure 3), click Add Database to launch the New ClearQuest Database Set options shown in Figure 4.
3. Type the connection name in the Name field (DB4CQ in this example), and, from the drop-down menu, choose DB2 as vendor.
4. Then click Next.
5. In the next window of the New ClearQuest Database Set wizard, specify the server name or IP address for Server field, the schema repository database name for the Database field, the database access account and password, and, essentially, the port option for DB2 connection mentioned in the Assumption section, previously. For this example, as Figure 5 shows, we used these entries:
   - **Server:** 192.068.0.34 (selected from the drop-down menu)
   - **Database:** DB4CQSHR (selected from the drop-down menu)
   - **User Name:** db2inst2
   - **Password:** *******
   - **Connect Option:** port=500001

6. Then click **Finish** to complete creation of the database set.
7. Now, set the connection to user database by highlighting the database set that you just created (DB4CQ in the example that Figure 6 shows), and then clicking **Add Connection**.

8. Leave the **Schema Repository** name as it shows (which is the same as Database Set name), click **Next**, and then specify your **User ID** to access the user database, which is defined in the ClearQuest User Administration tool.

9. Click **Finish** (see Figure 7).
ClearQuest – How do I

Figure 7. New Connection to schema repository

10. Next, choose the user database from the drop-down menu, and type the correct password to log in to the repository (Figure 8).

Figure 8. Connect to user database

Now you are ready to work on the selected user database within ClearQuest.

Deploy and configure the ClearQuest Web client on WebSphere Application Server

In the ClearQuest packages, you can use the Web application included, as the option 3 indicated in Figure 3. However, you might prefer to deploy and configure ClearQuest Web on IBM WebSphere Application Server (WebSphere for short hereafter) for various reasons, such as unified architecture, scalable performance, and so on. For that alternative, follow these steps:

1. Launch the WebSphere Application Server Administration Console on Linux from the main menu, and log in.
2. Under Applications in the directory tree on the left, click Install New Application, as shown as Figure 9.
3. In the Full path field in the middle panel, enter this EAR file name: /opt/rational/clearquest/cqweb/cqwebws.ear
4. Click Next to proceed.
5. Accept all of the default settings (no action required), and click **Step 3, Summary** (see Figure 10).
6. Then click the **Finish** button at the bottom of the Summary page.

7. Next, click **Save** directly to the master configuration” (see Figure 11).
8. In the command console where WebSphere Application Server is installed, navigate to the Classes directory:
   `/opt/IBM/WebSphere/AppServer/profiles/AppSrv01/installedApps/localhostNode01Cell/RationalClearQuestWeb.ear/CQWebModule.war/WEB-INF/classes`

9. Modify the `common.properties` file to specify the properties shown in Listing 2.

Listing 2. Modify the `common.properties` file

```properties
CQ_WEB_SERVER_NAME=localhost
PROPERTIES_DIR=/opt/IBM/WebSphere/AppServer/profiles/AppSrv01/installedApps/localhostNode01Cell/RationalClearQuestWeb.ear/CQWebModule.war/WEB-INF/classes
UPLOAD_DIR=/opt/IBM/WebSphere/AppServer/profiles/AppSrv01/installedApps/localhostNode01Cell/RationalClearQuestWeb.ear/CQWebModule.war/htdocs/cqattachments
DOWNLOAD_DIR=/opt/IBM/WebSphere/AppServer/profiles/AppSrv01/installedApps/localhostNode01Cell/RationalClearQuestWeb.ear/CQWebModule.war/htdocs/cqchtrpts
CHTRPT_DOWNLOAD_DIR=/opt/IBM/WebSphere/AppServer/profiles/AppSrv01/installedApps/localhostNode01Cell/RationalClearQuestWeb.ear/CQWebModule.war/htdocs/cqchtrpts
CHTRPT_DOWNLOAD_URL=/cqweb/htdocs/cqchtrpts
```

10. Return to the administration console.

11. Click **OK** on the **Update global Web Server Plug-In Configuration** view of the WebSphere administrative console (Figure 12) to regenerate the plug-in configuration.
12. Now, restart WebSphere Application Server, and then start the Rational ClearQuest Web application.

13. Verify the Rational ClearQuest Web application deployment on WebSphere by entering the following Web address in your browser, similar to what Figure 18 shows: http://localhost:9080/cqweb/login

Figure 13. ClearQuest Web
Connect to IBM DB2 databases created by previous versions of ClearQuest

When you want to add a connection that is based on the Connection Set to an IBM® DB2® database that was created and configured by a previous version of ClearQuest (2003.06.19, for example), that connection might fail. The reason is that, before ClearQuest 7.0, the database connection in ClearQuest depended on a DB2 client, where the database information was cataloged to a local machine for connecting. It is not a problem that the server name information in the Repository Schema for both master and user databases are the same as their corresponding database names. However, ClearQuest 7.0 no longer needs a DB2 client, because it accesses DB2 database directly, based on the connection information installed in schema repository, including the server name. Thus, the name of that server is essential to the connection.

Therefore, when you use ClearQuest 7.0, use the ClearQuest Maintenance Tool and ClearQuest Designer to update server information for both the schema repository and user database. Such updating will not affect users of previous versions of ClearQuest.

Update the schema repository

1. Launch the ClearQuest Maintenance Tool in Windows, and create a new connection to the Repository Schema for the database in the previous version of ClearQuest, as shown in Figure 14. You will need to complete these fields:
   - Vendor
   - Server
   - Database
   - User Name
   - Password
   - Connect Options (if any, or leave blank)
Figure 14. Create a new connection in the ClearQuest Maintenance Tool

2. When you have finished creating the new connection, notice that the server name for the connection has changed from 9.181.112.59 to s_cqtm, as shown in Figure 15.

Figure 15. Server name changed

3. From the menu, select Schema Repository > Update > Selected Connection.
4. Change the server name from s_cqtm to the IP address or server name where the database is located (in this example: 9.181.112.59), as Figure 16 shows.
5. Click Next.
ClearQuest – How do I

Figure 16. Update server name for Schema Repository

6. Enter the super user name and password (admin for this example), as Figure 17 shows, to proceed.

Figure 17. Super user login information to update

7. Click Done to finish.
8. Now, verify that the server information is correct under Existing Connections (see Figure 18).
Figure 18. Correct server name

ClearQuest Designer in Windows, and choose the connection that you just created in the ClearQuest Maintenance Tool (CQ2003DB in this example).
2. Log in with correct user account and password.
3. From the ClearQuest Designer menu, select Database > Update User Database Properties, choose the user database (logical database) to update, and then click the Properties button.
4. Change the Server name from ur_cqtm to the IP address or server name where the database is located (9.181.112.59 in Figure 19).
5. Click Update.

Figure 19. Update server name for user database

You can verify that the server information is correct, and you can now access the database from the ClearQuest 7.0 client.

Resources

Learn

- To learn more about ClearQuest, try taking one of IBM's ClearQuest courses.
- Online documentation for ClearQuest users and administrators is available at the IBM Software Information Center.
- In the Rational area on developerWorks, get the resources you need to advance your skills in the Rational arena.
ClearQuest – How do I

- Read the article: Configuring ClearQuest to use DB2 as your backend RDBMS, IBM developerWorks (November 2005)
- Read the datasheet for IBM Rational ClearQuest.
- Browse the technology bookstore for books on these and other technical topics.

Get products and technologies
- ClearQuest users and administrators can find more resources in the ClearQuest section of the developerWorks Rational zone, including hooks, Eclipse plug-ins, product documentation, articles and whitepapers.
- Download IBM product evaluation versions and get your hands on application development tools and middleware products from DB2®, Lotus®, Rational®, Tivoli®, and WebSphere®.

Discuss
- Check out the ClearQuest discussion forum on developerWorks Rational.
- Check out developerWorks blogs and get involved in the developerWorks community.

14. How do I – understand the migration utilities for Rational Quality Manager

To leverage the updated versions of the migration utilities download the versions of the utilities-to your client system, and install them as described in the migration section of the online user guide. In the first step of installing each utility the user guide will ask you to copy these files from the RQM server.

Comments
Feedback from the initial use of these tools have shown users should be reminded of several migration idiosyncrasies.

- The version of the client systems used to initiate the migration of data is limited to these versions:
  - IBM ClearQuest Test Management migration must be performed from the ClearQuest Eclipse client version 7.0.1 or newer.
  - IBM Rational Test Manager version 2003.06.15, 2003.06.16, 7.0.0 or 7.0.1
  - IBM Rational Manual Tester version 7.0.1 or newer.

- User need to migrate Rational Manual Tester scripts before migrating references to those scripts from either ClearQuest asset registries or Rational Test Manager projects. Existing test management artifacts can not connect to the scripts that are not available to be referenced. Repeating the test artifact migration after script migration will insert the references where appropriate if the scripts are not migrated first.

- When migrating from ClearQuest the file location in ClearQuest must exactly match the Rational Manual Tester script location for the scripts to align in RQM. In particular if a UNC path name is used in CQTM to refer to the RMT scripts then the same path needs to be used to migrate the RMT scripts to RQM. This path is used to ensure that the scripts align properly in the RQM server.

- In a Rational RequistePro (ReqPro) enabled ClearQuest project there is a RAProject record that contains the ReqPro database information for CQ. One of the fields in this record is the ReqWeb server URL. This needs to be set and the same as the ReqWeb server that RQM will use to integrate with ReqPro for the CQTM requirement integration to be migrated correctly.

In order to migrate defect records associated with ClearQuest Test Manager or Rational Test Manager test artifacts the user must set up the ClearQuest Connector first. Migrated records can only be referenced in the target project if they have been made available through the connector.

Prerequisites
Rational TestManager or Rational ClearQuest Test Manager

Installation Instructions

The installation instructions are available at the following locations:
- IBM ClearQuest Test Management migration utility installation
- IBM Rational Test Manager migration utility installation
- IBM Rational Manual Tester migration utility installation

Download package
RQM Migration tools

<table>
<thead>
<tr>
<th>Download</th>
<th>RELEASE DATE</th>
<th>LANGUAGE</th>
<th>SIZE(Bytes)</th>
<th>Download Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>CQTM migration utility</td>
<td>10/28/2008</td>
<td>US English</td>
<td>322</td>
<td>FTP</td>
</tr>
<tr>
<td>TestManager migration utility</td>
<td>10/28/2008</td>
<td>US English</td>
<td>235</td>
<td>FTP</td>
</tr>
</tbody>
</table>

Cross Reference information

<table>
<thead>
<tr>
<th>Segment</th>
<th>Product</th>
<th>Component</th>
<th>Platform</th>
<th>Version</th>
<th>Edition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Software Development</td>
<td>Rational TestManager</td>
<td>Integrations: IBM</td>
<td>Windows</td>
<td>2003.06.15, 2003.06.16, 7.0, 7.0.1</td>
<td></td>
</tr>
<tr>
<td>Software Development</td>
<td>Rational ClearQuest</td>
<td>CQTM</td>
<td>Windows</td>
<td>7.0.1, 7.0.1.1, 7.0.1.2</td>
<td></td>
</tr>
<tr>
<td>Software Development</td>
<td>Rational Manual Tester</td>
<td>Integrations: IBM</td>
<td>Windows</td>
<td>7.0.1, 7.0.1.1, 7.0.1.2</td>
<td></td>
</tr>
</tbody>
</table>

15. How do I – run tests in parallel using ClearQuest Test Manager

Is it possible to run multiple test suites and configured test cases simultaneously in IBM Rational ClearQuest Test Manager (CQTM)? This functionality is available in Rational TestManager

**Answer**

It is not possible to run parallel tests in CQTM. A request for enhancement, RFE RATLC01247425, exists for this functionality. It is available for viewing on the [RFE Community Web site](http://publib.boulder.ibm.com/infocenter/install/v1r2/index.jsp).

16. How do I – understand the sample response files for IBM Rational ClearQuest

Where can I find a sample response file to install IBM Rational ClearQuest?

**Answer**

The attached response files provide a template for installing IBM Rational ClearQuest on a specific platform. To use the files below, download and modify following the instructions provided within. For more information on using response files, see the IBM Installation Manager Information Center at: [http://publib.boulder.ibm.com/infocenter/install/v1r2/index.jsp](http://publib.boulder.ibm.com/infocenter/install/v1r2/index.jsp)

17. How do I – understand the TestFix information for ClearQuest 7.x

Occasionally, TestFixes are created to help resolve specific customer situations. This technote summarizes which test fixes are fixed, as well as those which are NOT included in the latest FixPacks.

**Rational ClearQuest versions 7.0.1.4 and 7.0.0.5 released February 26th 2009**

**TestFix details for ClearQuest 7.0.1.4**

- 7.0.1.4 TestFixes NOT fixed (click to expand or collapse)
- 7.0.1.4 TestFixes - Fixed (click to expand)

**TestFix details for ClearQuest 7.0.0.5**

- 7.0.0.5 TestFixes NOT fixed (click to expand or collapse)
- 7.0.0.5 TestFixes fixed (click to expand or collapse)

**Rational ClearQuest versions 7.0.1.3 and 7.0.0.4 released November 24th 2008**
ClearQuest – How do I

TestFix details for ClearQuest 7.0.1.3

7.0.1.3 TestFixes NOT fixed (click to expand or collapse)

TestFix details for ClearQuest 7.0.0.4

18. How do I – understand the knowledge collection: Rational ClearQuest 7.1 installation issues

This technote is intended to supplement the individual product release notes, placing emphasis on important issues that you must be aware of prior to installation.

TABLE OF CONTENTS

All Platforms: Issues affecting all platforms

Windows: Issues affecting Windows platforms

Linux: Issues affecting Linux platforms

Solaris: Issues affecting Solaris platforms

HP-UX: Issues affecting HP-UX platforms

General Information: Installation information

<table>
<thead>
<tr>
<th>Title</th>
<th>Weblink</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>All Platforms</strong></td>
<td></td>
</tr>
<tr>
<td>Unable to find a valid license if redundant license servers are specified without a port number during installation</td>
<td>1326944</td>
</tr>
<tr>
<td>Manage Licenses is empty or does not list Rational Team Product in Installation Manager</td>
<td>1328034</td>
</tr>
<tr>
<td>Languages shown on the language selection screen during an installation may not apply to all of a product’s components</td>
<td>1327478</td>
</tr>
<tr>
<td>ClearQuest Web Server requires a CM Server</td>
<td>1327152</td>
</tr>
<tr>
<td>Uninstall ClearQuest Eclipse feature plugins before ClearQuest installation</td>
<td>1328354</td>
</tr>
<tr>
<td>Supported Rational integrations with ClearCase and ClearQuest</td>
<td>1329304</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Window</th>
<th>Weblink</th>
</tr>
</thead>
<tbody>
<tr>
<td>Installation of ClearCase or ClearQuest with .NET Integration fails when regedit.exe is not in the PATH environment variable</td>
<td>1327946</td>
</tr>
<tr>
<td>Modifying ClearCase to remove CM Server or uninstalling ClearQuest, RequisitePro, or ProjectConsole fails when Global Monitoring is installed</td>
<td>1327882</td>
</tr>
<tr>
<td>Unable to uninstall or modify a Team Product when files are active</td>
<td>1326602</td>
</tr>
<tr>
<td>Error: The installation directory &quot;C:\Program Files\IBM\RationalSDLC&quot; exists and contains files.</td>
<td>1326166</td>
</tr>
<tr>
<td>Installation of Team Products fails on a machine with Microsoft Terminal Server configured as an Application Server</td>
<td>1321678</td>
</tr>
<tr>
<td>Launchpad exits with an error when run from a UNC path on a Windows 2008 server</td>
<td>1327716</td>
</tr>
<tr>
<td>Reinstall Visual Studio .NET integration after installing a new version of Microsoft Visual Studio .NET</td>
<td>1327132</td>
</tr>
<tr>
<td>Unable to install IBM HTTP Server using a directory with double-byte characters</td>
<td>1326940</td>
</tr>
<tr>
<td>Installation Manager fails to remove files after an uninstallation</td>
<td>1328226</td>
</tr>
<tr>
<td>Unable to connect to database after upgrade</td>
<td>1326627</td>
</tr>
<tr>
<td>Error: File init_masterschema_22.sql not found when creating a new schema repository</td>
<td>1326629</td>
</tr>
<tr>
<td>The Next button is disabled when installing ClearCase and ClearQuest at the same time</td>
<td>1351485</td>
</tr>
<tr>
<td>albd_server.exe cannot find license2.dll on Windows 2000 Advanced Server</td>
<td>1324767</td>
</tr>
<tr>
<td>ClearQuest LDAP SSL authentication does not support GSKit installed in a non-default location</td>
<td>1326575</td>
</tr>
</tbody>
</table>
19. How do I – understand the RationalAdminUser user account usage in ClearQuest and Rational Administrator

The RationalAdminUser account is a user who belongs to an IBM Rational ClearQuest® database. This user is used by Rational Administrator when setting up a Rational Administrator Project with ClearQuest. This user might present certain security concerns and thus should be activated and deactivated when needed to ensure database security.

**Answer**

**When is this the RationalAdminUser account used?**

The RationalAdminUser is only used when configuring the Rational Administrator Project. Once the project is configured and is working as desired, you can disable the RationalAdminUser user.

**What happens to my integrations if I disable the RationalAdminUser account?**

Normal integration activity such as associating IBM Rational RequisitePro® Requirements to ClearQuest records will work as expected. The configuration of this integration as well as other integrations will still be available with the RationalAdminUser user deactivated.

Rational Administrator Project configuration however, is not accessible when the RationalAdminUser user is deactivated in the ClearQuest User database.

If you attempt to configure your Rational Administrator Project, a login prompt with **RationalAdminUser** as the default user will appear and if you enter the password and attempt to connect you will receive a message stating, "RationalAdminUser" has been deactivated, or Unable to Create Project.

**How does the RationalAdminUser account pose a security risk?**

When the RationalAdminUser user is active, it is possible for users to log into ClearQuest, run queries, and modify records.
How do I disable the RationalAdminUser account?

To disable the RationalAdminUser, open the ClearQuest User Administration and select the database set you are working with. Locate the RationalAdminUser user, right-click and select Deactivate. Once deactivated you will need to perform DB Action > Upgrade and upgrade the user databases RationalAdminUser was subscribed to.

Should I change the RationalAdminUser account’s password?

No. The RationalAdminUser password must remain the default as its hard coded into the Rational Administrator setup and configuration. The password must be the default for the Rational Administrator Project to work correctly.

What if I need to re-administer my Rational Administrator Project?

If you need to make changes to the Rational Administrator Project, you must manually reactivate the RationalAdminUser through ClearQuest User Administration.

Environment

20. How do I – understand that changes to user and group administration do not appear in the user database in MultiSite

If you create new users and groups at a site other than the working master site, these changes do not appear in the user database until you have synchronized with the working master site, performed an upgrade at the working master site, and then synchronized those changes with the replica site.

Resolving the problem

In a ClearQuest MultiSite environment, it is possible to add users at a replica site, however these users will only appear in the schema repository for that site. Any attempt to perform a DB Action -> Upgrade on the user databases located at that replica may result in a pop-up message indicating the action was successful, however the users created at the replica will not be pushed into the user database.

In order for these users to appear in the replica site’s user databases, the following steps need to be taken:

1. A sync packet will need to be generated from the replica site, and then synchronized with the working master site.
2. Once the packet has been synchronized (assuming the sync is error-free), the next step is to login to the User Administration tool at the working master site.
3. After logging in, the users which were generated at the replica site, will need to have their mastership set to the appropriate site (most likely the site from which they were created). It is also good practice to verify their database subscriptions.
4. Next, perform a DB Action -> Upgrade at the working master site to apply the changes.
5. Assuming that there are no errors to report, and that the process completed successfully, the next step is to generate a sync packet from the working master site.
6. Synchronize the sync packet with the replica where the users were created.
7. Following a successful sync at the target replica, those users should now be able to login and work at the replica site.

The following text is from the ClearQuest and ClearQuest MultiSite 2003.06.13 readme file: Changes to user and group administration (2003.06.13, 2003.06.00–6)

As a fix for RATLC00700658 (APAR IC37460, APAR IC37673, APAR IC37674), updates from the schema repository to a user database now occur only at the working master site. Therefore, if you create new users and groups at a site other than the working master site, these changes will not appear in the user database until you have synchronized with the working master site, performed an upgrade at the working master site, and then synchronized those changes back to the replica site.

21. How do I – understand the ClearQuest 7.1.x client Feature Comparison Matrix

<table>
<thead>
<tr>
<th>Capability List</th>
<th>Native Windows Client</th>
<th>Eclipse Plug-in</th>
<th>CQ Client for Eclipse</th>
<th>CQ Web</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ability to resize Windows</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Logon Screen remembers user id</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>No *</td>
<td>Yes</td>
</tr>
</tbody>
</table>

* See technote 1321012 for further information
### ClearQuest – How do I

<table>
<thead>
<tr>
<th>Feature</th>
<th>Yes</th>
<th>No</th>
<th>No</th>
<th>Yes</th>
<th>Yes</th>
</tr>
</thead>
<tbody>
<tr>
<td>List Schema Repositories at login</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>List User Subscribed DBs at login</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Re-authentication on Session Timeout</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Support for caching user password</td>
<td></td>
<td></td>
<td></td>
<td>No</td>
<td>*</td>
</tr>
<tr>
<td>Ability to display context-sensitive help text</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Ability to select dates from a calendar</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Ability to select multiple items in a list box</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Ability to refresh result set</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Refresh only selected item</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Ability to run long running operations in the background</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Eclipse Update Manager for patches</td>
<td>N/A</td>
<td>No</td>
<td>No</td>
<td>N/A</td>
<td></td>
</tr>
<tr>
<td>Ability to login on client startup</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>N/A</td>
<td>N/A</td>
</tr>
<tr>
<td>Ability to view print preview result set</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>Ability to modify header/footer information on print preview result set</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>N/A</td>
</tr>
<tr>
<td>Ability to generate report from query result set</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>N/A</td>
</tr>
<tr>
<td>Ability to view SQL pane in queries</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>Ability to run actions on multiple entities</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>Yes*</td>
</tr>
<tr>
<td>IBM Group 1 Language support Globalization</td>
<td>Yes*</td>
<td>Yes</td>
<td>Yes*</td>
<td>Yes*</td>
<td></td>
</tr>
<tr>
<td>Ability to find recent submissions</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Ability to find recently executed queries</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Ability to find records without executing queries</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Ability to list records recently searched for (Find Record History)</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>CQ Server Load Balancing</td>
<td>N/A</td>
<td>N/A</td>
<td>N/A</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>CQ Web Application Load Balancing</td>
<td>N/A</td>
<td>N/A</td>
<td>N/A</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Welcome Name on Banner</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Schema/User DB on banner</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Toolbar Visual after Login</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Properties on UI</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>CQ Recent Items</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Type ahead capability within</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
</tr>
</tbody>
</table>

* Only available with the Modify action. Request for Enhancement RFE RATLC01289721 exists for the ability to batch update with all actions.

* Localized to Simplified Chinese and Japanese only.

RFE RATLC01289721 exists
## ClearQuest – How do I

<table>
<thead>
<tr>
<th>dynamic query filter list selections</th>
<th>User UI Customization</th>
<th>Capability List</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>No</td>
<td>Native Windows Client</td>
<td>v7.1</td>
</tr>
<tr>
<td></td>
<td>Yes</td>
<td>Eclipse Plug-in</td>
<td>v7.1</td>
</tr>
<tr>
<td></td>
<td>Yes</td>
<td>CQ Client for Eclipse</td>
<td>v7.0.1</td>
</tr>
<tr>
<td></td>
<td>Yes</td>
<td>CQ Web</td>
<td>v7.1</td>
</tr>
</tbody>
</table>

### Record

- **Ability to submit records**: Yes, Yes, Yes, Yes, Yes
- **Ability to modify records**: Yes, Yes, Yes, Yes, Yes
- **Ability to create email rules**: Yes, Yes, Yes, Yes, Yes
- **Ability to modify email rules**: Yes, Yes, Yes, Yes, Yes
- **Support for dependent pick lists**: Yes, Yes, Yes, Yes, Yes
- **Support for non-interactive hook execution**: Yes, Yes, Yes, Yes, Yes
- **Support for internationalization (level 3)**: Yes, Yes, Yes, Yes, Yes
- **Ability to include hypertext in text fields**: Yes, Yes, Yes, Yes, Yes
- **Displays Record Form as Designed in the CQ Designer**: Yes, Yes, Yes, Yes, Yes
- **Form Validation - Identifies required fields before and after submit**: Yes, Yes, Yes, Yes, Yes
- **Record Script Hooks with Form Control Buttons**: Yes, Yes, Yes, Yes, Yes
- **Record Script Hooks with Form Control Context Menu Hooks**: Yes, Yes, Yes, Yes, Yes
- **Record Script Hooks with Actions**: Yes, Yes, Yes, Yes, Yes
- **Field Hooks, Permission Hooks**: Yes, Yes, Yes, Yes, Yes
- **Field Hooks, Default Value Hooks**: Yes, Yes, Yes, Yes, Yes
- **Field Hooks, Choice List Hooks**: Yes, Yes, Yes, Yes, Yes
- **Global Scripts**: Yes, Yes, Yes, Yes, Yes
- **Action Hooks**: Yes, Yes, Yes, Yes, Yes
- **Email Link to Record**: Yes, Yes, Yes, Yes, Yes
- **Support for attachments**: Yes, Yes, Yes, Yes, Yes
- **Ability to print selected record**: Yes, Yes, Yes, Yes, Yes
- **Ability to display records in different windows**: Yes, Yes, Yes, Yes, Yes
- **Ability to find search text in defect**: Yes, No, No, Yes, Yes
- **Spelling Checking the Text fields in a Record**: No, Yes, Yes, No, No
- **Ability to create Web address to form, query report in a named frame or window.**: No, N/A, N/A, Yes, Yes
- **Provide Login URL with userid and password for links to records, queries and reports so that you don’t get prompted for user id and password**: No, N/A, N/A, Yes, Yes
- **Provide URL to specific record using record id instead of internal db id.**: No, N/A, N/A, Yes, Yes
- **Record Script Hooks for Messages and Dialog Boxes**: Yes, Yes, Yes, No, N/A

Regarding this functionality in the client for 7.0.x web clients: See the Using hooks in Rational ClearQuest Web topic in the ClearQuest Information Center. It states you cannot have...
ClearQuest – How do I

<table>
<thead>
<tr>
<th>Field Hooks, Value Change</th>
<th>Yes</th>
<th>Yes</th>
<th>Yes</th>
<th>No</th>
<th>N/A</th>
</tr>
</thead>
<tbody>
<tr>
<td>Field Hooks, Validation,</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>N/A</td>
</tr>
<tr>
<td>Realtime</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Support for dynamic lists</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>(choice lists)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Ability to import/export multiple submit record defaults</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>Duplicate Choose from List</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Ability to configure Print Record functionality</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>N/A</td>
</tr>
<tr>
<td>Build Query in Browse Record Type Dialog for Reference Records</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>N/A</td>
</tr>
<tr>
<td>Ability to find duplicates for selected record</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Ability to open attachments with internal editor</td>
<td>No</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
<td>Eclipse Plug-in Only</td>
</tr>
<tr>
<td>Ability to multi-select records</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Ability to update multi-select records</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Ability to save defaults</td>
<td>Yes</td>
<td>Yes*</td>
<td>Yes*</td>
<td>Yes**</td>
<td>Yes</td>
</tr>
<tr>
<td>Ability to load defaults</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Support for record export to XML</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Select a row in Resultset, and if user pref is &quot;No Split View&quot; then the CQ Record will open in main container tab of Content Pane</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Customized view of CQ Record (Table View), by clicking the Table icon</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Customize the fields to be displayed by clicking the pencil icon during the Table view</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Customization is persisted per Record Type per user</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Right click to access all related records</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>open record in new window</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Records opened in new window can be stacked towards bottom right of screen</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
</tr>
</tbody>
</table>

Regarding this functionality in the client for 7.0.x web clients: See the Using hooks in Rational ClearQuest Web topic in the ClearQuest Information Center. It has a section on "Special considerations for Value Changed field hooks in ClearQuest Web".

<table>
<thead>
<tr>
<th>Capability List</th>
<th>NativeWindowsClient</th>
<th>EclipsePlug-in</th>
<th>CQClientforEclipse</th>
<th>CQWeb</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>v7.1</td>
<td>v7.1</td>
<td>v7.1</td>
<td>v7.0.1</td>
<td>v7.1</td>
<td></td>
</tr>
</tbody>
</table>

Ability to search within query results (CTRL-F) | No | No | No | No | Yes |

Ability to export reports to | Yes | Yes** | Yes** | Yes | Yes | PDF export with Crystal |
<table>
<thead>
<tr>
<th>Feature</th>
<th>CQ 7.0</th>
<th>CQ 7.1</th>
<th>CQ 7.2</th>
<th>CQ 7.3</th>
<th>CQ 7.4</th>
<th>CQ 7.5</th>
<th>CQ 7.6</th>
<th>CQ 7.7</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ability to export reports to other formats (Word)</td>
<td>Yes *</td>
<td>Yes **</td>
<td>Yes **</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Ability to modify query parameters from results set</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Result Set Navigation to go to First or Last Result</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Ability to export results set</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Ability to print results set</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Ability to display results set and record form simultaneously</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Ability to drill down on query results (display parent/child relationships)</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>Support for drill-down in result sets</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>Ability to zoom in on Result Set for easier viewing</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>Configurable result set updating</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>Ability to sort columns in result set</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Suppress field from being displayed in the result set</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Support for displaying multiple query results views</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Ability to reformat results set grid (sort by clicking column title)</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Web customization result set presentation scheme</td>
<td>No</td>
<td>N/A</td>
<td>N/A</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Support for Table Tree View</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>Column Sorting (client side [default]- user pref)</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Column Sorting (Server side - user pref)</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Column Resizing</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Customize Result View by Show/Hide Columns ( pencil Icon)</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
<td>Only available on CQ Web 7.1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Show Multiple Query Result Sets</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Right-Click for Context Menu on result set</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Multi-select by SHFT-Click in result set</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Multi-select by CTRL-Click in result set</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Multi-Select, Right-Click should enable Batch Update</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
</tbody>
</table>

**Notes:**
- **Export options only available when running reports using the Report Server option.**
- **Export options only available when running reports using the Report Server option.**

---

**Navigation**

- Back to top
### ClearQuest – How do I

<table>
<thead>
<tr>
<th>Feature</th>
<th>Native Windows Client</th>
<th>Eclipse Plug-in</th>
<th>CQ Client for Eclipse</th>
<th>CQ Web</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ability to create public queries</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Support for context sensitive functionality</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Ability to modify Workspace ACLs</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Ability to view Workspace ACLs</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Ability to preview Workspace ACLs during edit</td>
<td>No</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Workspace Refresh</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Ability to create new workspace folders</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Right click context menu on folders</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Right click context menu on sub-folders</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Ability to define startup query</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Ability to execute startup query on log in</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Ability to create short cuts (Query, Reports, Charts and Records)</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
<td>Yes*</td>
</tr>
<tr>
<td>Support for context sensitive menus for workspace objects</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes*</td>
</tr>
<tr>
<td>Ability to email query or report expand/collapse folder in navigation area</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes*</td>
</tr>
<tr>
<td>Ability to create charts</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>Yes*</td>
</tr>
<tr>
<td>Ability to drill down on charts</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>Yes*</td>
</tr>
<tr>
<td>Ability to import query from another user</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>N/A</td>
</tr>
<tr>
<td>Ability to execute multiple startup queries on log in</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>Support for viewing and changing mastership of query objects</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>Ability to display multiple databases in a single workspace</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>Ability to drag and drop items</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>Ability to drag and drop in workspace</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Support for workspace restoration after session expiration</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Animation during expand</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Tree area increase/Decrease with nodes</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Tree expand restore to previous state if Error</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Capability List</td>
<td>v7.1</td>
<td>v7.1</td>
<td>v7.1</td>
<td>v7.0.1</td>
<td>v7.1</td>
</tr>
</tbody>
</table>

**Favorites**

- **Add Favorite from Navigator**
- **Remove Favorite**
- **Add Favorite from ResultSet**
- **Modify the Query Definition**
- **Check the Image decorators for items in Favorites**
- **Back to top**
<table>
<thead>
<tr>
<th>ClearQuest – How do I</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>does not effect the link</strong></td>
</tr>
<tr>
<td><strong>Modify the CQ Record does not effect the link</strong></td>
</tr>
<tr>
<td><strong>Properties</strong></td>
</tr>
<tr>
<td><strong>Lt-Click Navigator Item to Load properties for Folder and leaf node</strong></td>
</tr>
<tr>
<td><strong>Execute Query on Navigator to Load Query meta data in properties</strong></td>
</tr>
<tr>
<td><strong>View a CQ Record by clicking the result set to load some of the Record properties</strong></td>
</tr>
<tr>
<td><strong>UI Personalization</strong></td>
</tr>
<tr>
<td><strong>Save the splitter resizing between views</strong></td>
</tr>
<tr>
<td><strong>Customized view of CQ Record (Table View), by clicking the Table icon</strong></td>
</tr>
<tr>
<td><strong>Click on Preferences on Global toolbar</strong></td>
</tr>
<tr>
<td><strong>Hide/ view CQ Properties view using Preferences</strong></td>
</tr>
<tr>
<td><strong>Hide/View Help view using Preferences</strong></td>
</tr>
<tr>
<td><strong>Hide/View Split view of ResultSet and CQ Record</strong></td>
</tr>
<tr>
<td><strong>Persist the number of records viewed in result set</strong></td>
</tr>
<tr>
<td><strong>Display customized record view by default</strong></td>
</tr>
<tr>
<td><strong>Resultset sorting method (client/Server)</strong></td>
</tr>
<tr>
<td><strong>Administration</strong></td>
</tr>
<tr>
<td><strong>Ability to update user profile</strong></td>
</tr>
<tr>
<td><strong>Support for restricted access</strong></td>
</tr>
<tr>
<td><strong>Support for CQ MultiSite</strong></td>
</tr>
<tr>
<td><strong>Support for automatic email notification</strong></td>
</tr>
<tr>
<td><strong>Site Configuration Options</strong></td>
</tr>
<tr>
<td><strong>Provide getlogonstats.asp - LoginName EMail Phone Full Name Total Active Sessions, Empty Sessions, Server PID Restricted vs Non.</strong></td>
</tr>
<tr>
<td><strong>Ability to switch between databases without logging in</strong></td>
</tr>
<tr>
<td><strong>Support for a ClearQuest console containing workspace action history</strong></td>
</tr>
<tr>
<td><strong>Support for administrative functionality</strong></td>
</tr>
<tr>
<td><strong>Toolbar will have two options Configuration and Monitoring</strong></td>
</tr>
<tr>
<td><strong>Configuration will open in Floating pane</strong></td>
</tr>
<tr>
<td><strong>Server Work Thread Count</strong></td>
</tr>
<tr>
<td><strong>Active HTTP Session threshold</strong></td>
</tr>
<tr>
<td><strong>Maximum Active Servers</strong></td>
</tr>
<tr>
<td><strong>Recycle Server Http session Limit</strong></td>
</tr>
</tbody>
</table>
### ClearQuest – How do I

<table>
<thead>
<tr>
<th>Feature Description</th>
<th>Native</th>
<th>Eclipse</th>
<th>CQ Client</th>
<th>CQ Web</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Recycle Server Lifetime Limit</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
<td>Only available on CQ Web 7.1</td>
</tr>
<tr>
<td>Recycle server ONC RPC call Limit</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
<td>Only available on CQ Web 7.1</td>
</tr>
<tr>
<td>View all the active CQ RPC servers with metadata</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
<td>Only available on CQ Web 7.1</td>
</tr>
<tr>
<td>Login Stats (view all active users)</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
<td>Only available on CQ Web 7.1</td>
</tr>
<tr>
<td>Refresh Monitoring screen view</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
<td>Only available on CQ Web 7.1</td>
</tr>
<tr>
<td>Allow CQ Workspace for Restricted User</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
<td>Only available on CQ Web 7.1</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Capability List</th>
<th>v7.1</th>
<th>v7.1</th>
<th>v7.1</th>
<th>v7.0.1</th>
<th>v7.1</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Native Windows Client</td>
<td>N/A</td>
<td>N/A</td>
<td>N/A</td>
<td>Yes</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>Eclipse Plug-in</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>CQ Client for Eclipse</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>CQ Web</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
<td></td>
</tr>
</tbody>
</table>

### REST APIs

<table>
<thead>
<tr>
<th>URLs published to access various use cases in XML or ATOM format</th>
<th>No</th>
<th>No</th>
<th>No</th>
<th>Yes</th>
<th>Only available on CQ Web 7.1</th>
</tr>
</thead>
</table>

### Integrations

<table>
<thead>
<tr>
<th>Integration Description</th>
<th>Native</th>
<th>Eclipse</th>
<th>CQ Client</th>
<th>CQ Web</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Base ClearCase ClearQuest Integration (Native CC to CQ Web)</td>
<td>N/A</td>
<td>N/A</td>
<td>N/A</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>CC UCM support in CQ (Work on action)</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>CC UCM support in CQ (View change sets)</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>CC UCM support in CQ (Synchronization of headlines w/CC)</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>UCM ClearCase ClearQuest Integration (Native CC to CQ Web)</td>
<td>N/A</td>
<td>N/A</td>
<td>N/A</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>RequisitePro integrations Associate a defect with a requirement</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Integration to Microsoft Project</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>Test Manager: Create defect from TestCase</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>N/A</td>
</tr>
<tr>
<td>Test Manager: View defect from TestCase; View TestCase from Defect</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>N/A</td>
</tr>
<tr>
<td>Eclipse/IDE Java integration</td>
<td>N/A</td>
<td>Yes</td>
<td>N/A</td>
<td>N/A</td>
<td>N/A</td>
</tr>
<tr>
<td>Ability to generate SoDA reports</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>N/A</td>
</tr>
</tbody>
</table>

### Fields with an light blue background denote features only available on ClearQuest Web 7.1

**22. How do I – understand Eclipse RCP clients**

Are there any additional configuration steps required to update the IBM® Rational® ClearQuest® (CQ) 7.0.1.x Eclipse® client (RCP) with the latest Fix Pack or iFix?

**Cause**
ClearQuest – How do I

Patching for the ClearQuest Eclipse RCP client in 7.0.1.x now uses the Eclipse update mechanism. This is because Eclipse no longer allows the product installer to automatically update the shell.

This new procedure was initially referenced in the ClearQuest 7.0.1 Release notes. Failure to update the ClearQuest configuration could cause features, such as language translation updates and defect fixes, to not install.

This problem is resolved starting in ClearQuest 7.1, which uses IBM Installation Manager. When the version of ClearQuest is updated, the RCP client is automatically upgraded to reflect that change.

Answer
Follow these directions to assure that the latest version of the RCP client is in use.

1. Start the ClearQuest Eclipse RCP Client.
2. Access the Install/Update section of the Tools -> Preferences screen. Make sure that the Valid updates value is set to compatible. If it is set to equivalent, the client will not recognize the available update.
3. Click OK to save these changes.
4. Access the menu option Help -> Software Updates -> Find and Install.
5. Select “Search for updates of the currently installed features”.
6. Continue through the wizard to install the latest updates for the ClearQuest RCP components. A restart of the client will be required.

Notes:
- This process updates users to the latest version available. If you are not on the latest version of ClearQuest, this can cause a version mismatch and problems might occur. Using a policy file can control the version to which the RCP client upgrades. See technote 1304260 for more information on update policy files.
- If the client is used by multiple users on a Windows computer, the update process might not properly upgrade the client for all users. In this situation, using the RCP Updater command-line utility will update the client for all users.

Assuring connection through a proxy:
If you are behind a proxy, an "Unable to access" error may occur when trying to search for updates.

To avoid this problem, access the Install/Update section of the Tools -> Preferences screen. Make sure that the Proxy settings values have the appropriate proxy information.

Cleaning the ClearQuest RCP Workspace:
In the event that plugin errors occur when trying to access the client, it is possible to "clean" the workspace in an attempt to resolve them. Run the clean command from the RCP directory, like so:

C:\Program Files\Rational\ClearQuest\rcp\clearquest.exe -clean
ClearQuest – How do I

Depending on the configuration state, even starting with the -clean option may not work.

To resolve this, delete the workspace completely. Browse to C:Documents and Settings<user profile>\Rational and delete the \ClearQuest directory. Restart the client and this will get recreated. Then retry updating the plugins per the instructions.

**Using a command line utility for command-line or silent updating of clients:**

A Java™ based utility is available for download that can update the client in a command line format. Commands for this utility are usable in a batch process, allowing for virtually silent updating of the RCP client. The utility and its documentation is in the following download URL:


This tool will update the client to the latest version. It is possible to use the tool with an update policy XML file to control the version of the update process. See [technote 1304260](http://www3.software.ibm.com/ibmdl/pub/software/rationalsdp/clearquest/70/update/rcp/RCP_Updater) for more information on update policy files.

**Related information**

- Creating a local RCP Update Site
- CQ RCP Update fails on 64-bit Windows

---

23. **How do I – understand which API the CQTOOL command for 7.1 uses**

The CQTOOL architecture uses two processes. One is a Perl process that parses the command line. The other is a Java process that utilizes Eclipse. The CQTOOL code in the Perl process uses CM API.

CQTOOL invokes ClearQuest Test Manager (CQTM) using the Eclipse command line. When you run a tmexecute command, the command runs Eclipse in headless mode. All activities with Eclipse are using the standard ClearQuest API.

24. **How do I – understand optimistic and pessimistic record locking in ClearQuest**

By default, ClearQuest uses an Optimistic Locking method. ClearQuest explicitly enforces locks on records while work is being performed on them. This allows multiple users to modify the same record at the same time. This can cause "Race Conditions" to occur.

A Race condition is a condition where multiple users attempt to modify the same record at the same time. The user that saves their changes first wins. The other user gets an error similar to this one:

```
ERROR! Cannot apply the requested changes to the Defect "SAMPL00000003". The record probably has been updated or deleted by another user while you were working on it. (Details: ID = SAMPL00000003, rows = 0, old version = 17, object version = 18, new version = 18)
```

ClearQuest uses the version number of a record to determine if the record has changed since it was open for modification.

Starting in ClearQuest 7.1, a Pessimistic Locking option is available that locks a record in the event that a user is editing it. For more information, see the Optimistic and pessimistic record locking topic in the ClearQuest Information Center for 7.1.

25. **How do I - use ClearQuest over a WAN**

Using the local client software to work with ClearQuest in a WAN environment is not supported. The performance in this environment is likely to be unsatisfactory, and could also cause database corruption if there is a connection problem.

ClearQuest Web and ClearQuest MultiSite are specifically designed for WAN implementations and can be considered as viable alternatives. ClearQuest MultiSite allows ClearQuest clients to work with local replicas of their ClearQuest databases rather than accessing servers in remote locations.

26. **How do I - use Full-Text Searching in ClearQuest 7.1**

This is expanded documentation on how to use the full-text search capability introduced in ClearQuest Web 7.1. It is not in the ClearQuest Information Center, which is a documentation defect tracked with APAR PK79510. This information is available in technote form until it is added to the Information Center.
ClearQuest – How do I

Lucene is an open-source information retrieval library utilized for full-text searching. It has a rich search syntax that is simple yet powerful. It uses industry standard Web-based search syntax, which allows for the searching of ClearQuest records in a manner similar to common search engines using natural language.

Note: ClearQuest 7.1 full-text search syntax is different from a SQL or ClearQuest query. This is important to keep this in mind to understand and utilize this new search feature.

1 Terms

In Lucene, a query is broken up into terms and operators. There are two type of terms, single terms and phrases. A single term is a single word such as "spell" or "login." A phrase is a group of words within double-quotes, such as "spelling error." Multiple terms can be combined with Boolean operators to form a more complex Lucene query. To search for a set of words, simply enter them in the text search field of ClearQuest Web 7.1, along with the Full Text radio button selected.

Note: When searching for a phrase such as "spelling error" or "error spelling" note that these are two unique searches. You will get hits only when the two words, or more exist in the order given in your phrase search.

2 Case Insensitivity

Lucene is case-insensitive by default when executing search terms or phrases. For example, searching for the terms "clearquest", "ClearQuest", and "CLEARQUEST" will all generate the same result set.

3 Fields

When performing a search, you can either specify a ClearQuest field to search within or use the default (when no field is specified). When the default is used, the search is evaluated across all fields. To search within a specific field, use the ":" separator between the field name and the search term.

For example, if you want to search for "spelling" within the "Headline" field (ClearQuest display name) of any record, then use the syntax:

Headline:spelling

To search for a phrase within a field, use syntax:

Headline:"spelling error"

Use caution when performing field specific searches as Lucene treats ClearQuest field display names as case-sensitive. For example, "headline:spelling" is not the same as "Headline:spelling".

Note: A field search like "Headline:spelling error" will result with the term "spelling" being searched within the "Headline" field. The result of this search will be combined as an OR operator (by default) with the result of searching for "error" across all fields. Thus, if you want to narrow down your search such that the term "spelling" and "error" must be contained within the field "Headline", use the following syntax:

Headline:spelling AND Headline:error

or

Headline:(spelling AND error)

4 Term Modifiers

You can modifying query terms to provide a wide range of searching options. When used, they can help broaden or narrow your search syntax to get a better result set.

- Wildcard Searches
  Lucene supports single and multiple character wildcard searches. Use "?" for single character wildcard search and "*" for multiple character. The single character wildcard search looks for terms that match that with the single character replaced. For example, to search for "text" or "test" you can use the search "te?t". Multiple character wildcard searches looks for 0 or more characters. For example, to search for "test", "tests" or "tester", you can use the search "test*".
  You can also use the wildcard searches in the middle of a term.
  Note: The wildcard characters "?" or "*" cannot be used as the first character of a search.

- Fuzzy Searches
  Lucene supports fuzzy searches based on the Levenshtein Distance, or Edit Distance algorithm. To do a fuzzy search use the tilde, "~", symbol at the end of a single word term. For example, to search for a term similar in spelling to "word" use the fuzzy search "word~". This search term will match "wood", "work", "dword", "wordy", "ford", "worf", "warning", etc. It will also match "word".

- Proximity Searches
  Lucene supports finding words that are within a specific distance away from one another. To do a proximity search use the tilde, "~", symbol at the end of a phrase. For example to search for a "clearquest" and "clearcase" within 10 words of each other in a record field, use the search phrase:

  "clearquest clearcase"~10

- Range Searches
  Range searches allow you to match records whose field(s) values are between or inclusive of the lower and upper bound specified by the range search operators. Range searches can be inclusive
ClearQuest – How do I

or exclusive of the upper and lower bounds. Inclusive range searches are denoted by square brackets "[]". Exclusive range searches are denoted by curly braces "{}". A range search may combine the use of inclusive and exclusive operators for example "{} TO ... ]" or "[ ... TO ...)".

The following search term:
SubmitDate:[2007 TO 2008]
... will find records whose SubmitDate fields have values between 2007 and 2008, inclusive. You can narrow it to a specific month, by using:
SubmitDate:[20080101 TO 20081031]
This will find records that are submitted in the month of October, 2008.
SubmitDate:[20080101 TO *)
This will find records that are submitted from October 1st, 2008 through the newest record in the ClearQuest user database.

Range searches are not reserved for date fields. You can also use range searches with non-date fields like so:
Headline:{apples TO blueberries}
This will find all records whose headlines are between "apples" and "blueberries", inclusive of "apples" and exclusive of "blueberries"; you may find a result set of "apples" and "bananas" for example.

- Boosting a Term
Lucene provides a relevancy scoring for matching records based on the terms found, and weighting calculated by the configured analyzers. To boost a term use the caret, "\(^\)", symbol with a boost factor (a number) at the end of the term you are searching on. The higher the boost factor, the more relevant the term will be, and the higher the hit will be in your result set. Boosting allows you to control the relevance of a record by boosting its term. For example, if you are running the following search:
clearquest clearcase
... and you want the term "clearquest" to be more relevant, then boost it using the "\(^\)" symbol along with the boost factor next to the term. You would ultimately use:
clearquest\(^4\) clearcase
This will make records with the term "clearquest" appear more relevant then those with the term "clearcase" in the result set scoring.

You can also boost phrase terms, as in this example:
"clearquest web 7.1"\(^4\) "clearcase 7.1"
By default, the boost factor is 1. Although the boost factor must be positive, it can be less than 1 (For example, 0.2) to lower the relevancy of records that contain the term or phrase.

- Boolean operators
Boolean operators allow terms to be combined through logic operators. Lucene supports AND, "+", "&", OR, "||", NOT, "!", and "-" as Boolean operators. Note
Note: Boolean operators must be ALL CAPS.
OR or ||
The OR operator links two terms or phrases and finds a matching record if either of the terms or phrases exist in a record. This is equivalent to a union using sets. The symbol || can be used in place of the word OR.
To search for documents that contain either "clearquest clearcase" or just "clearquest" use the search:
"clearquest clearcase" clearquest
Note: This assumes the default operator for ClearQuest full-text search is OR. The default can be changed to AND.
You can combine multiple OR or || operators, like so:
"clearquest clearcase" clearquest || 7.1
AND or 

The AND operator matches documents where both terms exist anywhere in the text of a single record. This is equivalent to an intersection using sets. The symbol \&\& can be used in place of the word AND.
To search for records that contain "clearquest" and "clearcase" use the search:
clearquest AND clearcase
You can combine multiple AND or \&\& operators, like so:
clearquest AND clearcase AND 7.1 \&\& web

The "+" operator, also known as the required operator, requires that the term after the "+" symbol exist somewhere in a field of a single record. This can be used in the same way as the AND operator. To search for records that must contain "clearquest" and might contain "clearcase" use the following search:
+clearquest clearcase

NOT or !
The NOT operator excludes records that contain the term after NOT. This is equivalent to a difference using sets. The symbol "!" can be used in place of the word NOT. To search for records that contain "clearquest" but not "clearcase" use the search:
ClearQuest – How do I

clearquest NOT clearcase |clearprompt

Note: The NOT operator cannot be used with just one term or phrase. For example, the following search will return no results:
NOT clearquest

- The "-" operator, also known as the prohibit operator, excludes records that contain the term after the "+" symbol. This can be used in the same way as the NOT operator. To search for records that contain "clearquest" but not "clearcase" use the following:
clearquest -clearcase

- Grouping
Lucene supports using parentheses to group clauses in order to form sub searches. This can be useful if you want to control the Boolean logic for a query. To search for either "clearquest" or "clearcase" and "7.1" use the search:
(clearquest OR clearcase) AND 7.1

- Field Grouping
Lucene supports using parentheses to group multiple clauses to a single field. To search for a headline that contains both the word "clearcase" and the phrase "clearquest web" use the search:
Headline:(+clearcase +"clearquest web")

- Escaping Special Characters
Lucene supports escaping special characters that are part of the search syntax. The current list special characters are:
+ - && || ! ( ) { } [ ] ^ " ~ * : \ 
To escape these characters, use a backslash (\) before the character. For example to search for:
(1+1):2 use the search:
\(1+1):2
To escape a UNC path like "\myhost\my share" use the search:
\\\myhost\\myshare\\

27. How do I – understand about securing the ClearQuest full-text search service and administration console

This technote identifies an issue with IBM Rational ClearQuest. The IBM WebSphere Application Server profile for full-text search requires additional configuration to prevent unauthorized access.

Symptom
The activities in the Securing the Solr Administrative console topic of the ClearQuest Information Center do not prevent access to the WebSphere Application Server administration console or Solr search service.

Cause
This issue has been identified as a product defect under APAR PK93938

Resolving the problem
These directions will provide increased security and prevent unauthorized access to the administration console.

1. On the server where you have installed ClearQuest full-text search (the cqsearchprofile profile), point your Web browser to:

http://localhost:14060/ibm/console

Login when prompted.
ClearQuest – How do I

the "Log in" button. For more information, refer to the Enabling security topic of the WebSphere Information Center.

2. Expand the Servers category.

3. Click on Application servers.

4. In the Application servers screen, click on server1.

5. Access the Configuration tab. In the Container Settings section, expand Web Container Settings.

6. Click on Web container transport chains.
ClearQuest – How do I

Container Settings

- Session management
- SIP Container Settings
- Web Container Settings
  - Web container
    - Web container transport chains
- Portlet Container Settings

7. Click on **WCInboundDefault**.

Application servers

**Application servers > server1 > Web container transport chains**

Use this page to view and manage a transport chain. Transport chains represent network operating within a client or server.

**Preferences**

<table>
<thead>
<tr>
<th>Select</th>
<th>Name</th>
<th>Enabled</th>
<th>Host</th>
<th>Port</th>
</tr>
</thead>
<tbody>
<tr>
<td>☐</td>
<td>WCInboundAdmin</td>
<td>Enabled</td>
<td>*</td>
<td>14060</td>
</tr>
<tr>
<td>☐</td>
<td>WCInboundAdminSecure</td>
<td>Enabled</td>
<td>*</td>
<td>14043</td>
</tr>
<tr>
<td>☐</td>
<td><strong>WCInboundDefault</strong></td>
<td>Enabled</td>
<td>*</td>
<td>14060</td>
</tr>
<tr>
<td>☐</td>
<td>WCInboundDefaultSecure</td>
<td>Enabled</td>
<td>*</td>
<td>14443</td>
</tr>
</tbody>
</table>

Total 4

8. Click on **TCP inbound channel (TCP_2)**.
9. Based on your needs, provide the list of addresses or host name to the exclude and include lists.

Address exclude list

Address include list

192.168.1.2,192.129.2,*

Hostname exclude list

Hostname include list

*.mydomain.sample

In this example, the host IP 192.168.1.2 and the range of hosts at 192.168.2.* are permitted. Also permitted are all hosts within *.mydomain.sample.

Notes:
ClearQuest – How do I

- Refer to the `TCP transport channel settings` topic of the WebSphere Information Center for more information on the syntax for these lists. Pay close attention to the order of values and syntax used in this list.
- Security needs vary by organization. At minimum, include all Change Management (CM) Server hosts that serve ClearQuest Web such that end-users will be able to access the user database and this associated ClearQuest full-text search service. Failure to do so will block users from achieving successful full-text search queries. Hosts might include CM Server hosts at different MultiSite locations (when using a single full-text search service for the family), or a set of load balanced CM Servers.

10. Once you have your list of servers configured, click on the **Apply** button at the bottom of the page. When prompted, click **Save** to apply these changes to the master configuration.

11. Log out from the console. Restart the associated **cqsearchprofile** profile service for the change to take effect.

28. **How do I – understand the issue unable to switch to a valid database within ClearQuest Web**

The following error could occur when trying to select a database using the CQ Web client:

Could not switch database.

**Cause**

There can be several causes of this issue:

1. The password for the user database does not match the password for the schema repository.
   The most likely reason is that the ClearQuest database has not been updated with the user's current password. See your ClearQuest administrator for more information.
2. There are databases that no longer physically exist, but have not yet been "deleted" in the ClearQuest Designer.
3. There is a missing or incorrect IBM® DB2® alias. This problem affects version 2003, which relies on DB2 client software for connectivity.

A fully qualified domain name is not being used in the URL.

**Resolving the problem**

**Resolution to Cause 1**

Perform the following steps:

1. Open ClearQuest Designer.
2. Select **Tools > User Administration**.
3. Select the user account that is not able to switch to the database.
4. Enter the correct password for this account and verify that the proper database is selected under the databases to subscribe the user. Click **OK**.
5. Select **DB Action > Upgrade**. Select the appropriate database and click **OK**.
6. Once the message User database `<logical_database_name>` upgrade successful appears, then you will be able to select the database in ClearQuest Web.

**Resolution to Cause 2**

Perform the following steps:

1. Open ClearQuest Designer.
2. Select **Databases > View User Database Properties**.
3. Look through each database and verify it is still valid.
4. If there are old databases that no longer exist, delete them in the **Databases > Delete User Database** screen.

**Resolution to Cause 3**

Verify that the DB2 aliases applicable to ClearQuest exist and are valid. To create a DB2 alias, perform the following steps:

1. Click **Start > IBM DB2 > Set-up Tools > Configuration Assistant**.
2. In the DB2 Message dialog box, press **Yes**, then, press the **Search the Network** button and press **Next**.
3. Expand the Known Systems folder. If you see the DB2 database server host on which the ClearQuest database resides, expand it and select the database name for which you want to create an alias. Click **Next**.

**Note:** If you do not see the DB2 server host you need, expand the Other Systems folder. If you still do not see the host, talk to your ClearQuest database administrator. There might be a network problem.
ClearQuest – How do I

4. Type an alias name in the Database alias box. Type an optional comment in the Comment box and click Next.
5. Clear the "Register this database for ODBC" option if it is selected. Press Finish.
6. A confirmation dialog box opens. To test access to the DB2 database, press Test Connection and type the user name in the User ID box and password in the Password box.

Note: The DB2 Administration Client must be installed on all hosts.
After the installation is complete, see Creating a DB2 Database Alias on page 138 of the Rational Software Server Products Installation Guide, Creating a DB2 Database Alias.

Resolution to Cause 4
Instead of accessing ClearQuest Web via this URL:
http://server01/cqweb/login

Use a fully qualified host name:
http://server01.myCompany.sample/cqweb/login

29. How do I – understand why the calendar selects the wrong month in Web client

On the 31st of a month, when clicking Next for the month, the month advances in the drop-down list, but the actual calendar does not. This results in a mismatch between the calendar elements, and will result in an incorrect date display when the calendar control closes.

Cause
This issue was identified as a product defect, APARs PK19049 and PK33859

Resolving the problem
This problem is resolved in ClearQuest Web versions 7.0.0.2 and 7.0.1.1.

WORKAROUND:
Click Previous, and then Next again. This will clear the defect, displaying the appropriate month for both the pull-down and calendar.

30. How do I - change the result set default limit in ClearQuest Eclipse RCP client

How can I change the result set limit in the IBM Rational ClearQuest client for version 7.1?

Answer
1. Go to the menu option Window > Preferences
2. Expand ClearQuest and select Advanced
3. Change the Number of Records per page in Query Result View value, as needed

For more information, see the Setting ClearQuest Preferences topic in the ClearQuest Information Center.

31. How do I – understand the Support Policy for ClearQuest with Clustered Database

A database cluster is a virtual database that appears to be on one machine but actually is distributed across a cluster of servers. The only database clustering that ClearQuest currently supports is Oracle RAC. For more information regarding RAC and the ClearQuest versions that support it, refer to technote 1247220.

A request for enhancement, RFE RATLC01035023, exists for support of Microsoft® SQL Server™ database clustering. It is available for viewing on the RFE Community Web site.
32. How do I – create a global config.pl file setup for the Base ClearCase – ClearQuest V2 Integration

Open the ClearCase - ClearQuest Integration Configuration Tool. Note that the Windows® and UNIX Trigger Selection fields are pointing to the default locations of CQCC\config.pl (Windows) and CQCC/config.pl (UNIX). CQCC is an environment variable for the location ...lib\perl5\CQCTrigger\CQCC under the ClearCase install directory on each machine.

To point to a global config.pl, change the Windows and UNIX Trigger selection fields, so that the full explicit path to the global config.pl file is used.

For example, the Windows path would read: \machine_name\exported\directory\config.pl and UNIX could be /exported/directory/config.pl. The key is that both the UNIX and Windows clients need to be able to step down that path to access the global config.pl file. On Windows, this can be accomplished by sharing out the folder \machine_name\exported\directory\. On UNIX this can be accomplished by using an NFS mount to the /exported/directory/. An IT Specialist or a System Administrator will be able to set up this scenario.

33. How do I - use of the CQCC_AUTO_ASSOCIATE environment variable in the ClearCase config.pl file

This Technote describes the use of the CQCC_AUTO_ASSOCIATE environment variable in the IBM® Rational® ClearCase® config.pl file, used with the IBM Rational Base ClearCase / Rational ClearQuest® integration.

Released with the ClearCase version 2002 Patch 15 and contained in all subsequent versions of ClearCase, the CQCC_AUTO_ASSOCIATE allows you to associate many ClearCase elements with one or more ClearQuest records, without manually having to select each of them in the integration user interface.

To specify one or more ClearQuest records to associate with a batch of ClearCase elements without displaying the integration user interface, set the environment variable "CQCC_AUTO_ASSOCIATE" to the associations you want to make, before starting cleartool command or the ClearCase Explorer application.

If enabled at your site, use this option to specify one or more ClearQuest records that you want to associate with ClearCase elements during checkout and checkin operations. The integration uses the ClearCase records that you specify, rather than prompting you ClearQuest record selections through the integration user interface. The "ApplyToAll" button in the integration user interface works only for ClearCase elements being versioned in a single checkin or checkout command. This option lets you handle large batches of ClearCase elements in multiple checkin and checkout commands.

Use the same conventions used in the "Type In" option in the integration user interface to specify ClearQuest records. For example, "SAMPL1,2,3" identifies the ClearQuest records IDs 1, 2, and 3 in the ClearQuest SAMPL user database.

The values you specify remain in effect, until you unset the option, or set it to "". On checkin operations, the integration uses the values you specify with this option to override associations you made on checkouts. Specify "-" to set the option to select no ClearQuest records. If errors occur, the integration displays them, and then starts the integration user interface for associating ClearQuest records.

======== Administrator documentation ================

CQCC_AUTO_ASSOCIATE_ENABLE: [DEFAULT: "TRUE"]

In the config file (config.pl), use this option to specify whether local users may use the CQCC_AUTO_ASSOCIATE option. To prohibit use of the CQCC_AUTO_ASSOCIATE option, set CQCC_AUTO_ASSOCIATE_ENABLE to "FALSE". To allow use of CQCC_AUTO_ASSOCIATE, set CQCC_AUTO_ASSOCIATE_ENABLE to "TRUE".

34. How do I – understand supported Java versions for ClearQuest

The following is a summary of the Java Runtime Environments (JRE) that are shipped with ClearQuest.

<table>
<thead>
<tr>
<th>ClearQuest version</th>
<th>Operating System</th>
<th>JRE Version</th>
</tr>
</thead>
<tbody>
<tr>
<td>7.0.1</td>
<td>All</td>
<td>IBM JRE 1.42 SR7</td>
</tr>
<tr>
<td>7.0.0.1</td>
<td>All</td>
<td>IBM JRE 1.42 SR6</td>
</tr>
<tr>
<td>7.0</td>
<td>All</td>
<td>IBM JRE 1.42 SR2</td>
</tr>
</tbody>
</table>
ClearQuest – How do I

<table>
<thead>
<tr>
<th>2003.06.00 - 2003.06.16</th>
<th>Windows</th>
<th>Sun 1.4.1</th>
</tr>
</thead>
<tbody>
<tr>
<td>AIX® HP-UX Linux® Solaris®</td>
<td>Sun 1.3.1_02</td>
<td></td>
</tr>
<tr>
<td>2002.05.x</td>
<td>All</td>
<td>Sun 1.3.0 Java</td>
</tr>
</tbody>
</table>

Note: Java 1.5 (Java 5) is not supported at this time.

On a Windows installation, the Java JRE is located in the directory:

C:\Program Files\Rational\Common\java\jre\bin

On a UNIX® installation, the Java JRE is located in the directory:

/opt/rational/common/java/jre/bin

To determine the locally assigned Java version, open a command prompt, and navigate to the Java JRE directory. Type the command: java -version and press the ENTER key.

For example the Java version in the ClearQuest 7.0 release returns:

```
java version "1.4.2"
Java(TM) 2 Runtime Environment, Standard Edition (build 1.4.2)
Classic VM (build 1.4.2, J2RE 1.4.2 IBM Windows 32 build cn142-20050609
(JIT enabled: jitm)
```

The Java version in the ClearQuest 2003.06.x release returns:

```
java version "1.4.1_01"
Java(TM) 2 Runtime Environment, Standard Edition (build 1.4.1_01-b01)
Java HotSpot(TM) Client VM (build 1.4.1_01-b01, mixed mode)
```

35. How do I - launch ClearQuest from the command prompt using an argument to bypass the login screen

It is possible to launch ClearQuest from a command prompt and bypass the login screen.

Create a batch file, or another application, that will start up ClearQuest using the command below at the command prompt or called by another application. For example:

```
C:\Program Files\Rational\ClearQuest\clearquest.exe -login admin -password "" -database test -dbset Connection1
```

<table>
<thead>
<tr>
<th>Arguments</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>-login</td>
<td>ClearQuest user name</td>
</tr>
<tr>
<td>-password</td>
<td>ClearQuest password (if the password is blank, use &quot;&quot;)</td>
</tr>
<tr>
<td>-database</td>
<td>Logical Database Name of your target ClearQuest database (five characters)</td>
</tr>
<tr>
<td>-dbset</td>
<td>Connection name that appears in the maintenance tool and shows the connection parameters to your user database.</td>
</tr>
</tbody>
</table>

36. How do I - encrypt database password with Oracle and DB2

When ClearQuest is configured to connect to Oracle, it will pass the Oracle database password to the Oracle database by using a modified 64bit Data Encryption Standard (DES) encryption. Oracle will always use this encrypted password, unless security has been deliberately disabled in the Oracle instance.

**DB2 and ClearQuest 7.0.x**

By default, ClearQuest does not encrypt the database password that is passed to the DB2 server. Beginning with the ClearQuest 7.0.0.1, it is possible to add an additional connect option, **DB2_SECURE_LOGIN**. This parameter will enable an encrypted password be sent to a DB2 server, provided that the DB2 server's authentication method to **SERVER_ENCRYPT**.

Note: The DB2 server must be configured for encryption in order for these parameters to work. For more information on enabling this option on a DB2 server, contact IBM DB2 support. Using this parameter with a DB2 server that is not configured for encryption cause an "ODBC DB2 Wire Protocol driver" error.
ClearQuest – How do I

The 7.0 release of ClearQuest introduced the connect option:
"EXTRA_PARAMS='SecurityMechanism=2'". This option provides the same functionality as the
DB2_SECURE_LOGIN parameter in the 7.0.0.1 release.

Note: Documentation for the DB2_SECURE_LOGIN parameter has not been added to the ClearQuest
Information Centers. This issue has been identified as a product defect logged under RATLC01047233.

DB2 and ClearQuest pre-7.0
In versions of ClearQuest prior to 7.0, DB2 passwords could be encrypted by setting SERVER_ENCRYPT
in the DB2 client on each ClearQuest client. For further information, contact DB2 support.
Note: The DB2 server must be configured for encryption in order for this parameter to work. For more
information on enabling this option on a DB2 server, contact IBM DB2 support.

37. How do I – understand Error: An error was detected in the middle of
upgrading database
The following error has been reported to occur when upgrading Microsoft SQL Server based databases
from ClearQuest:
Error! An error was detected in the middle of upgrading database <user
database name> to the schema <schema name> version <number>:.....
SQL statement"alter table defect add CONSTRAINT fk_16779650 FOREIGN KEY
(analyzer_1) REFERENCES users (dbid)".........
There are no primary or candidate keys in the referenced table 'users' that
match the referencing column list in the foreign key 'fk_16779650'
The database may be in an inconsistent state. The database will be locked
to prevent users from logging on until it is restored from the latest
backup......."
The logfile C:\Doc........upgrade.log may be useful in resolving this
problem.
Cause
Possible causes could be:
1. The table could be corrupt, as described in technote: 1131752.
2. The database configuration was changed after the database was setup.
The database indexes have been removed from the offending table.

Environment
This error is known to occur in Microsoft SQL Server environments.

Diagnosing the problem
If an explicit error message was not given nor was there any in the log, the problem could be with the data
base configuration. If the database permission or role was changed after ClearQuest was setup, there
could be a failure in upgrading the user database with no specific SQL error. Check the database account
that ClearQuest uses.
The only way to determine what indexes need to be added back is to turn on ClearQuest diagnostic
tracing and create a new user database. This way, you can see in the logs what indexes are created for
each table. Then use SQL tools to see if those indexes exist. Contact Rational Support for help in setting
up tracing.

Resolving the problem
This solution is known to resolve this issue if the back-end database vendor is SQL Server.
Make a backup of the schema repository and all the user databases and then move the user database
from SQL Server 2000 to SQL Server 7 and then back to SQL Server 2000 using the ClearQuest Designer.
After that, the upgrade should go through successfully.
If the back-end is SQL Server 2005, move the database. Moving the database rebuilds the indexes, and
this may resolve the problem.

38. How do I – understand the default ports used by Rational
ClearQuest
Licensing:
The default Rational FlexLM Licensing port is 27000.

ClearQuest Web server (Versions 2003.06.13 and later)
The ClearQuest Web application services use the ports defined in the jtl.properties file, as specified in
these parameters:
JTLRMIREGISTRYSERVERS=localhost:1130
ClearQuest – How do I

JTLRMIÇALLBACKPORTS=1140,1142
JTLRMIÇALLBACKFILESERVERPORTS=1141,1143

jtl.properties file locations:
Windows:
C:|Program Files|Rational|ClearQuest|cqweb|cqserver|config|jtl.properties

UNIX:
/opt/rational/clearquest/cqweb/cqserver/config/jtl.properties

Rational Web Platform
The ClearQuest Web Server runs on the IBM Rational Web Platform (RWP), which uses port 80 by
default. The default port for SSL is 443.

The Request Manager component of the ClearQuest server uses ports specified in the jtl.properties (File
specific to RWP), as specified in these parameters:

JTLRMIÇEGISTERYSERVERS=localhost:1130
JTLRMIÇERVICEPORT=1132
JTLRMIÇERVERFILESERVERPORTS=1133

jtl.properties file locations:
ClearQuest version 2003.06.13 to 2003.06.16

For ClearQuest 2003.06.13 to 2003.06.16, the jtl.properties file for the Request manager is located:
Windows:
C:|Program Files|Rational|Common|rwp|webapps|cqweb|WEB-INF|classes\jtl.properties

UNIX:/opt/rational/common/rwp/webapps/cqweb/WEB-INF/classes/jtl.properties

ClearQuest version 7.0

For ClearQuest 7.0 and later, the jtl.properties file for the Request manager is located:
Windows:
C:|Program Files|Rational|Common|rwp|EmbeddedExpress|profiles
|profile1\installedApps\DefaultNode|RationalClearQuestWeb.ear
\CQWebModule.war\WEB-INF\classes

UNIX:
/opt/Rational/Common|rwp|EmbeddedExpress|profiles
/profile1\installedApps\DefaultNode/RationalClearQuestWeb.ear
/CQWebModule.war/WEB-INF/classes

ClearQuest E-Mail:
SMTP: port 25
POP: port 110
MAPI: none

Note: The ClearQuest 7.0 version of E-Mail Reader does not support the MAPI protocol.

Vendor Databases
Databases have their own port usage apart from ClearQuest. For example, the default Microsoft® SQL
Server port is 1433. Unless it is changed to a non-default port, you specify that in the connection
(ClearQuest Maintenance Tool).

39. How do I – understand that ClearQuest 7.0 uses Unicode (UTF-8) for
e-mail notification messages

Beginning in ClearQuest 7.0, e-mail notification uses Unicode (UTF-8) for messages being sent from
ClearQuest. This is a change (especially for our Japanese users) because in ClearQuest 2003 on
Microsoft® Windows® platforms, e-mail notification used the SJIS codepage, if the ClearQuest data
codepage was 932/SJIS.

Note: Prior to the 7.0 release, ClearQuest UNIX® clients and servers only used the ASCII codepage.

40. How do I – set up Round-Trip E-Mail in ClearQuest

You can combine e-mail notification with e-mail submission to update records by using round-trip e-mail.
For example, when a user receives an automatic e-mail notification that a new record has been
submitted, that user can respond with an e-mail message that appends notes to the record in the
database.

Answer

Page 54 of 126
ClearQuest – How do I

To setup round-trip e-mail, it involves enabling the ClearQuest clients for e-mail notification, along with an E-Mail rule and the E-Mail Reader. Refer to the ClearQuest Administrator's Guide for version 2003. In the ClearQuest 7.x release, this information is found in ClearQuest Information Center. Search for the following topics for further information:

1. Using round-trip e-mail
2. Managing Rational ClearQuest e-mail
3. Creating e-mail rules
4. Administering Rational E-Mail Reader

When setting up round trip e-mail, the following tips should help ensure getting round-trip e-mail to work:

1. Make a simple email rule that has Fields to check for change for Headline and that in the From Address field, and tested that both the e-mail rule and E-Mail Reader works.

2. If the E-Mail Reader is not triggering the e-mail notification upon a Submit action, check that the Mail Reader system has the ClearQuest Client installed. If not, the E-Mail Option may be enabled by copying the HKEY_LocalMachine\software\rational software\ClearQuest\<version>\SendMail registry key to the server where the E-Mail Reader exists. For the <version> value, use 2003.06.00 for ClearQuest 2003.x, and 7.0.0 for ClearQuest 7.x.

3. The E-Mail Reader Service caches E-mail Rules. If E-mail Rules change, the E-Mail Reader must be restarted for the changes to take effect.

41. How do I – understand the times and dates are displayed incorrectly in ClearQuest issue

Date_time field values are assumed to be in local time in string representation. All ClearQuest (CQ) clients (native and CQ API) set the values in local time in string format. When setting value for the database, the core invokes FormatGMT to format it into GMT string. The core converts the string value set by the client to GMT time when saving it to the database. In absence of a time value, the core will default to midnight local time and converts it to GMT accordingly.

When adding the submit_date field to your forms, the time may be incorrect. It may show 1/1/70. Or when running queries or reports, the time may be incorrect and may show 7:00:00 GMT or 00:00:00 GMT (12:00 am).

The VB Script Function that is causing this error is the DATE or TIME function, that is used to set the default value. However this is not a problem if we use the NOW function to set the default value. This may be used as a workaround.

If selecting the workaround, this is how it is applied.
Within Rational ClearQuest designer, find the field that has the default Date Value set by going into the Record Type, Select Fields. In the workspace, one will see a grid showing all the fields for the record type. For example, with submitted_date, one will see a column saying Default Values, go down to submitted_date row, it will have a cell saying "Basic,Perl" Double Click on it. It will bring up the code for Perl, close this Perl code window, and the following Basic Script should now be seen;

********************************************
Sub Submit_Date_DefaultValue(fieldname)
  'fieldName As String
  'entityDef = Defect
  REM *** Do not modify the predefined prologue above this line ***

  REM ***TO DO: Add your code here ***

  SetFieldValue fieldname, Date
  ********************************************

Change the line > SetFieldValue fieldname, Date TO
> SetFieldValue fieldname, Now

If using "SetFieldValue fieldname, Date" then the current date is displayed but the default time of 7:00 AM GMT instead of the current time is displayed. If no time is specified in the database (often in the
ClearQuest – How do I

case of imported data), then ClearQuest sets 12:00:00am (midnight) as the time.

If using "SetFieldValue fieldname, Time" then the current time is displayed but the default date of 1/1/70 instead of the current date is displayed.

Therefore, the best solution is to use "SetFieldValue fieldname, Now"

If you are using dates only, you can create a SQL Query that would add a 12:00 pm (noon) timestamp to all records in the date/time field. If applying the times as well, it is important to understand what is happening to the dates as this cannot be modified.

Time is stored at Greenwich Mean Time (GMT). The Pacific time zone is -8 GMT with an hour reduced to observe Daylight Savings time for -7 in the summer and -8 in the winter. Systems west of GMT will have the time displayed as a later value than those to the east.

The Rational ClearQuest Client adjusts any displayed values such that it reflects the correct local time based on the local settings.

The web differs in that the times displayed are local to the webserver and then stored as GMT.

42. How do I – understand where to find information on Rational ClearCase server central caching for ClearQuest transactions in 7.0.1

Central server-side cache for Rational ClearQuest transactions supported in the Base Rational ClearCase and Rational ClearQuest integration

In this release, the integration between Base Rational ClearCase and Rational ClearQuest monitors a central server-side cache repository to process unposted Rational ClearQuest transactions and to remove stale cache files and directories.

For details about configuring and using the central server-side cache in the Base Rational ClearCase and Rational ClearQuest integration refer to the following document SC23-7648-00 (see below)

43. How do I – configure the ClearQuest Request Manager service to restart automatically after failure

IBM® Rational® ClearQuest® Request Manager can be unresponsive under special conditions in ClearQuest version 2003.06.15. This technote provides details on scheduling a pro-active stop and restart of the Request Manager.

Note: An updated cqboot.vbs file for ClearQuest 2003.06.15 has been added as an attachment to this solution.

Cause

When you use the ClearQuest Web in an environment that has a very high transaction rate, the ClearQuest Request Manager service running on the server may unexpectedly stop. If it does stop, any non-saved edits will be lost.

This problem occurs only when the Request Manager is hosted on a Microsoft® Windows® platform.

Solution

Configuring ClearQuest Request Manager service:

To work around this problem, IBM Rational software Customer Support recommends that, depending on your environment, either you configure ClearQuest Request Manager to restart automatically after a failure, or you schedule a pro-active stop and restart of the Request Manager.

For ClearQuest version 7.0

The ability to configure the Request manager to recycle is controlled directly through the rmmanager.properties file in the 7.0 release. Details on how this is done are contained in the ClearQuest 7.0 Release notes under the section: Configuring the Rational ClearCase Web Request Manager for Automatic Recycle.

The rmmanager.properties file is found in the C:\Program Files\Rational\ClearQuest\cqweb\cqserver\config directory on the RWP server.

For ClearQuest version 2003.06.15

Use this option to restart the ClearQuest Request Manager service without intervention. You can configure the ClearQuest Request Manager service so that it restarts automatically after a failure. Follow these steps to re-configure the ClearQuest Request Manager service on Windows and to test and monitor the automatic restarts.
ClearQuest – How do I

To set and test the cqboot script:
1. Make sure that the cqboot.vbs script is in the directory: 
   <Rational Install Dir>\clearquest\cqweb\.
2. Open a command prompt and run the command:
   cscript //H:CScript
   Note: This command sets the default script host to CScript, so that it runs in command line mode and does not display any dialog boxes.
4. Right-click Rational ClearQuest Request Manager and select Stop.
5. Make sure that the ClearQuest Request Manager Service has stopped.
6. Change the directory to the cqboot.vbs location. At the command prompt, enter:
   cd <Rational Install Dir>\clearquest\cqweb\.
7. Start the ClearQuest Request Manager Service. At the command prompt, enter:
   cqboot START_RM
8. Verify that ClearQuest Request Manager Service is running. First, check the services in the Windows Control Panel, and then send a request from a Web browser to the ClearQuest Web. If you receive the login page with the list of schema repositories, the services are running.
   Note: A new version of the CQBOOT.VBS script is available as an attachment to this technote. This version allows for the rotating of the Request Manager logs prior to a restart. This should ensure that all logs are current. The logs that it refreshes are: requestmgr.log, requestmgr.jvm.stdout, requestmgr.jvm.stderr
9. For archived logs, it will append a date and time stamp in the following format:
   .yyyymmdd_hhmmss
   For example, a requestmgr.log file that was rotated at 12:26pm today would read: requestmgr.log.20060929_122600

To configure the ClearQuest Request Manager Service to restart automatically after failure:
1. Open the Windows Task Scheduler by selecting:
   Start > Programs > Accessories > System Tools > Scheduled Tasks.
2. In the wizard, double click Add Scheduled Task, and then click Next.
3. The wizard lists available programs on the machine. Click the Browse button.
4. Locate the cqboot.vbs file under "C:\Program Files\Rational\ClearQuest\cqweb", then click the Open button.
5. Name the task: Auto Restart CQ.
6. Select Daily as the Frequency of running this script.
7. Select the time of script execution (for example, 12:00 AM) and the start date.
8. If prompted, enter the user name and password of the Administrator of the machine. This script will be started under this account.
9. On the confirmation screen, select the Open Advanced Properties checkbox for the task, and click the Finish button. A dialog opens with the detailed settings of the task.
   Note: If you need to make future changes to the scheduling properties for this script, go to:
   Start > Settings > Control Panel > Scheduled Tasks and open your scheduled task.
10. Change the text in the Run text field to:
    cscript.exe "<Rational Install Dir>\ClearQuest\cqweb\cqboot.vbs" START_RM
   Note: There is a space after cscript.exe and before START_RM. If the path to cqboot.vbs contains spaces, make sure you wrap the location in double quotes
   (for example: cscript.exe "C:\Program Files\Rational\ClearQuest\cqweb\cqserver\cqboot.vbs" START_RM).
11. To ensure that this scheduled task is enabled, check Enabled.
13. Check Repeat task. Enter “1” in the “Every <xxx> minutes” field and “9999” in the “Duration <xxx> hour(s)” field. The result is that the script executes every minute.
   Note: If the ClearQuest Request Manager Service is already running, the script exits immediately and has no impact on server performance.
14. Click OK and then Apply to save the settings. You have successfully scheduled the automatic restart of the ClearQuest server.

To test the Scheduled Task:
1. On the server, select:
   Control Panel > Administrative Tools > Services
2. Right-click Rational ClearQuest Request Manager and select Stop.
3. Make sure that the ClearQuest Request Manager has stopped.
4. Right-click Auto Restart CQ in the Scheduled Task pane and select Run.
   The script will start the ClearQuest Request Manager service.
5. Verify that the service is running. First, check the service in the Windows Control Panel. Then, send a request from a Web browser to the ClearQuest Web. If you receive the login page with the list of schema repositories, the services are running.
ClearQuest – How do I

To monitor the restart history of the ClearQuest Request Manager:
2. In the Tree view (on the left), click System.
3. Look for items in the list on the right that have Information as the Type and Service Control Manager as the Source.
4. Double-click each item. If the entry corresponds to an automatic restart of the ClearQuest Request Manager service, the following text displays in the description field: The Rational ClearQuest Request Manager service entered the running state.

Scheduling a proactive stop and restart of the ClearQuest Request Manager service
Use this option if you prefer to schedule the stop and restart of the Request Manager service proactively. You will need to schedule the stops as appropriate for your environment, depending on frequency of observed failures. It is suggested that you begin with a nightly stop and restart and then make adjustments if you find that you require more frequent resets for your installation.

To set and test the cqboot script:
1. Make sure that the cqboot.vbs script is in the directory: `<Rational Install Dir>\clearquest\cqweb\`
2. Open a command prompt and run the command: `cscript //H:CScript`
   **Note:** This command sets the default script host to CScript, so that it runs in command line mode and does not display any dialog boxes.
3. Make sure that both the ClearQuest Registry Server and the ClearQuest Request Manager services are running.
4. At the command prompt, change the directory to the cqboot.vbs location: `cd <Rational Install Dir>\clearquest\cqweb\`
5. Restart the ClearQuest Request Manager and ClearQuest Registry Server services. At the command prompt, enter: `cqboot BOUNCE_RM`
6. Verify that both the services are running. First, check the services in the Windows Control Panel, and then send a request from a Web browser to the ClearQuest Web. If you receive the login page with the list of schema repositories, the services are running.

To schedule the proactive restart of the services:
2. In the wizard, click "Add Scheduled Task" and then click Next. The wizard lists available programs on the machine.
3. Instead of selecting a program from the list, click Browse and then select the cqboot.vbs script.
4. Name the task: "Proactive Restart CQ"
5. Select the Frequency of running this script (for example, Daily).
6. Select the time of script execution (for example, 12:00 AM) and the start date.
7. If prompted, enter the user name and password of the Administrator of the machine. This script will be started under this account.
8. On the confirmation screen, select "Open Advanced Properties" for the task. A dialog opens with the detailed settings of the task.
   **Note:** If you need to make future changes to the scheduling properties for this script, go to Start > Settings > Control Panel > Scheduled Tasks.
9. Change the text in the Run text field to: `cscript.exe "<Rational Install Dir>\ClearQuest\cqweb\cqboot.vbs" BOUNCE_RM`
   **Note:** There is a space after cscript.exe and before the BOUNCE_RM. If the path to cqboot.vbs contains spaces, make sure you wrap the location in double quotes (for example: `cscript.exe "C:\Program Files\Rational\ClearQuest\cqboot.vbs" BOUNCE_RM`).
10. To ensure that this scheduled task is enabled, check Enabled.
11. Click Apply to save the settings. You have successfully scheduled the proactive restart of the CQServer.

To test the scheduled task:
1. Right-click the scheduled task in the Scheduled Task pane and select Run. The script will stop both the services and then start them again.
2. Verify that both the services are running.
   First, check the services in the Windows Control Panel. Then, send a request from a Web browser to the ClearQuest Web. If you receive the login page with the list of schema repositories, the services are running.

44. How do I – understand about Base ClearCase integration with Rational ClearQuest new centralized cache manager features

In Version 7.0.1 of IBM Rational® ClearCase® and IBM Rational ClearQuest®, numerous changes have been made in storing local information on end user hosts and managing the information to improve reliability and flexibility in the base Rational ClearCase integration with Rational ClearQuest.

Changes in locally stored information
ClearQuest – How do I

Triggers used by the base ClearCase integration with Rational ClearQuest store information between trigger invocations. The stored information is in a set of files that reside in a user-private cache directory on the end user host.

Changes have been made to improve data management when the same user on a given host performs multiple simultaneous Rational ClearCase operations (for example, checking out files using cleartool while checking in files using Rational ClearCase Explorer). The changes affect all users but do not require administrator changes to enable. By default, the information is stored locally in the users' home directory or Documents and Settings application data area in their Windows profile.

Multiple process support

The integration triggers save both operational information (that is, current file information) and Rational ClearQuest Web connection information between invocations. Previously, all triggers for a given user stored this information into a common set of files; simultaneous Rational ClearCase operations could write conflicting information to the same files, leading to data inconsistency.

Rational ClearCase applications typically use environment variables to define a file series identifier, which tells triggers when a set of related files are being processed. The integration now uses this series identifier to specify unique names for operational and Rational ClearQuest Web session files, and reuses the Rational ClearQuest Web session files as much as possible between the multiple processes.

For example, if a developer uses multiple Rational ClearCase tools simultaneously and invokes the integration simultaneously against different sets of files, different cache files are now used for the different processes. Information that previously might have been mixed between the different processes is now isolated.

As the integration runs for individual operations, it automatically checks for and deletes any stale operational and session cache files that remain after they are processed.

Multiple session caches

For base ClearCase integration with Rational ClearQuest users who are not using Rational ClearCase remote client, all Rational ClearCase processes that run on the same host use the same session subdirectory, session.main. If users want to work with multiple unrelated sessions, (for example, they are doing a large clearsimport checkin while trying to work interactively with Rational ClearCase Explorer using different VOBs, databases, and entities), they can optionally identify a different session using the CQCC_SESSION_ID environment variable. For example:

```bash
setenv CQCC_SESSION_ID import
```

The process that uses this environment variable writes to session.import rather than session.main.

Note: This option should be used only when central caching is enabled. It relies on the cache manager to ensure that any un-posted association batches eventually get posted.

Controlling error logging

A new configuration parameter (CQCC_LOG_ERRORS) can be set optionally to log user-encountered errors to a new file (cqcc_error.log) in the user's cache directory. The existing debugging capability (CQCC_DEBUG and CQCC_LOG_OUTPUT) records diagnostics for all user operations so it can produce a large amount of output even during normal operations. The new option records only information that is reported to the end user, providing the administrator with a means of reviewing user errors encountered while running the integration.

Set the CQCC_LOG_ERRORS configuration parameter to enable writing all configuration parameters with each error message to a log file in the session cache directory. For example:

```bash
&SetConfigParm("CQCC_LOG_ERRORS", "ERROR");
```

Valid values to specify the level of dialog at which to start logging:

- **INFO**: No error logging information is saved. (This is the default.)
- **WARN**: Information is provided about the operation and the operation can continue.
- **ERROR**: A potential error exists but the operation can proceed.
- **FATAL**: Condition temporarily prevents particular operation from succeeding.

Note: The error logging levels are cumulative. For example, if you specify the WARN message level, all messages of severity WARN and above would appear in the log. In this case, that would include WARN, ERROR, and FATAL messages.

Central cache management

A new optional configuration parameter (CQCC_CACHE_ROOT) enables storing the trigger information in a shared central cache directory rather than in the user’s local directory. This central cache is required to support Rational ClearCase Remote Client servers and is an option in other situations to ensure that Rational ClearCase operations in association batches always are posted reliably. A new Rational ClearCase scheduler task provides a central cache manager that automatically scans for unposted Rational ClearCase transactions and cleans up stale directories and files.

The CQCC_CACHE_ROOT configuration parameter changes the storage of the user’s information between trigger calls from the local machine to a central cache location that you specify. Caching the information in a central directory tree has the following advantages:
ClearQuest – How do I

- Facilitates administration of association batches ensuring that they are posted in a timely fashion and provide oversight of user errors (when error logging is enabled).
- Enables support of the integration on a Rational ClearCase remote client server where there are no "central directories" and hence is required for Rational ClearCase remote client deployment.

For improved performance, the integration offers a configuration option (CQCC_ASSOC_BATCH_ENABLE) that enables storing Rational ClearQuest association transactions into a batch file (stored in the user’s cache area) so they can all be posted at the same time. There are circumstances under which association batches do not always get posted immediately. For example, in a multiple-file operation (a series), the last checkout or checkin is the event that causes the association batches to be posted. If the last checkout or checkin fails (for example, the last checkin is identical and identical checkins are not enabled), this event does not occur and the association batch is not posted. The batch can be posted during subsequent Rational ClearCase operations, but this may take significant time because it depends on the usage patterns for the user. Similarly, if there is any problem posting the association batches to Rational ClearCase user database (for example, the server is not available), the posting operation fails and must wait until another event to force the re-posting.

If you configure the CQCC_CACHE_ROOT configuration parameter to use a central cache and enable the cache manager scheduler task, any un-posted association batches can be noticed by the automated central cache manager process and posted without waiting for additional user activity. Problems in posting the association batches can be reported to the administrator without user intervention for faster resolution.

Enabling the central cache requires that the administrator perform the following tasks.

- Set the CQCC_CACHE_ROOT configuration parameter in the configuration file to specify the cache location, as described below under Configuring the cache location directory.
- Schedule the cache manager job to run on the file server being used so that the un-posted association batches are found and posted. For details see Cache manager command overview and Scheduling the cache manager.

The cache manager also cleans out obsolete cache files and directories left behind after a specified time period.

Configuring the cache location directory

In the configuration file (config.pl), use the CQCC_CACHE_ROOT configuration parameter to identify the central cache directory root. For example:

\&SetConfigParm("CQCC_CACHE_ROOT", "/net/unixHost/var/tmp/cqcc_server_dir");

This setting redirects all trigger calls to store information into a subdirectory of the specified root directory, cqcc_server_dir.

When a user runs the integration, it automatically creates user-private subdirectories of the root directory as follows:

- A user subdirectory for the current Rational ClearCase user
- A host subdirectory for the host that is currently being used (the server in the case of Rational ClearCase Remote Client users)
- A session subdirectory for the current session context. For Rational ClearCase remote client users, this is qualified by the client session id, for example, session.12345. For other users, this value defaults to session.main.

These are some additional guidelines for setting up a central information cache directory:

Creating the central cache root directory and regulating access permissions

The central cache root directory must exist before the integration starts; it is not created automatically. This directory must be accessible and writable for to all potential end users. On Windows, security should be set to allow all users to write their own folders and files within the central area but should not allow them to see each others’ directories. The administrator user who will be running the cache manager task should have full privileges to read and delete all user folders and files. The integration automatically will create subdirectories that are accessible only by the individual end user and members of the Rational ClearCase administrators group.

Keeping the root directory name short

The full pathname to the central cache file looks like this on Windows:

root_directory\username\hostname\session.id\name.seriesID

On Windows, there is a 255-character limit to the full pathname of the central cache file. The seriesID can be 40 characters long, so if you specify an inordinately long name for the root_directory, you might encounter problems with the 255-character limit.

Using a UNC or exported file space

Use either a UNC (Windows) or exported file space (Linux and the UNIX system). If you set the root directory for a Windows server, ensure that you escape any backward slashes in the name. For example:

\\\myhost\\public\\cqcc_server_dir

Changing the central cache location

When you enable the use of central caching, the user’s home directory is first checked for any pre-existing unposted batch files. If any are found, they are automatically copied to the new central cache directory for posting.

If you change the location of a central directory or return to the user of local caching, you should make the change when users are not actively using the integration (that is, off hours) and run the cache manager to post any unposted transaction batches that might have been left behind.
ClearQuest – How do I

Cross-platform issues
Central caches cannot be shared between Windows and non-Windows platforms. SAMBA and other multiple platform file sharing technologies are not supported for cross-platform caching. Linux and UNIX client computers must use a directory on a Linux or UNIX computer and Windows clients must use a folder on a Windows computer. For example:

use Config; # At top of config file with other "use" commands
...
&SetConfigParm("CQCC_CACHE_ROOT",
($Config::Config{osname} eq "MSWin32") ?
"\\\(windowsHost{\}
temp\(\)cqcc_server_dir" :
"/net/unixHost/var/tmp/cqcc_server_dir"");

Working with Rational ClearCase Remote Client
You must enable central caching to support Rational ClearCase Remote Client but it is optional for other clients. If you want to set central caching only for Rational ClearCase Remote Client servers, you can use the following approach:

if (defined $ENV{ATRIA_WEB_CLEARPROMPT}) {
    &SetConfigParm("CQCC_CACHE_ROOT", "central-directory-path");
}

Defining the scope of a cache configuration file
Whatever configuration you use, make sure that the end user is not directed to different central cache directories within the same session or operation. For example, do not base the central directory on the VOB name since a checkin involving files from different VOBs could end up spread over multiple cache directories. Additionally, the cache manager should always be using the same configuration file as the clients that it is monitoring. If you are using multiple configuration files for different VOBs or sets of VOBs, there should be one cache manager job scheduled for each different configuration file. This ensures that the same databases and configuration parameters are used for both the end user's original operations and operations performed afterwards by the cache manager.

Using NetApp devices for the central cache directory
If you plan on using a NetApp devices to store the central cache directory, ensure that the device has installed Rational ClearCase such that it can run as the appropriate type of user with the appropriate privileges for accessing the central cache file and directory structure (for example, root user on UNIX and Linux or as a member of the ClearCase group on Windows). Note: For example, sometimes the root user on one computer isn't recognized as the root user on the NetApp device.

Clock differences between computers
Since the behavior of the cache manager is driven by the age of different files, there should not be a significant discrepancy between the system clocks of end user client computers and the computer on which the cache manager is running. If the cache manager inadvertently perceives the wrong age for cache files, this may interfere with the reliability of the integration.

Combining central cache functionality with other product options to improve the integration
Now that central caching is supported, the following combination of configuration options can improve the functionality and performance of the integration:

Table 1.

<table>
<thead>
<tr>
<th>Configuration option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CQCC_POSTCHECKIN_COMMIT</td>
<td>Setting this option causes the cache manager to avoid changing Rational ClearQuest associations until the check in operation has succeeded. This causes the integration to run both before and after the check in operation reducing performance slightly, but improving reliability.</td>
</tr>
<tr>
<td>CQCC_ASSOC_BATCH_ENABLE</td>
<td>This option can help to combine individual Rational ClearQuest database changes into batches to improve performance for multi-file operations and to improve the reliability of post-checkin operations (Rational ClearQuest operations are repeated if necessary until they succeed).</td>
</tr>
<tr>
<td>CQCC_CACHE_ROOT</td>
<td>This option is required to enable centralized caching to ensure that batches are posted in a timely fashion. This requires the cache manager task to be run manually or automatically to monitor the central cache for any unposted transaction batches.</td>
</tr>
<tr>
<td>CQCCCOMMENT_PATTERN</td>
<td>This option can be used to allow users to include association information in comments to minimize user interaction when adding multiple new elements to source control.</td>
</tr>
</tbody>
</table>

Rational ClearCase Remote Client support
This section shows how the base Rational ClearCase and Rational ClearQuest integration works with Rational ClearCase Remote Client and describes the limitations in this environment.
ClearQuest – How do I

- Server requirements
- Basic operations
- Setting the time zone for UNIX and Linux computers
- Internationalization
- User-modified environment variables
- Adding multiple files to source control
- Rational ClearQuest pathnames under the Rational ClearCase Remote Client environment
- Command-line operations cannot be executed from the Rational ClearCase Remote Client

The base integration is now supported under Rational ClearCase Remote Client servers. For details on configuring the servers to support the integration, how the integration works, and restrictions for remote clients, see Rational ClearCase Remote Client support.

Server requirements
When the integration triggers are enabled on VOBs that the Rational ClearCase Remote Client user is accessing, the triggers are executed on the server that user is logged into. The triggers check for the following conditions before running on the server:
- Rational ClearCase Version 7.0.1 must be installed on the server. The integration depends on changes made in the 7.0.1 release.
- Central caching must be enabled. For details, see Central cache management.
- If you are using Rational ClearQuest native client to access Rational ClearQuest databases, the Rational ClearQuest native client must be installed on the server and the database sets must be registered correctly.
  Note: On UNIX and Linux computers, the timezone must be set to enable access to Rational ClearQuest. For details, see Setting the time zone for UNIX and Linux computers.

Basic operations
Whenever a Rational ClearCase Remote Client end user checks out files, checks in files, or adds files to source control, they encounter the base integration operations menu. This menu is the same as that seen when performing command-line operations. It is different from the conventional graphical user interface association dialog familiar from previous releases, but contains the same functions and capabilities:
- OK — Commit associations
- CANCEL
- HELP — Display help for this menu
- QUERY — Select from ClearQuest query
- TYPEIN — Enter associations from keyboard
- REVIEW associations
- DATABASE
- RECORD TYPE
- PATHNAME
- QUERYNAME
- RELOGIN CLEARQUEST — Force a new login to Rational ClearQuest

Each dialog instance has an OK or Cancel button. Once a selection is made from the menu, click OK to execute that operation or Cancel to exit the current menu or the integration.
For more information about how this dialog functions, select the HELP item and then click OK in the dialog.

Setting the time zone for UNIX and Linux computers
The integration accesses Rational ClearQuest servers using either the native Rational ClearQuest client (if that client is installed) or the Web-based Rational ClearQuest client. If your site uses the native client, the integration’s initialization requires that the time zone environment variable (TZ) be defined. On Linux and some UNIX computers, the time zone is not set by default for the root user, so it must be set explicitly in those situations, since the cache manager and the server for the Rational ClearCase Remote Client run as root user processes.

Running integration related commands as the root user
Before running integration related commands as the root user (for example, running the cache manager script or using cqcc_launch to get a password string), you must set the TZ environment variable explicitly if it is not currently set. For example, if you are using the csh shell command environment:
setenv TZ US/Eastern

Running the cache manager through the scheduler
When running the cache manager through the scheduler, you must provide the time zone variable using the --env command-line option. For example:
--env TZ:US/Eastern

Running the cache manager in Rational ClearCase Remote Client
When running the cache manager in Rational ClearCase Remote Client, set the time zone variable in the cccrc.conf file:
1. On the UNIX or Linux computer, log on as the root user.
2. Open the /var/adm/rational/common/rwp/conf/ccrc.conf file for editing.
3. Under this line:
   # Other CCRC-specific Apache directives should be added here
add this line:
SetEnv TZ local_time_zone
For example:
SetEnv TZ US/Eastern
4. Re-start IBM Rational Web Platform (RWP):
/opt/rational/common/rwp/bin/rwp_restart
Note: If you have installed the IBM Rational products to a directory other than
/opt/rational, adjust the command path accordingly.

Internationalization
All messages from the integration between Base Rational ClearCase and Rational ClearQuest are in
English at this time.

User-modified environment variables
User-modified environment variables are not supported. If an environment variable defined on the client
computer is the same as one defined on the server computer, the server computer value is used. In
particular, this restriction affects these options:
   • CQCC_ASSOC_BATCH_SERIES
   • CQCC_AUTO_ASSOCIATE

Adding multiple files to source control
When adding multiple files to source control, the integration dialog appears for each file operation. This
situation can be improved by enabling the CQCC_COMMENT_PATTERN configuration option to support
embedding the desired associations in the comment for multiple-file additions, reducing the integration
dialog interactions to operations on only directories.

Rational ClearQuest pathnames under the Rational ClearCase Remote Client environment
Under Rational ClearCase Remote Client, the integration does not use the lengthy default filename
showing the temporary storage location for the Rational ClearCase Remote Client view. It replaces it with
a shorter pathname.
On Windows, this references a hypothetical view called ccweb. For example, a file such as "long-view-
name\myvob\dir1\file.1" appears as "M:\ccweb\myvob\dir1\file.1".
On UNIX and Linux, the path looks like a conventional dynamic view path, starting with the VOB name
(for example, "/myvob/dir1/file.1").

Command-line operations cannot be executed from the Rational ClearCase Remote Client
Command-line operations like "–op batch" and "–op edit" cannot be executed from the Rational
ClearCase Remote Client. The "–op batch" operation is handled automatically by the cache manager. The
"–op edit" operation must be run using the Rational ClearCase native client using an appropriately
configured view.
For example, if you wish to run the –op edit operation to change a checked in association:
1. Using the Rational ClearCase native client on a Windows server, create a dynamic view called
cweb.
2. In the Rational ClearCase native client, change directory to the M:\ccweb directory.
3. In the Rational ClearCase native client, re-issue the –op edit operation

Ensure that the local pathname in your view is the same as the actual file name stored in Rational
ClearQuest.

Summary of new configuration parameters
Table 2 contains a list of the new configuration parameters in this release (Version 7.0.1).

<table>
<thead>
<tr>
<th>Configuration parameter</th>
<th>Description</th>
<th>Locally settable</th>
</tr>
</thead>
<tbody>
<tr>
<td>CQCC_CACHE_MGMT</td>
<td>Optionally changes default timing options and other adjustments.</td>
<td>No</td>
</tr>
<tr>
<td>CQCC_CACHE_ROOT</td>
<td>Required to enable central caching. Activates the positioning of locally stored information in the central cache directory.</td>
<td>No</td>
</tr>
<tr>
<td>CQCC_LOG_ERRORS</td>
<td>Writes a specified level of information about user-encountered errors to a file in the session directory; values for level are INFO, WARN, ERROR, and FATAL. Default is &quot;&quot;.</td>
<td>Yes</td>
</tr>
<tr>
<td>CQCC_SESSION_ID</td>
<td>Establishes an identification for the user session different from the default (session.main ).</td>
<td>Yes</td>
</tr>
</tbody>
</table>

Cache manager command overview
When central caching is enabled, the cache manager is used to monitor the central cache manually or
automatically to process any unposted Rational ClearQuest association batches and to delete stale files
and directories. The cache manager is a Perl script built on top of the integration that can be run either
from the command line or from the Rational ClearCase scheduler. Command-line arguments tell the
ClearQuest – How do I

cache manager how to find the configuration file and integration source code, and what to do when it runs.

- **Sample command**
- **Specifying the cache manager command parameters**
- **Complete list of parameters for the cache manager command**

**Sample command**

Here is a sample cache manager command on Windows:

```bash
@cqcc_cache_mgr -vob \my_vob -cqlogin admin:encrypted_password -cqbatch_post_mins 30 -nolog -noexec
```

This command provides the following information to the cache manager:

- The `-vob` parameter tells the cache manager how to locate the integration source and configuration file based on the trigger installed in `\my_vob`.
- The `-cqlogin` parameter provides Rational ClearQuest login information without relying on cached information.
- The `-cqbatch_post_mins` parameter tells the cache manager to post any unposted association batches more than 30 minutes old.
- The `-nolog` parameter directs the message output to the command line instead of the log file.
- The `-noexec` parameter asks the cache manager to report what it would do, without actually modifying the files.

**Note:** In this Windows example, `cqcc_cache_mgr.bat` resides in `ccase-home-dir\config\scheduler\tasks`, where `ccase-home-dir` represents the Rational ClearCase installation directory (typically `C:\Program Files\Rational\ClearCase`). On UNIX or Linux computers, the cache manager script is named `cqcc_cache_mgr.pl`.

**Specifying the cache manager command parameters**

When specifying a cache manager command, you can set parameters to provide several pieces of information for the cache manager.

Integration source and configuration parameters

Specify the same integration source and configuration parameters that the main integration triggers use. Do one of the following:

- Specify `-vob` to indicate the VOB in which the triggers reside.
- Specify `-central` and `-config` to indicate the central source location and the configuration file name.

**Rational ClearQuest login information parameter**

Provide Rational ClearQuest login information, so that the cache manager can connect to the Rational ClearQuest user database on behalf of the administrator without depending on cached information or attempting to prompt at runtime.

To specify the login information, use the `-cqlogin` parameter with the appropriate user name and encrypted password.

To determine the values to supply for the `-cqlogin` parameter:

1. **Login as the user who will be scheduling the cache manager task.**
   
   In Microsoft Windows, you must generate the Rational ClearQuest login password as the user running the scheduled tasks. Here are two methods to determine the user specified in the scheduler:
   
   - **Using the Rational ClearCase log browser:**
     
     a. Open the Log Browser (Programs > IBM Rational > IBM Rational ClearCase > Administration > Log Browser).
     
     b. Click Scheduled Jobs.
     
     c. In the job listing that appears, right-click the cache manager task, and select Properties.
   
     The Attributes tab shows the runtime user.
   
   - **In the Microsoft Windows Services program:**
     
     a. In the Control Panel, open Administrative Tools.
     
     b. Start the Services application.
     
     c. Right-click the Atria Location Broker service, and then select Properties.
   
     In the properties dialog that appears, the Log on tab displays the runtime user.
   
   On UNIX or Linux computers, you must be logged on as root. If switching to root while logged on as a different user, use "su " to ensure that the current user is identified as root.

   **Note:** You might have to set the time zone environment variable. For details, see [Setting the time zone for UNIX and Linux computers](#).

2. **From the command line interface, issue this command:**

   ```bash
cqcc_launch -vob vob-tag -op pw
```

   You are prompted to login to the default Rational ClearQuest database used by the integration and the output string is what should be used for `-cqlogin`.

   **Note:** On UNIX or Linux computers, the root user command path might not be able to find `cqcc_launch`; use the full path (`/opt/rational/clearcase/bin/cqcc_launch`) instead, assuming Rational ClearCase is installed to `/opt/rational`.

**Timing parameters**

Adjust timings that are appropriate for your site if different from the defaults.
ClearQuest – How do I

- Specify `--cqbatch_post_mins` to define the number of minutes before un-posted association batches are posted.
- Specify `--dir_stale_hrs` to define the number of hours before which unused directories are deleted.
- Specify `--stale_hrs` to define the number of hours before stale series cache and `cqsession` files are deleted.

Logging and execution control
There are several parameters that control log output or execution:
- Specify `--maxlogsize` to determine the maximum size of the log.
- Specify `--noexec` to report what the cache manager would do if you executed the command, without actually modifying the files.
- Specify `--nolog` to display message output on the command line instead of in the log.
- Specify `--user` or `--path` to focus the cache manager on particular user's cache or the cache stored under a particular `user/host` or `user/host/session` subdirectory.
- Specify different values of `--verbose` to control how much output is displayed.

Complete list of parameters for the cache manager command
To see what options are available when running the cache manager, specify the `--help` argument to the `cqcc_cache_mgr` Perl script.

The following are the command line arguments for parameters that control the cache manager operation and scheduling:

`--central`  Provides the path of the central source location.

`--config` Provides the configuration file name. The default is `config.pl`.

`--cqbatch_post_mins` Specifies the integer number of minutes before posting un-posted association batches. The default value is 60, the minimum is 3, and the maximum is 6000.

`--cqlogin name:encrypted_password` Supplies the user name and encrypted password. By default, the trigger uses the cached password file for authentication; but it is best to add the information based on an encrypted password.

`--dir_stale_hrs` Specifies the integer number of hours before which unused directories are deleted. The default value is 48, the minimum is 8, and the maximum is 1000.

`--env name:value` Specifies an environment variable `name:value` pair. Can be used multiple times.

`--help` Prints a list of command line options.

`--maxlogsize` Maximum allowable size of the log file (in KB). Once the log file reaches this size, it is renamed to `filename.old` and a new log file is started.

`--noexec` Runs the cache manager in no-execute mode. This is a diagnostic mode that lets you see the results of a command without having to execute it.

`--nolog` Runs cache manager and directs output to `stdout`. Output is normally directed to Rational ClearCase scheduler log location `(/var/adm/rational/clearcase/log/cqcc_cache_mgr.log` on Linux and the UNIX system and `cc-home\var\log\cqcc_cache_mgr.log` on Windows)

`--path directory` Run against the specific cache subdirectory indicated by `directory`. Specifying `--path` can be used to narrow the focus beyond the cache directory for a particular user (as specified by `--user` and can contain multiple computers and sessions) to a `username/computer/session` subdirectory under the centralized cache directory.

`--stale_hrs hours` Specifies the integer number of hours before stale series cache and `cqsession` files are deleted individually, regardless of the directory age. The default value is 8, the minimum is 0.1, and the maximum is 100.

`--user username` Run against specific user's subdirectory as indicated by `username`. The cache directory for a particular user can contain multiple computers and sessions. You can limit the focus further using the `--path` parameter.

`--verbose level` Specifies the level at which status and error messages are output. There are four levels:
- 0: error messages only
- 1: provide listing of the directories being processed
- 2: provide listing of the files being processed
- 3: provide debugging information about why files and directories are being removed

`--vob tag`
ClearQuest – How do I

Specifies the VOB that stores the installed triggers which contain information about the source and configuration file locations.

Scheduling the cache manager

The Rational ClearCase scheduler can be used to periodically run the cache manager script on Rational ClearCase hosts that are configured to support the integration between Rational ClearCase and Rational ClearQuest.

- Overview
- Creating the cache manager task and job manually
- Running the cache manager using the Log Browser
- Running the cache manager using the cleartool schedule command

Note: The instructions in this section assume that you are familiar with the Rational ClearCase scheduler. For details on working with the scheduler, see IBM Rational ClearCase Administrator’s Guide.

Overview

Servers that host a central cache should schedule the cache manager to run periodically to clean out stale files and directories and to post any unposted Rational ClearQuest transactions if the association batch feature is enabled.

For the cache manager, a task (with fixed number 201) is defined in the Rational ClearCase scheduler with the following title:

Daily Base CC/CQ Integration Central Cache Manager

An inactive scheduler job is also defined. Use the Rational ClearCase scheduler or the log browser application to modify the scheduler parameters and command line arguments for this job.

The scheduler parameters define how often the task runs and who should receive e-mail if there are problems. The cache manager output is logged in the standard task log directory and can be viewed by running the log browser or by visiting the log directory.

The arguments to the scheduler job are the same as the cache manager command-line arguments (as described under Specifying the cache manager command parameters), except without any reference to the cache manager script itself (which is defined in the scheduler task). For example, this is an example of the arguments used in a typical scheduler job:

```
-vob \my_vob -cqlogin admin:encrypted_password --verbose 0
```

Creating the cache manager task and job manually

The new Cache Manager task and job may not appear on machines that have previously had ClearCase installed, specifically if the task registry on the local machine had been modified before upgrading to this release. The installation of the new release will not overwrite a customer-modified task registry, so you must manually add the scheduler elements for the cache manager.

The cache manager job task file location is:

- On Windows: `\ccase-home-dir\config\scheduler\tasks\cqcc_cache_mgr.bat`
- On UNIX: `\ccase-home-dir/config/scheduler/tasks/cqcc_cache_mgr.pl`

where `\ccase-home-dir` is the installation directory (typically, `\Program Files\Rational\ClearCase` on Windows or `/opt/rational/clearcase` on UNIX and Linux).

To manually add the cache manager scheduler task and job:

1. Add this code to your existing task_registry file, specifying a new Task.ID appropriate for your site:

```
1. Task.Begin
2. Task.Id: 20
3. Task.Name: "Base CC/CQ Integration Central Cache Manager"
```

Task.End

Note: This code is for a Windows computer; for UNIX or Linux computers, the Task.Pathname value should be `cqcc_cache_mgr.pl` instead.

6. If you do not have a cache manager job defined, you will need to add one to your local scheduler job list:

a. Run this command:

```
cleartool schedule --edit
```
b. Add this job description:

c. Job.Begin

d. Job.Name: "Daily Base CC/CQ Integration Central Cache Manager"

Note: This is the same as the name of the task defined above.
e. Job.Description.Begin:

```
Clean up Base CC/CQ integration central cache area when used
```

f. Job.Description.End:

g. Job.Schedule.Daily.Frequency: 1

h. Job.Schedule.StartDate: 3-Jul-1994

i. Job.Schedule.LastDate: StartDate

j. Job.Schedule.FirstStartTime: 01:00:00

k. Job.Task: "Base CC/CQ Integration Central Cache Manager"

l. Job.Args: -help

m. Job.End
ClearQuest – How do I

Running the cache manager using the Log Browser
On Windows, you can use the Rational ClearCase Log Browser to run the cache manager:
1. Ensure that the cache manager runs under the proper group.

On Windows, this means that the cache manager must run as a member of the Rational ClearCase group on the host computer.
2. Start the Rational ClearCase Log Browser (Programs > IBM Rational > IBM Rational ClearCase > Administration > Log Browser).
3. Open Scheduled Jobs. This displays a new job for the cqcc_cache_mgr job.
4. Under Scheduled Jobs, double-click the cache manager entry, displaying Job Properties.
5. Configure the job properties through these parameters:
   - Click Parameters to change cache manager configuration parameters.
   - Click Schedule to control timing.
   - Click Settings to establish users who should be notified of success or failure.

Note: If you have modified the task registry from its default content to add your own tasks before upgrading your Rational ClearCase installation to this release, you might not see the cache manager task and job in the scheduler. In this case, you must manually create them as described under Creating the cache manager task and job manually.

Running the cache manager using the cleartool schedule command
You can run the cache manager using the cleartool schedule command:
1. Ensure that the cache manager runs under the proper group.

On Windows, the cache manager must run as a member of the Rational ClearCase group on the host computer.
   - On UNIX, the cache manager must run as the root user, using the "su – username" command so that you are running as the root user with your own environment enabled.
2. Verify that the cache manager task is defined in the Rational ClearCase scheduler:
   a. From a command-line interface, run this command:
      cleartool schedule –get –tasks
   b. Look for the Base CC/CQ Integration Central Cache Manager task.
3. Verify that the cache manager job is defined in the Rational ClearCase scheduler:
   a. From a command-line interface, run this command:
      cleartool schedule –get
   b. Look for the Daily Base CC/CQ Integration Central Cache Manager job.

Note: If you have modified the task registry from its default content to add your own tasks before upgrading your Rational ClearCase installation to this release, you might not see the cache manager task and job in the scheduler. In this case, you must manually create them as described under Creating the cache manager task and job manually.

Accessing the cache manager log
You can access the cache manager log using either the Rational ClearCase log browser (on Windows only) or the Rational ClearCase cleartool getlog command (on all platforms):
Using the log browser
1. Start the Log Browser (Programs > IBM Rational > IBM Rational ClearCase > Administration > Log Browser).
2. The cache manager log (cqcc_cache_mgr) appears under Server Logs.

Using the cleartool getlog command
From a command-line interface, run this command:
cleartool getlog cqcc_cache_mgr
You can use the "–full" and "–last n" options to display the full listing or just the last n number of lines. For details, see the getlog reference page.

On the filesystem
The log file (cqcc_cache_mgr.log) can be found on the filesystem in these locations:
- On Windows computers: ccase-home-dir\var\log\ where ccase-home-dir represents the Rational ClearCase installation directory (typically C:\Program Files\Rational\ClearCase on Windows).
- On UNIX and Linux computers: /var/adm/rational/clearcase/log/

If the log file appears to be missing
The cache manager log file (cqcc_cache_mgr.log) might not appear until the cache manager has run at least once so the log file exists. You might have to re-start the log browser or re-run the cleartool getlog command to see the log file.

The output log files are cleaned periodically by the scrubber_log task.
When the log file reaches the size determined by the –maxlogsize option, the cache manager saves the contents of the current log file to cqcc_cache_mgr.old and creates a new log file.
For details about periodic scrubbing and scheduler tasks, see the scheduler reference page and IBM Rational ClearCase Administrator’s Guide.

Responding to reported problems
Here are some guidelines for troubleshooting problems reported with the cache manager:
Using the –nolog option to print output to standard output instead of the log
ClearQuest – How do I

If you are using the cleartool command line interface to access the cache manager and want to see the results directly, you can use the –nolog argument to send log output to standard output rather than to the log file.

Using the –verbose option to output more information into the log

The log will report information about the individual user directories and files as the cache manager walks the central cache directory structure. By default, the cache manager reports only problems or actions that it took to post batches or to delete files and folders. The –verbose argument to the getlog command increases this amount of information provided, including the rules that were specified to determine what to do with different files.

Problems with a particular user, computer, or session

If the logs show problems with a particular user, computer, or session, review the error message and address the problem by focusing on the scope of that user, computer, or session.

For example, adjust mastership or ensure that the Rational ClearQuest user database is accessible. Then re-run the cache manager against the entire cache area or select specific users or user sessions using additional cache manager arguments:

- –user for logging the cache information for a specific user
- –path for logging the cache information for a specific user/computer/session path

For details about using these options, see Complete list of parameters for the cache manager command.

Advanced cache manager configuration

When the base ClearCase integration with Rational ClearQuest runs for each user, it automatically tries to clean out any stale cache files left behind over time. This behavior can be adjusted by a string of timing options that you can modify from their default values by setting the CQCC_CACHE_MGMT configuration parameter.

&SetConfigParm("CQCC_CACHE_MGMT", "cache_mgmt_options");

Note: Most sites should not need to use this option.

The variable cache_mgmt_options provides one or more internal parameters that modify the cache manager and must be a string in the format "name=value,name2=value2".

The following name and value pairs are available for cache_mgmt_options:

- CM_CLEAN_HRS
  Specifies the integer number of hours that pass between attempts by the trigger to self-clean up stale cache and session files. Default is CM_CLEAN_HRS=4. If value is 0, then every trigger attempts self cleanup.

- CM_CQSESSION_STALE_MINS
  Specifies the integer number of minutes after which Rational ClearQuest Web sessions are considered stale and appropriate to delete. Default is CM_CQSESSION_STALE_MINS=30. This value should be aligned with how long the Rational ClearQuest Web server considers sessions viable.

- CM_LOCK_BREAK_MINS
  Specifies the integer number of minutes after which operation locks can be broken by competing processes. Default is CM_LOCK_BREAK_MINS=5.
  Note: When simultaneous Rational ClearCase applications are running and sharing a cache directory, they will share access to the association batch file. A lock is used to coordinate this shared access. If one process holds the lock more than a specified amount of time, the second process will safely break the lock to avoid a permanent deadlock situation.

- CM_LOCK_WARNING_MINS
  Specifies the integer number of minutes to wait before letting the user know that we are waiting for a contested lock. Default is CM_LOCK_WARNING_MINS=1. If this value is greater than CM_LOCK_BREAK_MINS, the user is not notified.

- CM_STALE_HRS
  Specifies the integer number of hours after which series cache files are considered stale and appropriate to delete. Default is CM_STALE_HRS=8.

- CM_WIN_UNIX
  If the central cache is on Linux or the UNIX system but accessed by Windows clients, set CM_WIN_UNIX to TRUE. Default is CM_WIN_UNIX=FALSE.

For example:

&SetConfigParm("CQCC_CACHE_MGMT", "CM_CLEAN_HRS=2,CM_STALE_HRS=4");

45. How do I – understand the further details regarding the configuration of MAPI on E-Mail notification for ClearQuest Web

ClearQuest Web offers the option to use the MAPI service for serving e-mail notifications. In some cases, a MAPI server may either not be available or may not be configured correctly. In these cases, several changes have to be made in order to successfully use MAPI correctly.

Solution

For detailed instructions on how to configure MAPI services and ClearQuest Web to work together for usage with e-mail notification, please refer to the "Configuring Rational ClearQuest Web to use..."
ClearQuest – How do I

MAPI as the mail transport for e-mail notification” section of the IBM Rational ClearQuest and ClearQuest MultiSite Release Notes for Version 7.0.0

A request for enhancement (RFE) exists that expresses the need for this information to be available in either the ClearQuest installation documentation or the ClearQuest Information Centers.

Note: With Service Pack 2 for Outlook 2000, Microsoft made modifications to the Collaboration Data Objects (CDO) libraries, that by default prompt the user to confirm the use of their MAPI profile every time the MAPI profile is accessed (for example by ClearQuest). This prevents E-Mail notification from working when using MAPI on ClearQuest Web. For information on which version of the Collaboration Data Objects is compatible with ClearQuest, see technote 1209308.

46. How do I – understand about ClearQuest 2003 Mailreader support with MAPI and Microsoft Outlook

A method that allows the IBM® Rational® ClearQuest® 2003 Mailreader to work with Microsoft® Outlook and the MAPI protocol. Microsoft applied a security update package to the file cdo.dll, that causes a popup dialog window for each MAPI request asking a user to confirm the access. The security message sent by Outlook is not visible to the Mail Service and can not be confirmed.

Solution

The ClearQuest Mailreader uses the mailservice.exe file as a Windows NT service in the ClearQuest 2003 release. The Mailreader can use either the SMTP or MAPI protocols.

Note:

- The ClearQuest 2003.06.15 Release notes state that the ClearQuest Mailreader does not work with MAPI on Microsoft Windows 2000 and Windows XP.
- The ClearQuest 7.0 version of Mailreader does not support the MAPI protocol.

Support for MAPI poses many challenges for Rational Products. See technote 1209308 for details on the supported versions of the required CDO.dll file.

There is a workaround for Mailreader when using newer versions of the CDO.dll file (such as the version that ships with Outlook 2003), to suppress the warning message, and allow Mailreader to perform. Rather than running Mailreader as a service, start the ClearQuest Mailreader Service from a Command prompt using the following command:

```
mailservice.exe -debug.
```

Whenever the service is started, the first time an email arrives, the security message will appear and can be confirmed. Once this has been done the first time, the Mailreader will continue to run without user interaction.

47. How do I - configure the MAPI protocol for email with ClearQuest

There is a known issue with Microsoft® Outlook users, where a pop-up warning message appears when using versions of the CDO.DLL file that have a Microsoft Outlook security update applied. The message displayed is:

"A program is trying to access e-mail addresses you have stored in Outlook. Do you want to allow this?"

This issue initially arose as Microsoft tightened security on its Outlook product and the MAPI protocol.

Resolving the problem

CDO (Collaboration Data Objects) must be installed to allow ClearQuest to send email. You must use a version of the Collaboration Data Objects that does not contain the CDO E-Mail Security Update. The latest version of Collaboration Data Objects that does not contain the CDO E-Mail Security Update is in Microsoft Office/Microsoft Outlook 2000 SR1. It installs a file named CDO.DLL, version 5.0.2448.0 or 5.5.2448.0.

Note: The first version of Collaboration Data Objects that contains the CDO E-Mail Security Update was in Microsoft Office/Microsoft Outlook 2000 SP2. It will install a file named CDO.DLL, version 5.0.2652.65 or 5.5.2652.65.

How to verify CDO version

If you have Microsoft Outlook installed, verify the CDO.dll version. To verify that the CDO.dll is installed, and to verified its version number:

- Go to "C:\Program Files\Common Files\System\MSMapi\1033\" and note the version of "CDO.DLL". 5.5.2232.0

In Outlook 2003, Microsoft added the functionality to configure security settings, and to manually adjust the changes at an administrative level. It is possible to set the Outlook Security Settings to Prompt User or Automatically approve mail being sent. Receiving the warning windows indicates that this setting was set to "Prompt User".
ClearQuest – How do I

There is also a setting for macro security, where security can be set to low, allowing all macros to run without any security warnings. Security must be sent to low when using the Mailreader or e-mail notification is enabled on the ClearQuest web server.

Note: The ClearQuest 7.0 version of Mailreader does not support the MAPI protocol. For more information on configuring Outlook 2003, refer to the following white paper produced by Microsoft:

There is also an application, unsupported by IBM Rational Client Support, called ClickYes that is reported to successfully block these pop-up warnings. For more information contact Context Magic.

Databases

Failed on Installing queries message when creating user database in ClearQuest Designer

- 
- 
- 
- 
- 
- 
- 
- 
- 
- 
- 
- 
- 
- 
-
ClearQuest – How do I

Technote (troubleshooting)

Problem(Abstract)
When creating an user database with IBM Rational ClearQuest (CQ) Designer, a "Failed on Installing queries into user database" message occurs.

Symptom
Connectivity to the back-end database server is working and the back-end database has created tables. The new database is listed in Database Admin window of ClearQuest Designer. However, you are not able to connect to this database from ClearQuest clients. This can happen if you run ClearQuest Designer with a non-administrator account or an account that is not a member of the local admin group.

Cause
This is caused by not having write permissions on this registry key:

HKEY_LOCAL_MACHINE\Software\Rational Software\ClearQuest\7.0.0\Core\Databases

Diagnosing the problem
Using CQ tracing to monitor AdRegistry and Throw operations you will see error:

[CQ 0.889, 20110104, 14:01:53, 7168, 7304, 2298] AdRegistry: RegOpenKeyEx Fail: HKEY_LOCAL_MACHINE\Software\Rational Software\ClearQuest\7.0.0\Core\Databases, Access is denied.

[CQ 0.921, 20110104, 14:01:53, 7168, 7304, 2334] Throw: Can't write to the registry key "Software\Rational Software\ClearQuest\7.0.0\Core\Databases\<schema repo>\<user db name>" under either HKEY_LOCAL_MACHINE or HKEY_CURRENT_USER.

Although the message says it tried to write under HKEY_LOCAL_MACHINE and HKEY_CURRENT_USER, starting on 7.1.1 only HKEY_LOCAL_MACHINE is used.

Resolving the problem
There are three possible solutions:

1. Grant Full Control permissions on
   HKEY_LOCAL_MACHINE\Software\Rational Software\ClearQuest\7.0.0\Core\Databases for the user running ClearQuest Designer.

2. When opening ClearQuest Designer, right click icon and elect Run As Administrator. This option is only available with Microsoft Windows 7, 2008, and later.

3. If solutions 1 or 2 are not possible because of security compliances or other reasons, enable the behavior flag USE_BOTH_HKCU_AND_HKLM. This enables ClearQuest to use the HKCU registry key in addition to HKLM. For instructions on enabling a behavior flag, see technote 1449897.
48. **How do I – understand about accessing a Microsoft SQL Server database in another domain**

If the SQL Server–hosted ClearQuest databases are on a server that resides on a different Microsoft Windows domain, you might get errors when trying to create or connect to the databases.

**Cause**

This occurs when SQL Server is configured to only use "named pipes" as a network protocol. Using named pipes requires that the SQL Server be able to access files on behalf of an invoking user ID, which in turn requires the requesting user ID to be "known" in the SQL Server's domain. If your user ID is defined in one domain and the server is in another, and no domain-trust relationship exists, then the requesting user ID is not "known". Authentication fails at that point.

**Resolving the problem**

Here are some known workarounds:

**Configure User Access to the same Domain as SQL Server**

One workaround is to create a user ID in the server's Microsoft Windows domain with the same user name and password as the requesting user ID. Then, when SQL Server using named pipes to authenticate, the it succeeds.

Although this approach is simple to implement, it is not a good solution for large networks with large numbers of users, as it requires that all userid/password maintenance be done twice, once in each Microsoft Windows domain.

**Configure a Domain Trust**

Another solution is to set up a "domain trust" relationship so the domain the SQL Server "trusts" the domain that the requesting user is defined in. The trust relationship effectively makes all the users defined in the "trusted" domain visible and valid in the "trusting" domain (the SQL Server's domain).

This approach is also simply in application (and has no administrative implications like the duplicate-userid's workaround above,) it may not be consistent with your company security requirements.

**Configuring the SQL Server connection for TCP/IP**

If the previous solutions are not feasible, or are not allowed under your company security policy, then named pipes cannot be the sole network protocol for SQL Server. Configure SQL Server to use TCP/IP.

On the SQL Server, configure the server to support TCP/IP instead of, or in addition to, named pipes.

**For SQL Server 7.0:**

1. Bring up the "Server Network Utility", under **Start > Programs > Microsoft SQL Server 7.0**.
2. On the **General** tab, if **TCP/IP** does not already appear, click **Add...**
3. Set the Network Library to **TCP/IP**.
4. Ensure that the port number is 1433. Alternatively, you can select a different port and remember it for use with the client-side procedure documented below.

**For SQL Server 2000:**

1. Bring up the "Server Network Utility", under **Start > Programs > Microsoft SQL Server**.
2. On the **General** tab, if **TCP/IP** does not already appear in the **Enabled Protocols** box, select it and click **Enable >>**.
3. Select **TCP/IP** and click **Properties...**
4. Ensure that the port number is 1433. Alternatively, you can select a different port and remember it for use with the client-side procedure documented below.

**For SQL Server 2005:**

1. Bring up the "SQL Server Configuration Manager", under **Start > Programs > Microsoft SQL Server 2005 > Configuration Tools**.
ClearQuest – How do I

2. Expand the SQL Server 2005 Network Configuration option, and select Protocols for MSSQLSERVER.

3. Enable TCP/IP if it is not already enabled.

4. Double-click on TCP/IP.

5. On the IP Addresses tab, ensure that the port number for the applicable IP address is 1433. Alternatively, you can select a different port and remember it for use with the client-side procedure documented below.

Note: At this point, depending on network configuration, you might be able to connect to the databases. Test out the connection on a ClearQuest client, and proceed with these instructions if connection errors persist.

Configure each ClearQuest client to use TCP/IP for its SQL Server connections

Next, you will need to configure each ClearQuest client workstation to use TCP/IP for its SQL Server connections. To do that, go to each client machine and define an ODBC System DSN. A "system DSN" is a specification that supplies connection parameters that this client machine will use when connecting to a specific SQL Server host. To set up the system DSN, do the following:

1. Bring up the ODBC administrator dialog: Start > Settings > Control Panel > Administrative Tools > ODBC. Note: Its name may be "ODBC", "ODBC Data Source Administrator", or other similar names.

2. Select the System DSN tab and click Add...

3. Select the SQL Server driver and click Finish.

4. Enter any name you like in the "Name" field and enter the SQL server's hostname in the "Server" field. Enter a description for the connection if desired. Click Next.

5. Choose SQL Server authentication, which will enable the login ID and password boxes below.

6. Press the Client Configuration button.

7. In the "Network libraries" selection, choose TCP/IP (details vary depending on your ODBC version). Set the "Computer Name" field to the server's hostname unless specific network issues at your site require you to do otherwise (see note below). Set the port number to match the TCP/IP port number you chose on the server side above (1433 by default).

8. Click OK to exit the Client Configuration dialog.

9. Enter the DBO (database owner) login name and password for the SQL Server database that you are connecting to and click Next.

10. Choose the defaults in the next three steps of the wizard, until you get to the final confirmation dialog and see the "Test Data Source..." button. Click the Test Data Source... button to ensure that a connection can be made. It should indicate that the tests worked successfully.

Note: In step 7, the "Server Alias" and "Computer Name" fields normally should be set to the same value: the hostname of the SQL Server machine. However, if your site has special requirements you may need to do otherwise. The details are as follows:

- **Server Alias**

  The "Server Alias" field is the name that all applications (like ClearQuest) will use to connect to the SQL Server. You should use this name as the "Server" name when creating your ClearQuest databases in the ClearQuest Maintenance Tool or ClearQuest Designer. The name used here must be the same on all ClearQuest client workstations, as this value will be stored in the ClearQuest database and used by all ClearQuest-related programs when connecting to the database server. This should usually be set to the SQL Server computer’s hostname although technically it does not need to be the same.

- **Computer Name**

  The "Computer Name" field on the ODBC dialog specifies the IP-level connectivity information for reaching the computer on which SQL Server is running. Normally this should be the same as the server hostname but if your site has special requirements you can put a domain-qualified hostname or even the SQL Server host's IP address in the "Server" field instead of the hostname.
ClearQuest – How do I

You would use this, for example, if there are two hosts with the same name in your network, or if WINS/DSN are not set up at all so you cannot resolve host IP addresses by any other mechanism than direct IP address.

The best approach in such cases is to resolve the underlying issues (duplicate hostnames or WINS/DNS setup) so as to allow the use of the "simple" hostname in both the "Server Alias" and "Computer Name" fields; however if you are unable to do that due to network management constraints you can work around the problem by using the domain-qualified hostname or IP address in the "Computer Name" field.

The "Computer Name" field does not have to be specified identically on every ClearQuest client workstation, but on every workstation it must be specified in a form that will allow the client to "see" the server at the IP level (use 'ping' to determine this).

Having set up the SQL Server to support TCP/IP protocol and having configured the client workstations to use it, you should now be able to use ClearQuest together with your SQL Server

49. How do I – find sample response files for IBM Rational ClearQuest

The attached response files provide a template for installing IBM Rational ClearQuest on a specific platform. To use the files below, download and modify following the instructions provided within. For more information on using response files, see the IBM Installation Manager Information Center at:

http://publib.boulder.ibm.com/infocenter/install/v1r2/index.jsp

clearquest_response_linux_x86.xml clearquest_response_nt_i386.xml clearquest_response_suns.xml

Related information
Test Databases in CQ Web Java
Test Databases in CQ Eclipse RCP
Test Databases in CQ Web 7.1

50. How do I – access a test database from the ClearQuest Web Java client

In order to use a database designated as a test database within the ClearQuest Designer, add the parameter "test=1" to the URL. When this is specified, the global toolbar is replaced by a simple text field, which will allow you to type in the name of a test database. The database marked as test in the ClearQuest Designer can then be specified in that field.

An example of the URL would be:

http://localhost/cqweb/login?test=1

Note: This feature was broken in original 7.0.0 release of ClearQuest, but was fixed in version 7.0.0.1 and later.

Alternatively, you can use a URL that includes the schema repository, the logical database name of the test database and a user name and password. The following sample URL uses the same format as the 7.0.x shortcut functionality where values in the `{*}` must be supplied by the user.
http://{{CQ WEB SERVER}}/cqweb/main?command=GenerateMainFrame
&service=CQ&schema={{(CONNECTION NAME)}}&contextid={{(DATABASE NAME)}}
&username={{(CQ USERNAME)}}&password={{(CQ PASSWORD)}}&test=1
For example:
http://localhost/cqweb/main?command=GenerateMainFrame&service=CQ
&schema=7.0.0&contextid=SAMPL&username=engineer&password=password&test=1
See technote 1136402 for more information on ClearQuest URLs.

Note: Selecting "Test Work" from the ClearQuest Designer will still open the test database in the ClearQuest native client for Microsoft® Windows®. A request of enhancement exists, RFE RATLC01202361, for an option to change the ClearQuest client that opens upon selecting Test Work in Designer. This feature is available starting in ClearQuest 7.1. See technote 1335125 for more details.

51. How do I - move ClearQuest databases

When moving IBM® Rational® ClearQuest® databases to new locations, the ClearQuest utilities should be used to perform the actual move. Database vendor utilities do not preserve or update the internal database settings used by ClearQuest.

The ClearQuest utility move operations copy the current databases to new target databases, which can be on the same server or another database vendor server. Whether or not you change database vendors/versions, the original ClearQuest databases are preserved. The old databases are locked by ClearQuest to prevent users from using them inadvertently.

Before you actually move any databases, you should:
1. Make sure all of your schemas are checked in.
2. Backup all your current ClearQuest databases.
3. If you are using IBM DB2®, Microsoft® SQL Server or Oracle target databases, create new, empty databases/logins on the target server, one new database for each database to be moved. They will hold the moved databases.
4. Make sure all your ClearQuest users, both Designer and Client, are logged off, and not using ClearQuest until the moves are completed.

The following steps summarize how to move your ClearQuest master and user databases:
1. Move the master database first.
   a. From any machine with ClearQuest installed as admin, open the ClearQuest Maintenance Tool from the Start menu.
   b. Select the connection to your master database and chose the option in the menu Schema Repository > Move, and follow through the dialogs (You have to be Administrator of ClearQuest to do this operation), specifying the properties of the new master.
   c. This ClearQuest machine will be configured automatically to use the new master after the move.
   d. Each of the ClearQuest client machines must run their Maintenance Tool, and connect to the new master database (or you can export the profile and send the cqprofile.ini to the other users so that they can import it to get the new connection parameters to your master database).
2. Then move each user database:
   a. From the same ClearQuest machine as in step 1, open the ClearQuest Designer.
   b. Select Database > Move User Database.
   c. Select the user database you want to move.
   d. Select the Properties button.
   e. Change the databases properties to the new database information.
   f. Click on Move.
   g. A message will indicate that the properties have been changed

Repeat step 2 for each user database you want to move. Each move is actually a copy of the original databases, and each of the old databases in steps 1 and 2 will be locked by ClearQuest to prevent users from using them inadvertently.

To unlock the original databases after the move is completed refer to technote 1133810. After all databases have been moved, and once the users are pointed to the new master database (step 1d), they can begin using ClearQuest again.

52. How do I – understand the required steps after moving databases without using ClearQuest tools

If ClearQuest databases are moved using vendor specific, non-ClearQuest tools, the following steps must also be performed:

1. Restore the databases from back up.
2. Create new SQL Server logins. Create a new login for each database.
3. If using Microsoft SQL Server, see solution [1134548](#) for details on changing object ownership.

4. Once the user id’s (UID) have been changed, run the SQL statement "select * from sysusers", to ensure that the database is now pointing to the correct login. This is done in the Microsoft SQL Server Query Analyzer.

5. Repeat steps 3 and 4 for each database.

6. Open the ClearQuest Maintenance tool and update the schema repository with the new login information.

7. Select the connection from the list and go to the schema repository menu > **Update > Selected Connection**. Enter the properties in the various fields. When asked for the login, enter the newly created one. Once all the information has been entered, press the next button.

   If no connection exists, go to the schema repository menu > **Update > Other**. Enter the properties in the various fields. When asked for the login, enter the newly created one. Once all the information has been entered, press the next button, and create a new connection.

8. When prompted, enter the ClearQuest administrator login, typically **Admin** by default. If the password has not been changed, the default is a blank password.

   If this is successful, a message should display stating that the schema repository has been successfully updated with the new location information.

9. It should now be possible to log into ClearQuest Designer.

10. Once logged into the Clearquest Designer, go to the database menu>update user database properties. Choose the logical database from the list and then enter all the information for the database, including the new login. If this goes through successful, a message will then display stating that the database information has been updated.

    Repeat the above step for each database.

   Log into the user database, to test this out.

**53. How do I - rename the logical database name in ClearQuest**

There is currently not a method to rename the ClearQuest Database name (the one that a user sees when logging into ClearQuest). The Database name (for example: SAMPL) is stored in the ClearQuest database and that name combined with the unique ID of a record create the records ID field (for example SAMPL0000001).

A workaround to this problem would be to create a new database:
1. Create a new database in ClearQuest Designer.
2. Export all the data from the original Database.
3. Massage the data (filter and keep the records that you want).
4. Import the data into the new database, saving the old record ID in a field (OldId) setup to hold the old ID.

This will ensure that the new Database functions correctly, and at the same time has the old data and old record ID’s.

**54. How do I - index the History table for ClearQuest**

When databases become large, performance can drop for various actions.

Prior to ClearQuest 7.0.0.0, the History table is not indexed by default when creating databases. The queries run against that table can return results in a linear fashion, incrementally slowing the database over time as the size increases.

**Answer**

If the ClearQuest databases were created with software versions prior to 7.0.0.0, these indexes likely do not exist. To potentially increase the performance on databases, apply an index to the History table. The following is an example of SQL code used to create an index for each. This can be done with [PDSQL](#) or the vendor command line tools.

```sql
create index history_entity_idx on history (entitydef_id, entity_dbid);
```
ClearQuest – How do I

This activity is available for IBM DB2®, Oracle, and Microsoft® SQL Server™. For more information on creating indexes for the back end databases, refer to your database administrator (DBA).

55. How do I - Index the History table to increase performance (pre v7.0)

The database History Table is not indexed by default in ClearQuest versions earlier that the 7.0 release. If you are using an earlier version, upgrade to the latest release. If you are using an earlier version of ClearQuest, it is possible manually create the History table. To increase performance, apply an index to the history table.

The SQL statement to complete this action is:

cREATE INDEX history_entity_idx ON owner.history (entitydef_id, entity_dbid);

This SQL statement can be applied using the native SQL Editing tools for the database being used (SQL Plus for Oracle, Microsoft® SQL Query Analyzer for SQL Server...). This command may also be run from a command prompt using PDSQL, which is a command line SQL Editor installed with ClearQuest.

(For additional information on using PDSQL please refer to the Related Information link).

**Note:** Create fresh backup copies of your databases prior to performing any commands against those databases. This provides a recovery point in event of unforeseen database failure.

56. How do I – understand why you must use unique default tablespaces for each of the ClearQuest database Oracle login accounts

There is some confusion about what are requirements for default tablespaces and what are recommendations:

- It is a CLEARQUEST REQUIREMENT that each ClearQuest database (the schema repository and each user database) have its own unique Oracle user id.
- It is an Oracle REQUIREMENT that each Oracle user id has a designated default tablespace and a designated temporary tablespace.

As to what these tablespaces can be, and whether two or more users can share them, the following rules apply:

- It is STRONGLY RECOMMENDED that you don't use the Oracle "SYSTEM" tablespace for any of this since that's usually reserved for the Oracle system to maintain its own organizational data. Putting "user-type" data into such a tablespace is extremely bad practice.
- It is RECOMMENDED that you separate your Oracle tablespaces so that each Oracle user has its own unique default tablespace. This is not a technical requirement; it will work if you violate this recommendation. The reason we recommend it is that it makes administration of the Oracle instance easier (creating/deleting/relocating tablespaces, ensuring sufficient space availability, performing backups, etc).
- For the "TEMP" tablespace, it is not a technical requirement for them to be separate but it's a good idea from the standpoint of managing the Oracle instance. Consult your Oracle DBA for their recommendation.
  1. Putting everything together is easier to manage in some sense because then there's just one tablespace to manage so, for example, if the tablespace runs out of space, you find some empty space and add another datfile to the tablespace. However, this approach is not good in a commercial environment because it doesn't support the usual strategy of improving Oracle performance by physically and logically separating things so they don't get into contention. This implementation is likely to perform poorly.
  2. Making everything separate is probably more efficient and unrelated objects will not be affected when you do things like backups. However, since it means you have more tablespaces, there is more complexity inherent in the maintenance of the tablespaces.

57. How do I – understand why a ClearQuest License is not consumed when a user is logged in via External API Script

ClearQuest (R) License is not consumed when a user is logged in via External API Script

Local fix

Problem summary

Problem conclusion

Temporary fix

Comments

By design, the ClearQuest API does not consume a license. ClearQuest has never required licenses for running scripts. The primary reason for this is that customers frequently use scripts
ClearQuest – How do I

that perform ClearQuest operations for automated tasks and you would not want such automated tasks to fail because of license-load fluctuations.

58. How do I – understand ClearCase and ClearQuest UCM Integration and support for multiple ClearQuest dbsets

The IBM Rational ClearCase and ClearQuest UCM Integration supports multiple ClearQuest dbsets.

Note: When only one ClearQuest dbset (master repository) exists, then the UCM integration will correctly use that dbset.

If multiple ClearQuest dbsets exist, then the desired ClearQuest dbset can be selected by doing the following:

On Microsoft® Windows®, define the following key:

Note: This solution contains information about modifying the system registry. Before making any modifications to the Microsoft Registry Editor, it is strongly recommended that you make a backup of the existing registry. For more information describing how to back up the registry, refer to the Microsoft Knowledge Base article 256986.

HKEY_LOCAL_MACHINE\SOFTWARE\Atria\ClearCase\CurrentVersion\ClearCase Squid
  a. Define the string "DBSet"
  b. Set the value to the dbset_name that you wish to use.

On UNIX® and Linux®, set the following environment (ENV) variable:

setenv SQUID_DBSET "dbset_name"

Note: The csh shell uses SETENV command. If your UNIX/Linux shell is set to ksh or bash, you have to use the EXPORT command to set the SQUID_DBSET and not the SET or SETENV commands.

In either case, the value of dbset_name should be the name of the ClearQuest dbset and not the name or the path name of the ClearQuest master database itself.

59. How do I - about PDSQL and how to use it

ClearQuest provides a command line SQL tool in the ClearQuest directory called pdsql. It can be used to open a SQL session with any database vendor supported by ClearQuest. To use pdsql, open a DOS window in the ClearQuest directory, and enter one of the following commands to log into a back-end database:

SQL Server:
  either: -dsn <ODBC-DSN> -u <user> -p <pass>
  or: -v ss -s server -u <user> -p <pass> -db <database>
  or: -v ss -s server -u <user> -p <pass>
          (the user’s default db as declared to sqlserver will be used)

For connect options, use the parameter -co. Here is an example for SQL Server:

      pdsql -v ss -s 192.168.0.75 -db CQ -u cqadmin -p "" -co PORT=1433

Oracle:
  either: -dsn <ODBC-DSN> -u <user> -p <pass> or: -v ora[7|8] -s <alias> -u <user> -p <pass> (alias is the SQL*Net or Net8 alias defined for the Oracle database).

NOTE: may need connect options (separated by semicolon):

      HOST=<host>
      SID=<sid>
      CLIENT_VER=<7, 8.0, 8.1> default is 7 for ora7, 8.0 for ora8
      LOB_TYPE=<LONG, CLOB> default is LONG

DB2:
  either: -dsn <ODBC-DSN> -u <user> -p <pass> or: -v db2 -db <alias> -u <user> -p <pass> (alias is the cataloged name for the database defined using DB2 Client Configuration Assistant).

SQL Anywhere:
      pdsql -v sa -s <server-service-name> -db <path-to-db-file> -u admin -p admin

NOTE: Add connect options for SQL Anywhere 8.x:

      -co "SERVER_VER=8.0"
ClearQuest – How do I

MS Access:
-v access -db <some valid access path> -u admin

NOTE: For Access and SQL Anywhere, put the <path-to-db-file> in double quotation marks.

Additional notes on PDSQL usage:
For pdsq on-line help and features, just type:

    pdsql -help

Pdsq supports all common SQL commands. There are 2 special pdsq commands, "tables" and "columns", that can be used, for example, to see if you are in the right database. Examples:

    pdsql> tables;
    pdsql> columns table-name;

The table and column names to use in subsequent SQL are those listed by the above commands; there should be no table prefixing necessary, regardless of db vendor.
Sample SQL:

    pdsql> update defect set new_field = old_field;
    pdsql> select new_field from defect;

Commands are executed when the semicolon is read. No explicit "commit" is required in pdsql.

To exit pdsql, use the quit command:

    pdsql> quit;

60. How do I - rename a dbset in for Rational ClearQuest on UNIX-based systems

There is no rename option available in the Linux or UNIX based versions of ClearQuest when using the command cqreg to manage connections (dbsets). To workaround this, you can add a new dbset with a new name and same database information, and then drop the old dbset. This can be done using the cqreg options of add_dbset and drop_dbset.
Starting with version 7.0.0, ClearQuest uses an Eclipse RCP client. This client allows for the creation and managing of database connections with a GUI interface, which is a more flexible and easy to use method than using cqreg. This screen can be accessed through via File --> Database --> Manage Connections.

61. How to unlock a ClearQuest database that has been locked

This technote explains how to resolve a locked database after a database copy or a failed upgrade of IBM® Rational® ClearQuest® databases. To resolve this issue you must either restore the database or unlock it.

Symptom
A ClearQuest user database is locked after a failed upgrade. If the upgrade is attempted again, the following error message is displayed:

    Access to this database is currently denied. The database is locked while upgrading the application.

Note: When using the installutil copyschemarepo and copyuserdb commands, the original databases are also locked, and remain locked once the new databases are created, to prevent old copies from being used. This solution can unlock these databases as well. See technote 1118690 for details on how to use the copyschemarepo and copyuserdb commands.

Cause
When the upgrade process is initiated, ClearQuest temporarily "locks" the database to prevent other transactions from accessing the data while the upgrade is in progress. The lock prevents new users from connecting to a database during the upgrade process; this is intentional and normal.
When a database is locked, users are not allow to access it, therefore when users try to login ClearQuest, they will denied access.
Once the upgrade transaction has successfully completed, the database lock should be released and users can once again connect to the database. If the upgrade does not complete successfully, the databases are left in a locked state.
Once a the original database is unlocked, it is possible to use it again.

Resolving the problem
ClearQuest – How do I

To resolve a failed database upgrade, restore the affected user database using a backup that was created just before upgrading it. Since the backed-up version was not locked at the time it was backed up, the database will no longer be locked after it has been restored.

Procedure to unlock a locked user database

Use the procedure described below to manually unlock the user database and then retry the upgrade. If it fails again, contact Rational Technical Support for assistance. If the upgrade appears to succeed, then carefully test the resulting user database to ensure that it includes all the latest schema changes. If not, contact Rational Technical Support for assistance.

The syntax and examples of both commands are shown below for ClearQuest 2002, 2003 and ClearQuest

**Note:** Not all databases and database versions are supported by all ClearQuest versions.

To unlock a user database:

1. Use a ClearQuest command line utility to unlock the database.
2. The `installutil unlockschemarepo` command is used to unlock a ClearQuest Schema Repository.
3. The `installutil unlockuserdb` command is used to unlock a ClearQuest user database.
4. To unlock the user database using a ClearQuest command line utility, follow these directions:
5. Open a command prompt window and type the following command:

   ```
   installutil unlockuserdb dbvendor server db dbologin dbopassword connectoptions
   ```

   To see the required parameters for the command, enter only the following at a command prompt:

   ```
   installutil unlockschemarepo
   or
   installutil unlockuserdb
   ```

### Parameter Description

<table>
<thead>
<tr>
<th>Installutil Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>unlockuserdb</td>
<td>Command to unlock a user database. (The remainder of the parameters remain the same for all the commands referenced in this technote).</td>
</tr>
<tr>
<td>dbvendor</td>
<td>The database vendor name. Available choices are MS_ACCESS, SQL_ANYWHERE, SQL_SERVER, ORACLE, DB2. <strong>Note:</strong> Vendor names must be capitalized.</td>
</tr>
<tr>
<td>server</td>
<td>hostname for the database server for MS Access - machine host name for DB2 - database alias name for Oracle - Oracle SID (SQL*Net Alias for CQ 2003.06.12 and earlier) for SQL Anywhere - service name for SQL Server - machine host name of the SQL Server</td>
</tr>
<tr>
<td>db</td>
<td>database name for MS Access - \full\path\to\file.mdb for DB2 - database name containing your user db for Oracle - db login who owns the tablespace for the user db for SQL Anywhere - \full\path\to\file.db for SQL Server - database name containing your user db</td>
</tr>
<tr>
<td>dbologin</td>
<td>The database owner user login.</td>
</tr>
<tr>
<td>dbopassword</td>
<td>The database owner password.</td>
</tr>
<tr>
<td>connect_options</td>
<td>Optional parameters that vary by vendor. (Refer to the latest <a href="#">ClearQuest Documentation Supplement</a> for details on use of the vendor connect options).</td>
</tr>
</tbody>
</table>

An example of the command in usage for Oracle would be:

**Sample command for ClearQuest versions 2003.06.13 and later that use Oracle with the CLOB datatype:**

```
installutil unlockuserdb ORACLE oracle_server_name SID dbologin dbopassword "LOB_TYPE=CLOB"
```

**Sample command for ClearQuest versions 2003.x and earlier that use Oracle with the Long datatype:**

```
installutil unlockuserdb ORACLE oracle_server_name SID dbologin dbopassword
```
"HOST=abc;SID=Oracle;SERVER_VER=8.1,CLIENT_VER=8.1;LOB_TYPE=long"

**Note:** Parameters do not have to be in quotes, unless a parameter is empty, in which case an empty set of double quotes (""") should be used as a place holder. Database vendor names must be capitalized.

**Example of the command in usage for Microsoft SQL Server:**

**Sample command for ClearQuest databases that use Microsoft SQL Server:**

```
installutil unlockuserdb SQL_SERVER sql_server_name host_name dbologin dbopassword ""
```

**Note:** The last argument is the connection options, which for SQL Server could be a port change. The dbologin and dbopassword are the username and password used by ClearQuest to login to the user database defined by the alias or database name. They are not necessarily dbo usernames.

**Example of the command in usage for IBM DB2:**

**Sample command for ClearQuest databases that use DB2:**

```
installutil unlockuserdb DB2 db2_server_name alias dbologin dbopassword ""
```

**Note:** The last argument is the connection options, which for DB2 could be a port change. The dbologin and dbopassword are the username and password used by ClearQuest to login to the user database defined by the alias or database name. They are not necessarily dbo usernames.

**Example of the command in usage for Sybase SQL Anywhere:**

**Sample command for ClearQuest versions 2003.06.00 through 2003.06.15 that use SQL Anywhere version 8:**

```
installutil unlockuserdb SQL_ANYWHERE sybsqla C:\SybSQLA\sampl.db admin admin SERVER_VER=8.0
```

The dbo username and password is the account for the Sybase database's DBA, not the Microsoft Windows account service user.

**Example of the command in usage for Microsoft Access:**

**Sample command for ClearQuest databases that use Microsoft Access:**

```
installutil unlockuserdb MS_ACCESS "" c:\temp\sampl.mdb "" "" ""
```

**Note:** Parameters do not have to be in quotes, unless a parameter is empty, in which case an empty set of double quotes (""") should be used as a place holder. Database vendor names must be capitalized.

**Create Back-up files**

**Note:** Always make new database back-ups of your schema repository and users databases prior to making schema changes and performing database upgrades. Failure to create back-up copies can limit your ability to recover from an upgrade failure, design change issues or other unforeseen failures. If a backup was not taken before the upgrade and the upgrade fails, you might be able to recover by manually unlocking the database and retrying the upgrade. There are three possible outcomes of this process:

1. The upgrade will succeed and your database will be upgraded successfully.
2. The upgrade will fail because the data has already been partially upgraded.
3. The upgrade will appear to succeed but not all the schema changes will be applied to the user database.

Important notes from the **Upgrading an existing database** help topic:

- Before upgrading a database, make sure no users are connected to it. ClearQuest prevents new users from connecting to a database while you are upgrading it, but does not disconnect users who are connected before you begin the upgrade.
- Always upgrade a test database to the latest schema version before changing your production database. You should also test your changes by using the ClearQuest client, especially if you have modified hook code. You cannot roll back a database after you have upgraded it with a newer schema version. To protect your database, you should back up the database before upgrading it.

**Note:** ClearQuest does not provide a mechanism to back up databases. Check your database vendor documentation for details on how to backup your database.
ClearQuest – How do I

Schemas

62. How do I - create a Project Record with the ALM Schema

How can I create an ALM project with the ALM Schema of IBM Rational ClearQuest? The ALMProject record type is not available in the drop-down list

**Answer**

The ALMProject record type is not available if there is no ALMAdmin record. Create an ALMAdmin record and add a user account. There should be one ALMAdmin record that initially has one member (For example, the admin account). Once this is done, the user in the ALMAdmin record can create ALMProject records. However, to view an ALMProject and other project-related records, a user must either have Security Administrator privileges or be added to security roles for the project. The correct sequence is to first create the ALMSecurityPolicy record(s) and then add them to the ALMProject. Otherwise, even ALMAdmin users cannot see the project records they have created.

63. How do I - export and import ClearQuest schemas

ClearQuest (CQ) has a command line utility, `cqload`, that allows an entire schema to be exported from one schema repository (MASTR) database and imported into another.

To use `cqload`, it is necessary to use the DOS command prompt. In addition, the schema to be exported, must not be checked out. If `cqload` is run while the CQ Designer is open, it will need to be closed, then restarted in order to show the changes made by `cqload`.

The `exportschema` subcommand is used to export an entire schema to a text file. This schema text file can then be imported into another schema repository using the `importschema` command. The syntax and examples of both commands are shown below.

**Example:**

```bash
cqload exportschema -dbset <connection name> <cq-login> <cq-password> <schema name> "<script full path name>"
```

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>&lt;connection name&gt;</code></td>
<td>Existing connection associated with the schema repository database as viewed</td>
</tr>
<tr>
<td></td>
<td>in the CQ Maintenance Tool. 2003.06.00 (shown in above example) is the</td>
</tr>
<tr>
<td></td>
<td>default set up automatically in the 2003 release of the CQ Maintenance Tool.</td>
</tr>
<tr>
<td><code>&lt;cq-login&gt;</code></td>
<td>CQ administrative login name</td>
</tr>
<tr>
<td><code>&lt;cq-password&gt;</code></td>
<td>CQ administrative password (enter &quot;&quot; if the value is blank)</td>
</tr>
<tr>
<td><code>&lt;schema name&gt;</code></td>
<td>Name of the schema exactly as it appears in CQ Designer. This is case</td>
</tr>
<tr>
<td></td>
<td>sensitive.</td>
</tr>
<tr>
<td><code>&lt;script full path name&gt;</code></td>
<td>This must be surrounded by double quotes. A UNC path format can also be used.</td>
</tr>
</tbody>
</table>

**Example:**

```bash
cqload exportschema -dbset 2003.06.00 admin "" DefectTracking "c:\temp\schema.txt"
```

This command will export the contents of the DefectTracking schema to the file `c:\temp\schema.txt`.

The `importschema` subcommand is used to import an entire schema from a textual representation, and add it to the schema repository. It can be useful for sharing entire schemas with sites that cannot access the main schema repository, or have a different schema repository.

**Example:**

```bash
cqload importschema -dbset <connection name> <cq-login> <cq-password> "<script full path name>"
```

**Note:** The file `C:\temp\schema.txt` was created using the `cqload exportschema` command. During that process, the name of the exported schema was saved into this file. So when this schema is imported, the schema name will be used to create the schema with `cqload importschema`. If that name is already in use in destination schema repository, the import will fail.

**Note:** Use of the `cqload` command does not effect the users of any production databases, unlike database upgrade operations that would require ClearQuest users to exit a database prior to an upgrade.
ClearQuest – How do I

64. How do I – understand IBM Rational ClearQuest general schema design performance

Katur Patel (katpatel@us.ibm.com), ClearQuest CAG Engineer, IBM
17 Jul 2007

Schema customization is one area within IBM® Rational® ClearQuest® where your decisions as a designer can have a major positive or negative impact on performance. Schemas are often designed with only functional testing in mind, without taking into account production transaction volumes or the effect of a Web interface. Designing a schema with best practices in mind will help cut down on unexpected behaviors and facilitate a smoother, more predictable implementation.

Overview
This article is a best practices guide for IBM® Rational® ClearQuest® schema design. Schema customization is one area within ClearQuest where your decisions as a designer can have a major positive or negative impact on performance. Schemas are often designed with only functional testing in mind, without taking into account production transaction volumes or the effect of a Web interface. However, changes that might be acceptable in a single-user environment can cause significant performance issues when you are running a schema in a larger environment with a multi-user Web interface.

A poorly designed schema, in addition, can lead to unexpected behavior in native clients as well as the Web interface. Designing a schema with best practices in mind will help cut down on unexpected behaviors and facilitate a smoother, more predictable implementation.

The recommendations included in this article represent general best practices. Keep in mind, though, that ClearQuest schema design (like any other application development process) is an iterative process. Schema designs should be planned out, reviewed, developed, thoroughly tested for both function and load, then reviewed and revised again until they meet the needs of the user community.

It is also worth noting that while ClearQuest is a flexible and configurable change management system, it is not intended to be a complete program development environment. It is designed to help you customize out-of-the-box schemas, not to completely re-implement the underlying database application. If you find yourself writing thousands of lines of hook code in ClearQuest, you should probably look to simplify your business use cases instead of trying to capture and implement these complex rules in your hooks. The result will be a system that is much easier for you to deploy and maintain. It will also be much more usable for your team members who are using the application to track defects and change requests (see the Resources section for more details).

This article looks at best practices in two areas:

- Schema customization
- General hook considerations

Unless otherwise noted, all recommendations are not specific to any database vendor, operating system, or platform.

Schema customization

Minimize the number of fields in each record type

It is best to minimize the number of fields in each record type. If you have numerous fields, regardless of whether they are used or not, it can impact performance to a large extent. Below are some points that impact this guideline:

- Having more fields increases the volume of data being transferred over the network between clients and servers. For example, when the form displays on the ClearQuest Web interface, all the fields' properties (field types, choicelists, field length, and requiredness) are calculated. Certain commonly-used ClearQuest API operations, such as LoadEntity and GetEntity, will query all the fields from the database.
- As the load on the ClearQuest Web server increases, the potential cost of a large number of fields multiplies with the number of user logins. The backend database will grow faster, with more fields, which increases disk space usage on the database server. A larger database also increases record seek time, because there are more database rows and columns to search.

Recommendations:

- Consolidate fields where possible.
- Avoid redundant fields where not needed.
- Use the ClearQuest Designer to delete fields that are not used instead of just removing them from forms. Never delete fields or columns directly from the backend database.
- Avoid use of the LoadEntity and GetEntity API calls where possible; instead, query the record type to return only fields that are needed.

Match the lengths of types of fields to the needs of your data

Defining field lengths to match the needs of your field can reduce the volume of data passing between the application and the database servers. This can be particularly beneficial when you work on networks with high latency. It can also help reduce your database size and the amount of memory allocated per field. Using the correct data type for fields (for example, using a SHORT_STRING instead of a MULTILINE_TEXT, or using INT instead of SHORT_STRING) can also help general database performance.

Each database vendor has different requirements in this area, so please refer to your database management system vendor documentation for more information.

Recommendations:

- Define all SHORT_STRING fields with an appropriate field length.
ClearQuest – How do I

- Minimize your usage of MULTILINE_TEXT types when you can use another data type. If your field will not use more then 255 characters, using SHORT_STRING would be better.
- Each database vendor will have different guidelines for data type usage and performance.

Consult your database vendor for specific information on data type usage and management.

Use separate Submit and Record forms
ClearQuest Designer allows you to create two unique types of forms for each record type; a Submit form and a Record form. Each of these forms can contain a different set of fields and images. If you must have a large number of fields and images on forms, it is best to create separate Submit and Record forms. This separation cuts down on the amount of unnecessary data that needs to be displayed to users each time they submit or modify a record. It also helps cut down on loading unnecessary choicelist data, which is calculated during form loads and value changes.

Limit the number of multiple choicelists on forms
A form consisting of multiple choicelists of data can have a large negative impact on performance. Particularly in the ClearQuest Web environment, choicelist data that appears on the form must make several hops though the network before it is presented to the user’s screen. Therefore, limiting their use will improve response time.

When a form is first loaded, the browser machine sends a request to the ClearQuest Web application. The request is transferred from the Web application to the ClearQuest server components. The request is then transferred to the database server, and the results are transferred back through the same set of components, as shown in Figure 1. The data is transferred in XML format, and with high latency networks it can take a good amount of time to present the data in the form’s choicelist.

Figure 1. The path taken by choicelist data

Recommendations:
- Reduce the number of choicelists on a form to help reduce the amount of data being transferred.
- Eliminate duplicated fields on forms.
- Use separate Submit and Record forms so that there are fewer fields on each form.

Limit the amount of data in choicelists
Having a lot of data in each choicelist on a form can also slow performance down, since the data is transferred though the same multi-step process as described in the previous section. This number is not easily quantifiable, because each environment is unique. It is best to test in your environment to determine the threshold of an acceptable amount of data. It is also important to note that having extraneous data in choicelists not only causes performance problems, but also makes it difficult for the user to search through.

Recommendations:
- Avoid adding reference fields to forms that reference large record types (record types that have many fields).
- Use a choicelist hook to limit the amount of data being populated in the choicelist.
- Reduce the number of items in dynamic choicelists (dynamic choicelists greater then about 100 items can be inefficient, and their use is not recommended).
- Use separate Submit and Record forms so that there are fewer fields on each form.

Limit the use of "Recalculate choicelist"
In your schema design, you should use the Recalculate choicelist option sparingly. When you select this option, it will fire the choicelist hook that is associated with the field when the form is first loaded (and with every subsequent change to any other field on the form). If the choicelist hook associated with the field is large, and there are many fields that have this option selected, then calculating the choices in the field can be a very expensive operation.

Recommendations:
- Use the Recalculate choicelist option only on fields that are truly dependent on other changes on the form.
- Use a Value Change hook in conjunction with the API call InvalidateChoiceList to force a refresh of this field only when the parent field is changed.
- Use separate Submit and Record forms so that there are fewer fields on each form.

Limit the use of dependent choicelists
Use of dependent choicelists which are several layers deep should be avoided when possible. Dependent choicelists pose the same problem as that discussed in the guideline for recalculate choicelist. Specifically,
ClearQuest – How do I

when using the Web interface and changing the value of a Web-dependent field, a chain of requests is sent to the server. These multiple requests back and forth to the server cause delays in presenting data in your choicelists. These changes are compounded if Recalculate choicelist is selected for other unrelated fields, since they will also fire to recalculate their own choicelists.

Recommendations:
- Limit the number of dependent fields to one or two layers deep.

Limit the use of Audit Trail Record
Audit Trail is a package that tracks when fields change from one state change or modification to the next. Each of these changes is tracked in an audit trail log field, which is stored in the database. ClearQuest allows you to specify which fields you would like to track, and which to leave alone. Tracking more fields then necessary can lead to the following negative effects:
- Databases can grow faster because more data is being tracked. This can impact record seek times as well as disk space on database server machines.
- The BASE action hooks for audit logging consumes more memory and processing time.
- Depending on how many fields are tracked, audit logging can take up to 10-15% of the total time for modifying a parent record.

Recommendations:
- Limit the number of fields that you audit to only ones which are necessary.

Avoid the use of large images on forms
Images that are displayed on a form cause extra overhead when they are transferred over the network from the database server to the client machine or to the Web components. The larger the image that is displayed on the form, the more data that needs to be transferred. On high latency networks, including many WAN environments, images can degrade performance when loading the form.

Recommendations:
- Remove unnecessary images on forms.
- Ensure images do not exceed 1MB.
- Use separate Submit and Record forms to possibly reduce the number of images on each form.

General hook considerations
Hooks make a large portion of schema designs. Writing hook code with best coding practices is always recommended. Writing large amounts of hook code with poor coding can cause schema performance to be unreliable, which can be amplified in the Web interface. Several practices can help reduce the memory footprint and runtimes of your application, including:
- Reuse variables
- Limit looping constructs
- Destroy objects when they are not needed

Following are some general guidelines which will help maintain a smooth running schema.

Reduce the number of Field Value Change hooks
Field value change hooks fire each time a field is changed and the user moves focus to another field. If you have multiple fields with large field value change hooks it causes overhead. This effect is multiplied with the Web interface. The impact of having lots of value change hooks includes:
- Each hook can cause a separate interaction between the browser and the Web server and application server. Each interaction can cause various properties of the recalculated fields to identify changes in the forms, including choicelist hooks.
- It results in slower performance for users over higher latency networks.
- The additional overhead from field value change hooks can account for up to 15% of the total time creating new records.

Recommendations:
- Reduce the number of value changed hooks to only ones which are really necessary.
- Consolidate value change hooks into a single BASE action validation hook where possible. This will increase the number of action hooks, but will reduce the amount of requests going back and forth from a browser to the ClearQuest Web server.

Reduce the number of field validation hooks
Validation hooks fire when the focus of a field is changed in the native clients, as well as when the Save or Apply button is selected in both Web and native clients. If you duplicate such hooks when they are not needed, it causes several interactions between the database server and the client or the ClearQuest Web server, so they should be eliminated if possible. All code that is duplicated should be moved into a single action validation hook if possible.

Recommendations:
- Reduce the number of field validation hooks where possible.
- Consolidate several field validation hooks into a single action validation hook or BASE action hook to reduce Web interaction between the browser and the ClearQuest Web server.

Reduce the number of separate BASE action hooks
Action hooks of type BASE fire any time you execute an action of any other type (change state, modify, record script alias). As in the previous two guidelines, there will be overhead associated with multiple separate BASE action hooks. The effects of using BASE action hooks include:
- A separate run for each of the BASE action hooks causes additional overhead to the system in general.
- It is difficult to debug issues that might span the different hooks.
ClearQuest – How do I

- All Record Scripts for current record type and all Global Scripts are passed to the interpreter and compiler for each and every action or BASE action hook that is executed.

Recommendations:
- Consolidate BASE actions hooks into a single base action wherever possible.

Limit the use of Admin session calls in hook code
The ClearQuest API allows you to create an admin session object in your hook code when you need to access methods and functions that require administrator privileges, such as user and database administration. Using such an object for general tasks (such as creating or editing a record) is unnecessary, and you should avoid it because of the overhead it causes when instantiating such objects in your code.

Recommendations:
- Try to avoid creating an admin session in your hook code.
- Create a globally defined admin session in your hook code to avoid creating multiple admin sessions.

Avoid using OutputDebugString and MsgBox within hooks
OutputDebugString is a method of the session object that allows ClearQuest administrators to write debug data to the console window. This method is very useful when debugging scripts throughout your application, but it can produce unnecessary overhead to users. Try not to use OutputDebugStrings when it is not necessary. To improve the performance of the OutputDebugString entries without removing them, add a constant to the Perl module. Constants are evaluated at compile time and not runtime, so performance is improved and branches are never taken if DEBUG is false. Listing 1 shows an example.

Listing 1. Only send debug output when DEBUG value is 1

```
# Only send debug output when DEBUG is 1.
# Example usage
use constant DEBUG => 1;
if (DEBUG) {
   $session->OutputDebugString("This is for debugging purposes");
}
```

The MsgBox function is another useful debugging technique that you should use with care. MsgBox functions will display a dialog box on the native client machine for the user to dismiss. However, on the Web interface, the dialog will display on the Web server machine (and will not be visible unless the server is set to Interact with desktop). Until you dismiss the dialog box, this will tie up one of the available free threads that the application uses. If this function is called several times in the Web interface it could potentially tie up all available threads and make the Web interface appear to be in a "hung" state. Avoid using the MsgBox function where possible, or code around it using the code shown in Listing 2.

Listing 2. How to avoid tying up the Web server

```
VBScript:
Dim MySession
Dim CheckWebSession
Set MySession = GetSession
CheckWebSession = MySession.NameValue("_CQ_WEB_SESSION")
if CheckWebSession = FALSE then
   msgbox "Information you want to show in the Message Box "
end if

PERL:
If ( $session->HasValue("_CQ_WEB_SESSION") ) {
   # We are in a Web session, and need to code accordingly
}
Else {
   # We are not in a Web session, and the use of a Win32::MsgBox is acceptable
   Win32::MsgBox ("Information you want to show in the Message Box")
}
```

Reduce calls to third-party applications in hook code
Calls to third-party applications or databases should be handled with care, especially in the ClearQuest Web environment. ClearQuest Web is configured to run with a finite set of threads. Each thread processes requests and returns data to the Web application. Calls to third-party applications will run in one of these existing threads and effectively tie up the thread until the call completes. This can make the application appear to hang while your hook code finishes its calls to the external database or application.
ClearQuest – How do I

Network resources and other delays to these third-party applications will appear to make ClearQuest perform slower than expected.

**Recommendations:**
- Make sure to code around any failures using error trapping calls such as On Error Resume Next for VBScript and Die for Perl.

**Properly frame functions in Sub/End Sub Blocks**
By default, ClearQuest Designer frames hook code in your schema (defined in your fields and actions grid) with Sub/End Sub and Function/End Function header blocks. However, this is not the default for Global hooks. Global hooks are loaded into memory when the ClearQuest application is first started. In the case of ClearQuest Web, they are loaded when a user first logs into a database. If you do not properly frame your global hook code in Sub/End Sub and Function/End Function calls, the application will keep this code in memory, even after a user logs off. The memory footprint of the application can grow greatly if multiple users log in and out of the application without this code being cleared.

**Use session-wide variables sparingly**
Session-wide variables should be used sparingly. Session-wide variables, as the name implies, stay in memory for the life of the session. If you create session wide-variables unnecessarily, it will increase the memory footprint of the application and tax the server when it is running in a Web environment.

**Recommendations:**
- Reduce the number of session-wide variables where possible.
- Use local variables where appropriate in your code.
- Destroy objects where possible, setting them equal to nothing in VBScript, and setting them equal to undef and calling an appropriate destructor for PERL.

**Summary**
Schema design is an important part in the deployment of your ClearQuest solution. Designing a schema is an iterative process, which you should carefully plan and test to ensure a smooth operation at every step of your project. Not only is it important to test during the initial rollout, but also during each schema change, to minimize the potential effects of a poor design. The guidelines presented in this paper can be used as a starting point for a new schema design, as well as for existing ones when you perform schema tuning. Designing a schema with these best practices in mind will help you cut down on unexpected behaviors and facilitate a smoother, more predictable implementation.

**ClearQuest Designer**

65. **How do I – understand the availability of the classic Designer in ClearQuest 7.1**
Yes, in addition to the new ClearQuest 7.1 Designer, you can still access the classic Designer. Run the cqdesign.exe program, which exists in the following default installation directory:

C:\Program Files\IBM\RationalSDL\ClearQuest

You can also run cqdesign from the Microsoft Windows Run screen.

**Note:** It is recommended that this interface is only used to workaround a potential defect in the standard Designer for ClearQuest 7.1.

66. **How do I – understand “Potential performance issues with the Rational ClearQuest 7.0 Designer tool”**
The ClearQuest 7.0.x Designer tool can sometimes perform very slow and consume close to 100% CPU usage, or an show an increase in virtual memory consumption. It has been also been reported to take several minutes before the properties screen displays. When right-clicking and viewing the properties of a form field, the ClearQuest Designer might temporarily freeze and then display an Out of Memory error. Until the application is shut down.

**Cause**
This behavior has been observed with forms in ClearQuest 7.0 that have a very high number of fields on them. This behavior did not occur in the ClearQuest 2003 releases. This issue was identified as a product defect under APAR PK37546, and was fixed in the 7.0.0.1 iFix04, and 7.0.1 iFix01 Patch release

**Resolving the problem**
In order to activate the fix for this problem, a registry value will need to be enabled. If experiencing this problem, please follow these instructions:
1. From the Start menu, open the Run box and enter Regedit. Click OK.
2. Find HKEY_CURRENT_USER\Software\Rational Software\ClearQuest.
3. Create a new key and name it Diagnostic.
4. Right click on the new Diagnostic key and select "New -> String Value". Name this Behavior.
ClearQuest – How do I

5. Double click on the Behavior string value and insert for the Value data:

**SET_NEST_LEVEL_3=TRUE**

Setting this registry value to "TRUE" will now set the nesting level to 3, which will resolve the "out of memory" problem. This registry value only needs to be enabled on a machine in which Designer is exhibiting this behavior.

**Registry Editing**

*Note:* This solution contains information about modifying the system registry. Before making any modifications to the Microsoft® Registry Editor, it is strongly recommended that you make a backup of the existing registry. For more information describing how to back up the registry, refer to the Microsoft Knowledge Base article 256986 [http://support.microsoft.com/kb/256986](http://support.microsoft.com/kb/256986).

67. How do I – understand the list View IDs are retained when copying and pasting List View form elements issue

This technote addresses an issue in IBM® Rational® ClearQuest® Designer where copying and pasting List View form elements can disrupt button controls, because List View IDs are retained in the process.

**Cause**

*List View IDs* are used as a mapping between button controls and the actual *List View* form element. The ID of a particular *List View* box can be viewed in the element’s properties. Each tab on a form has a unique set of IDs for its *List View* boxes.

It is not uncommon for schema developers to copy a *List View* box from one tab or form and paste it to another. However, it is important to understand when performing his action that the *List View ID* of that form element is going to be retained when it is pasted into its destination.

For example: You have two *List View* boxes that each exist on two different tabs, each with a *List View ID* of "1". Copying and pasting one of them to the same tab as the other will effectively mean you have a tab with two *List View* boxes which share the same ID of “1”. This can cause confusion when developing forms, because it’s possible that the properties of a button control on the tab could point to either of the duplicate *List View IDs*. There is essentially an ID conflict.

**Solution**

When pasting a List View box into a tab, review the properties and make sure that it has a List View ID that does not conflict with others on the form.

This problem was investigated as a defect in ClearQuest Designer, and tracked with defect APAR **PK44252**. The defect was closed as a permanent restriction, because the copy functionality when working with forms was designed to copy the entire element as is.

**State Transition Matrix**

68. How do I - modify State Transition Matrix and keep records containing old States and Actions

After modifying in one way or another the State Transition Matrix, the User frequently encounters problems when using 'Test Work' function. Problems often emerge when the User decides to delete an Action or change a State name in the Schema. There are already created records with **ACTION DELETED** and **STATE CHANGED** in the test database. When the User tries to test the database, ClearQuest Designer either hangs or returns an error message, after which the User is unable to open up databases. This potentially becomes a more serious problem when the User uses the production database as the test database. After having done modifications in the Schema and pressing the 'Test Work' button, ClearQuest automatically upgrades the production database.

Therefore, when the User runs into such problems, there are two options:

1. Either restoring the database from backups
2. Deleting the problematic test database and trying to work the Schema again.

If the User is unable to check out or work with the Schema, the last versions of the Schema will have to be deleted to the point where the Schema is functional.

Also make sure that the State Transition Matrix is structured correctly, meaning that each State references to another accordingly. For example transioning **Submitted** to **Assign to Open**.

The new State Transition model (when the User needs to keep old records) should be dealt with in the following way:

**Note:** Do not delete an Action or State before creating new ones and moving records into new states.

1. Add a new Action.
2. Add a new State.
3. Modify the old Action to move to a new State.
4. Modify the State Transition Matrix (direction) accordingly.
5. Run a query to pull out all the records in the old State that will be transferred into the new State.
ClearQuest – How do I

6. Perform an Action to move the old records to the new State (‘bulk modify’ function allows for fast change).
7. Run a query to verify the change, making sure that no records are left in the old State.
8. Delete the old Action and State.

**Note:**
1. Each defined State must have Actions.
2. For each Action there can be several source States but only one destination State.

Be very careful modifying the State Transition Matrix when using ClearQuest/ClearCase Integration.

69. How do I – understand State Types and State Transitions

Change requests in a ClearQuest user database move through a pattern, or lifecycle, from submission through resolution. Each stage in this lifecycle is called a state, and each movement from one state to another is called a state transition.

As with record types and records, a state type is a template that defines actions and other attributes associated with a state. The states in a tailored schema must be based on one of the following state types:
- Waiting
- Ready
- Active
- Complete

Record types must have at least one path of transitions among state types as follows: Waiting to Ready to Active to Complete. The transition from one state to the next must be made by a default action.

**State Transitions**

Schemas include rules for changing records from one state type to the next. Some examples of state transitions are shown below.

This information can be found in Chapter 5 - Setting Up a ClearQuest User Database of the Rational® ClearCase® Rational® ClearCase® LT Managing Software Projects guide.

The ClearQuest Information Center is also a source of additional information on State Transitions.

**State Transitions of Record Type**

![State Transition Diagram](image)
ClearQuest – How do I

In addition to this single path requirement, states must adhere to the following rules:

- All Waiting type states must have a default action that transitions to another Waiting type state or to either a Ready or Active type state.
- If a Ready type state has an action that transitions directly to a Waiting type state, that Waiting type state must have a default action that transitions directly to that Ready type state.
- All Ready type states must have a default action that transitions to another Ready type state or to an Active type state.
- All Ready type states must have at least one action that transitions directly to a Waiting type state.

For the BaseCMActivity record type, its initial state must be a Waiting type.

70. How do I – understand ClearQuest State Diagram Rules

Schema validation errors regarding states, state types, and state transitions.

**Cause**
Violating rules for state diagrams

**Resolving the problem**

**General Rules for ClearQuest State Diagrams:**

1. Each record type can have only one Submit (starting point) action. If there is more than one, an error such as the following will occur:
   EntityDef "Defect": There must be exactly one actionDef of type SUBMIT, but this entityDef has 2.
2. It is possible to come to the same state by different actions, but you cannot define two actions which would perform the same transition. An error similar to the following error will occur: You can only have a single action resulting in a transition between two states. Current setting will contradict this and is illegal. Illegal Source State “Assigned” and Destination “Opened” specified.
3. Every state must be connected to at least one other state with an action. An error similar to the following error will occur:
   Error: Statedef "XXXXX" - There is no series of transactions which can reach this state.
4. If you delete a state, you must edit any actions that refer to that state.
5. Ensure that someone is assigned to process records in every state, otherwise you could have a "black hole" in your workflow.

For Schema Packages that require state type mappings (UCM, Resolution), see the ClearCase Information Center for complete details, searching on the topics:

- "About state types and state transitions in a schema enabled for UCM"
- "State transition default action requirements for record types"
- "Requirements for enabling custom record types"

Here are some highlights of the requirements listed in the Information Center and corresponding error messages you will get in the ClearQuest Designer when you validate the schema:

1. You must assign a default action for each state (except for "Complete") and the actions must provide a valid path through the state type model:
   The "Submitted" state of the "Defect" record type is of type "WAITING" and must therefore be followed by a state transition sequence (using default actions) which goes through only WAITING-type states and leads to a state of type "READY" or "ACTIVE".
   The "Assigned" state of the "Defect" record type is of type "READY" and must therefore be followed by a state transition sequence (using default actions) which goes through only READY-type states and leads to a state of type "ACTIVE".
   Validation of the "Defect" record type was aborted due to previous errors."

2. In addition to this single path requirement, states must adhere to the following rules:
   All Waiting type states must have a default action that transitions to another Waiting type state or to either a Ready or Active type state:
   Validating Schema...
   The "Assigned" state of the "Defect" record type which is of type "READY" has a transition to the "Postponed" state which is of type "WAITING".
   The "Postponed" state must have a default action which transitions it back to the "Assigned" state.
ClearQuest – How do I

The "Postponed" state of the "Defect" record type is of type "WAITING" and must therefore be followed by a state transition sequence (using default actions) which goes through only WAITING-type states and leads to a state of type "READY" or "ACTIVE".

Validation of the "Defect" record type was aborted due to previous errors.

3. If a Ready type state has an action that transitions directly to a Waiting type state, that Waiting type state must have a default action that transitions directly to that Ready type state.
4. All Ready type states must have a default action that transitions to another Ready type state or to an Active type state.
5. All Ready type states must have at least one action that transitions directly to a Waiting type state.

The "Assigned" state of the "Defect" record type is of type "READY" and must therefore be followed by a state transition sequence (using default actions) which goes through only READY-type states and leads to a state of type "ACTIVE".

Do not rename or remove required states. When upgrading packages, you will get an error pointing to this:

The name "Ready" is not a valid statedef.

Records

71. How do I - make sure the parent record is not closed if its child records are still open

How can I assure that a parent record is not closed if the child records are still in progress in IBM® Rational® ClearQuest®?

Cause

It might be desirable to enforce the closure of a record only in the event that the child records are closed. For example, the schema has Defect and Task stateful record types. A Defect could have multiple Tasks created as children records to accomplish the defect resolution. It would not be logical to close the Defect unless all of the child Tasks are completed.

Answer

Below is a sample script in PERL, to make sure that a parent record in ClearQuest is not closed if its child records are still open. This script example assumes that the schema has a Defect record type that uses child Defect records. The reference list field is named ChildrenDefects.

This script would be in the validation of the desired action. For the purposes of this use case, it would be in the action validation hook for Close.

```perl
# Get the field object for the list of children
$ObjChildrenList = $entity->GetFieldValue("ChildrenDefects");
# Check if there are any children
if($ObjChildrenList->GetValueStatus() == $CQPerlExt::CQ_HAS_VALUE) {
  # if there are....
  # init result for later
  $result = "";
  # Get the actual list of children (this will return a list of the unique id (id))
  $children = $ObjChildrenList->GetValueAsList();
  # Break the list into an array
  @childrenList = @$children;
  # need session object to get entity records (children)
  $oSess = $entity->GetSession();
  # go through the list of children, if any are not in CLOSED state add to error message
  foreach $child(@childrenList){
    # Get the entity (record) of the current childr
    $eChild = $oSess->GetEntity("Defect", $child);
    # check the state, if not Closed add to error message
    unless($eChild->GetFieldValue("State")->GetValue() eq "Closed"){
      $result .= "$child, ";
    }
  }
  # if result is empty there were no children OR all are CLOSED
  unless($result eq ""){
    #
  }
```
# if result is NOT empty then set error message for validation failure, including the children that are not CLOSED
$result = "Following Children Not in Closed State - ". $result . " This record can not be moved to a completed state."
}
return $result;

DISCLAIMER:
All source code and/or binaries attached to this document are referred to here as "the Program". IBM is not providing program services of any kind for the Program. IBM is providing the Program on an "AS IS" basis without warranty of any kind. IBM WILL NOT BE LIABLE FOR ANY ACTUAL, DIRECT, SPECIAL, INCIDENTAL, OR INDIRECT DAMAGES OR FOR ANY ECONOMIC CONSEQUENTIAL DAMAGES (INCLUDING LOST PROFITS OR SAVINGS), EVEN IF IBM, OR ITS RESELLER, HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

72. How do I - show the maximum history.action_timestamp for each record
The following details how to create a report format that will show the maximum history.action_timestamp for each defect when using IBM® Rational® ClearQuest® with Crystal Reports.

The following steps are an example of creating groups and totals in a report format using Crystal Reports:

1. Login to ClearQuest, select Query > New Report Format.
2. Select the Defect record type from the Choose Record Type dialog box and click OK.
3. On the Edit Report Format dialog box select ID and history.action_timestamp from the list of available fields and click Author Report...
4. When Crystal Reports opens, go to Insert > Group > select ID from the list of available fields and click OK.
5. Go to Insert > Database Field... and put the ID and the history.action_timestamp fields in the "Group Footer #1:" section of the report.
6. With the history.action_timestamp field selected in the group footer, select Insert > Summary and select maximum as the summary function to use. Click OK and Crystal Reports will add a summary field called "Max of~CRPT_TMP0001_ttx.history.action_timestamp" to the Group Footer #1 section.
Delete the history.action_timestamp field because it was only used to create the Max of ~CRPT_TMP0001_ttx.history.action_timestamp summary field.

73. How do I - copy an entire record type in ClearQuest
There is currently (May 2007) no functionality within ClearQuest to copy or clone an entire record type. The record type must be recreated from scratch.
It is possible to export the record forms for a record type. This avoids having to redesign a new form.
To export a form:

1. Right click on the form and select Export form. This will export a file with a .frm extension.
   Specify a file name that is identical to the original form name to identify the form's purpose.
   Note: Any fields in the form that do not exist in the new record type will either need to be removed from the form or added to the new record type.
To import a form, right-click on Forms in your target record type and select Import form. Select your form to import and click the Open button.

74. How do I - display the ClearQuest Record ID with its UCM title and associated change set
how to display the output of an IBM® Rational® ClearQuest® record id along with its IBM Rational ClearCase® UCM title and associated change set.

Solution
With a ClearQuest enabled UCM project, how can a report be generated displaying the ClearQuest Record ID with its UCM title and associated change set?

The following cleartool lsactivity command with the use of fmt_ccase (format specifier) is a method to display the ClearQuest Record ID with its UCM title and associated change set version[s].
Review the ClearCase Command Reference Guide on the topic of fmt_ccase (cleartool man fmt_ccase) for more information on how to format cleartool output.

Command:
cleartool lsactivity -fmt "CLEARQUESTID:"%[crm_record_id]p\n"TITLE:"%[title]p\n"CHANGE SET:"%[versions]Cp\n\n
ClearQuest – How do I

Example:
%> cleartool lsactivity -fmt "CLEARQUESTID:%%%{crm_record_id}\n"TITLE:%%%{title}\nCHANGE SET:%%%{versions}\n
CLEARQUESTID:UCM00000058
TITLE: InitialActivity
CHANGE SET: M:\view\VOB\DIR1@@main\br1\1, M:\view\VOB.@@\main\n
CLEARQUESTID:UCM00000063
TITLE: TestingCode
CHANGE SET: M:\view\VOB\DIR2\scripts.txt@@main\Integration\br1\1

75. How do I – understand why importing incomplete record history can break the History package and Export function

The ClearQuest Import and Export functions were designed to import and export data to and from different ClearQuest environments. However, it is also possible to manually format import files in order to import data from legacy applications or third-party software exports. When exporting record history from ClearQuest to import into another database, the record information is pre-formatted and completely packaged together into an import file. However, when modifying this file or attempting to manually import history information from a third-party source, it's possible that some column values contain no data to import. For example, for one row of data, the user_name field may not contain any data; only empty double-quotes. If there are columns (or fields) with the record history that are imported into ClearQuest with missing values, then the History package and record Export Tools will no longer function properly. The History tab for the record with the incomplete history values will display history entries until it encounters a row with missing data, at which point that row and any further history entries will fail to appear. The history package will still store further record changes in the back-end database, but they will not be displayed because of the missing data.

Additionally, when using the Export tool to export a record with missing history data, you might experience the following error message:

The number of tokens in the history line does not correspond to the number of column headers!!

Solution
When exporting and importing records and history between different ClearQuest environments, the export files should not be modified. The Export tools format the data in a way that automates the association of history, attachments, and parent/child relation to records when they are being imported with the correct id to old_id mapping.

Note: Additional information about the required steps for ID mapping can be found in technote 1234126.
When importing record history that may have origins from a third-party source, the export file must be formatted correctly, and cannot contain any missing column values for any rows in the file. This issue has been identified as a product defect regarding the Import Tool not throwing an error when importing bad or corrupt history data. It is tracked by APAR PK51353.

76. How do I – understand the steps to Export and Import records in ClearQuest

The attached file contains instructions and screen shots that will show you how to export and import data, map fields and import the history, from one database into another in ClearQuest.

Answer
What are the necessary steps to export and import records with IBM® Rational® ClearQuest®? The attached file uses screen captures that break down importing records into key steps.

Hooks

77. How do I – create a dynamic pick-lists, dependent choice lists, in ClearQuest

You can create a choice list for one field that is dependent on the value of another field.
For example: Set the values in the 'version' field Choice List to display different choices depending on the selection made in the 'product' Choice List.

To setup this functionality, follow the instructions for these 3 key elements:
1. A field Value_Changed hook for the higher-level field.
2. A field Choice_List hook for the lower-level field.
ClearQuest – How do I

3. (optional) If using ClearQuest Web, the "Web Dependent Fields" property must be enabled on the higher-level field.

These components are discussed in more detail below:

1. **Value_Changed hook for the higher-level field:**

Create a *Field_Value_Changed* hook for the higher-level field ('product' in this example) which blanks-out the value in the lower-level field when a value is chosen in the higher-level field.

If this is not done, you could end up attempting to commit an invalid combination of values. For example, if there are two products "A" and "B". For product "A" there are versions 1 and 2, but product "B" has versions 1, 2, and 3. If the user chooses product "B" and version "3", then goes back and changes their selection in the "product" field to select product "A", then the selected value in the "version" field ("3") isn't valid. To avoid this conflict, implement a field Value_Changed hook which sets a blank value for the lower-level field when the user chooses a value in the higher-level field. For example, the following code should be placed into the Value_Changed hook for the 'product' field:

```plaintext
SetFieldValue "version", ""
```

2. **Choice_List hook for the lower-level field:**

The following code should be placed into the Choice_List hook of the 'version' field:

```plaintext
Dim ProductValue
ProductValue = GetFieldValue("product").GetValue()

If ProductValue = "ClearQuest" Then
    choices.AddItem("7.0")
    choices.AddItem("2003.06")
    choices.AddItem("2002.05")
ElseIf ProductValue = "ClearDDT" Then
    choices.AddItem("4.0")
    choices.AddItem("4.6")
    choices.AddItem("4.7")
    choices.AddItem("4.8")
Else
    choices.AddItem("select a product")
End If
```

This code gets the currently-selected value of the 'product' field and uses it in a conditional statement to determine which items to put into the 'version' field's picklist.

**Note:** When setting up the CHOICE_LIST hook for the lower-level field, to get ClearQuest to re-execute the hook every time a selection in the higher-level list, check the "Recalculate Choice List" box property associated with the lower-level field. You can configure this in the Choice List Hook Properties screen.

**Additional configuration for ClearQuest Web clients:**

To properly enable the dependent relationship for the ClearQuest Web interface, there is one additional step required: You must designate the second field as a Web dependent field. To do this, go to the form editor in ClearQuest Designer, select the properties for the higher-level field ('product' in our example), by right-clicking on the product field on the form. The Properties sheet will have a tab called "Web Dependent Fields". Choose the lower-level field ('version' in our example).

When end-users use the ClearQuest Web interface and choose a value in the higher-level field ('product'), the Web Dependent Fields property will cause a call to the web server to rerun the Choice_List hook associated with the lower-level field ('version') and propagate the results back to the web page.

7.8. **How do I – understand the execution order of hooks in ClearQuest**

The order hooks are executed depends on the user interaction and on the schema definition. To give an overall explanation, assume that there is a hook for every possible field hook and for every possible action hook.

Before the form displays, the following hooks are executed:

1. Action - Access control
2. Field - Permission
3. Action - Initialization
4. Field - Default value (only executed in action of type Submit)
5. Field - Validation
6. Field - Choice list

Once the Form is open, the following hooks are executed:

1. Field - Value changed (only if the value of a field is changed).
2. Field - Validation (only if the value of a field is changed).
ClearQuest – How do I

When applying the an Action the order is as follows:
1. Field - Validation
2. Action - Validation
3. Action - Commit
4. Action - Notification

For more information, see Online Help in ClearQuest Designer, search for Hooks.

79. How do I - use MsgBox in Perl hook code

The MsgBox command is normally only available from Visual Basic hook code in ClearQuest. However there is a workaround that allows to display a message box with custom text.

Note: This code only runs on Microsoft® Windows® platforms.

The Win32 library contains functionality that will generate a message box when executed on the Microsoft® Windows® operating system. The following code sample which displays the message “This is a message from CQPerl” in a message box with an OK button into your hook code. This example is written to be defined as a Global Script, which is callable from your other Perl hooks:

```perl
sub MsgBox {
    my($param) = @_; 

    use Win32;
    Win32::MsgBox("$param");
}
```

To execute this function, it would be called as follows:

MsgBox("This is a test");

If executed correctly, the user will see a dialog box containing the text “This is a test” appear on their screen.

Note: Message box calls should always be avoided when using the ClearQuest web client. Use of a message box on the web client will cause a process thread to be occupied until the Request Manager is restarted. Please see technote 1125997 for ways to use conditional logic to prevent this from

80. How do I – understand about Global Hook Cloning in ClearQuest

The Perl hook enhancement that clones global scripts avoids recompling code and allows hook environments to share a parse tree, thus saving time and memory, and providing better performance, with significant improvements for Rational ClearQuest Web.

The documentation in the ClearQuest 7.0.1 Information Center implies that you have to enable it, but it is enabled by default.

Performance improvements may vary, depending on your schema. Here are two areas to consider when evaluating this:

- Amount of PERL hook code: improvements will mainly be seen in the web environment with schemas that have a lot of hook code. Each user logging into the web will have a session which needs to load and compile the hook code. This can cause the request manager's memory to increase. If you do not have too much hook code, users might not see any improvement.
- Complex hook code outside your global hooks. For example: Value Changed, Access Control and Permission Hooks, do not get cloned.

For additional information, review the following whitepaper on schema performance, and see if you can make additional improvements:


81. How to send an e-mail notification programmatically using Perl

This example shows how to get the e-mail address from who is logged in and use that e-mail address to deliver as the to address.

The following code provides sample hook code for generating an e-mail message using Perl. You can use this sample code in the Action Notification column of the action you want to initiate the e-mail notification:
ClearQuest – How do I

```
use Win32::OLE;
$msg = Win32::OLE->new('PAINET.MAILMSG') or $session->OutputDebugString("no mailmessage\n\n");
$userEmail = $session->GetUserEmail();
$msg->AddTo($userEmail);
$msg->AddFrom($userEmail);
$msg->SetSubject("Testing");
$msg->SetBody("This is the body");
$msg->Deliver() or $session->OutputDebugString("Deliver failed\n\n");
```

Beginning with version 7.0 of ClearQuest, the `MailMsg` object was expanded to fully support Perl in the form of `CQMailMsg`. More information regarding this object and its methods can be found in the ClearQuest API Guide and in the ClearQuest Information Centers.

Here is an alternate sample hook:

```
use Net::SMTP;
$MAILHOST = "smtprelay.myserver.com";
$EMAIL = "myname\@us.ibm.com";
$smarty = Net::SMTP->new("$MAILHOST");
$smarty->mail("DeploymentGuard\@DONOTREPLY.COM");
$smarty->to("$EMAIL");
$smarty->data();
$smarty->datasend("To: $EMAIL\n");
$smarty->datasend("Subject: Testing Email Notification Hook \n");
$smarty->datasend("my test message\n");
$smarty->dataend();
$smarty->quit();
```

### Methods

#### 82. How do I - copy an entire record type in ClearQuest

There is no functionality within ClearQuest Designer to copy or clone an entire record type. The record type must be recreated from scratch. A Request for Enhancement, RFE RATLC01203218, exists for the ability to copy record types. It is available for viewing on the [RFE Community Web site](#).

It is possible to export the record forms for a record type, which avoids having to redesign a new form.

To export a form:

1. Right-click the form and select **Export form**. This will export a file with a `.frm` extension. Specify a file name that is identical to the original form name to identify the form's purpose.

   **Note:** Any fields in the form that do not exist in the new record type will either need to be removed from the form or added to the new record type.

2. To import a form, right-click **Forms** in your target record type and select **Import form > select your form to import and click Open**.

#### 83. ``

Using the local client software to work with ClearQuest in a WAN environment or over a VPN is not supported. The performance in this environment is likely to be unsatisfactory, and could also cause database corruption if there is a connection problem.

ClearQuest Web and ClearQuest MultiSite are specifically designed for WAN implementations and can be considered as viable alternatives. ClearQuest MultiSite allows ClearQuest clients to work with local replicas of their ClearQuest databases rather than accessing servers in remote locations.

### Audit Trail package

#### 84. How do I – use the IBM Rational ClearQuest AuditTrail & eSignature Packages

Many companies today must satisfy a variety of record-keeping requirements imposed by various regulatory statutes or agencies, such as how audit trails and electronic signatures must be applied to electronic record-keeping systems. With the SR4 release of IBM Rational ClearQuest v2003, ClearQuest can now be used in a way that will allow customers to satisfy these requirements.
ClearQuest – How do I

Companies that develop drugs or medical devices must satisfy a variety of record-keeping requirements imposed by the Food and Drug Administration (FDA) through its various regulations. When such companies use ClearQuest as part of their development process, they might be required to use ClearQuest in a way that satisfies these FDA regulations. Specifically, they might be required to satisfy the 21 CFR Part 11 regulations, which say how audit trails and electronic signatures must be applied to electronic record-keeping systems used during the development of drugs and medical devices.

With the ClearQuest v2003 SR4 release, ClearQuest can now be used in a way that will allow customers to satisfy these requirements.

- **Password security.** ClearQuest passwords must provide a reasonable level of security against various kinds of security threats. This functionality will be implemented through ClearQuest support for LDAP authentication.
  
  **NOTE:** ClearQuest LDAP support will be generally available for SR5. Please contact your IBM Rational sales team for more information.

- **Audit trails.** When ClearQuest data is changed, ClearQuest must be able to record who changed what when. This functionality can be implemented with the new AuditTrail package provided with SR4.

- **Electronic signatures.** When a user enters or changes administrator-defined ClearQuest data, the user must prove his or her identity for each change or each group of related changes. This functionality can be implemented with the new eSignature package provided with SR4.

**AuditTrail Package**

**Administration**

A ClearQuest administrator will be able to specify that certain records should automatically get an audit trail when created or updated. If the administrator specifies that a given record type will have an audit trail, all changes to records of that type will automatically get an audit trail from then on. The administrator will be able to turn off the audit trails for any record type that has them.

**Audit trail capture**

To ensure reasonable response times, the AuditTrail package will not store all audit trail information for a record as one of the record’s fields. Instead, only the most recent change to the record will be stored and displayed with the record; a separate table will provide access to the complete audit trail history. The AuditTrail package will create a new database table that contains the audit trail for all records that are enabled for audit trails. The table will store sufficient information to link each record to each change made to that record, and will record the version of the database schema that was used to describe the record.

**Information in the audit trail**

The audit trail describes a sequence of events that have happened to the record being audited. For each such event, ClearQuest will record the following information:

- **Who changed it:** ClearQuest will record the user name (such as “jdoe”) and the full name (such as “John Doe”) of the user who made the change. The full name is taken from the fullname field in the ClearQuest user table.

- **When it was changed:** ClearQuest will record the date and time of the change. This timestamp includes its own time zone so that there is no ambiguity about what the timestamp means. The time zone can be GTM, the client’s time zone, or the database server’s time zone, but it must be specified.

- **The action and state:** The action that changed the record and the final state of the record will be recorded for this event.
  - **Deleted records:** Information is never deleted from the audit trail. If an audited record is deleted, an entry is made in the audit trail with an Action of DELETE and State of DELETED.

- **What fields were changed:** For each data field in the record that was changed with this event, the audit trail will record the name of the field, its old value, and its new value.
  - **Deltas for multi-line text fields:** If the full old and new values of multi-line text fields were recorded in the audit trail, they would consume excessive disk space and be hard for humans to read. Consequently, the audit trail will show only those lines that changed between the old and the new values. Line numbers will indicate which lines are affected. (A consequence of this feature is that an append-only field, such as the Notes field where text is appended at the top but old text is never changed, will display only the new appended text in the audit trail.)

**Audit Trail Display.**

Applying the AuditTrail package to a record type will give that record’s form a new tab that displays the audit trail for the record. This tab contains no editable fields.

**Customization**

The AuditTrail package provides a customization mechanism by which its functionality can be modified via user-defined extensions, similar to the various Hooks provided by ClearQuest itself. Extensions allowed by the package include:

- **Exclusion of specific fields from AuditTrail capture.** Some fields in a record do not pertain to the “predicate data” covered by 21 CFR 11 regulations. At the customer’s option, a set of fields can be specified for each entity type (or even each entity) that will not be subject to AuditTrail capture. Note that if a change to a record affects only those fields that a customer has
ClearQuest – How do I

marked for exclusion, the package will still record the relevant user name, time of the change, and the state information for the record.

- **Audit trail format.** The AuditTrail is currently captured in a textual format. Each change to an originating record prepends its AuditTrail data to the existing AuditTrail information. The customer may supply an extension to format the data that is recorded for each change.

**Prevent the capture of AuditTrail data.** There is currently no way to disable a ClearQuest package for a record type once it has been applied to that record type. We will allow the customer to provide an extension to disable AuditTrail capture for specific record types. (This could also be used at a finer-grained level, e.g. to disable AuditTrail capture for specific states, but that is not the intent of this extension and should be discouraged.)

**eSignature Package**

The Electronic Signature package will provide the following functions:

**Administration (eSig_Config records)**

Once the eSignature package has been applied to a schema, enabling eSignatures for a specific record type requires two additional actions by the administrator: applying the package to that record type (via the Package Wizard or the packageutil enablerecordtype command) and creating at least one eSig_Config record describing when the target record type needs to be signed.

The eSig_Config record provides the administrator with a field that selects the target record type, and two options to indicate when records of that type are to be signed: State selection and Action selection. If the chosen record type is stateful, then both State selection and Action selection options are available; if the record type is stateless, only Action selection is available. The State and Action selections are both cleared when the record type is changed.

Note that eSig_Config records always indicate when a record is to be signed; they cannot suppress signature collection. Hence multiple eSig_Config records can be created for the same target record type without causing ambiguity: Signatures are to be collected if any record exists that matches a specific state and/or action condition.

Similarly, if the administrator selects both Action-based and State-based criteria on an eSig_Config record, the criteria in the record are logically or’d together. Hence a target record will require a signature if an eSig_Config record exists that matches either the current state condition or the current action condition.

Figure 1 (below) shows a sample eSig_Config record form.

**Target record type selection**

This field allows the user to select one entity type. The choice list includes all entity types found in the schema (whether stateful or stateless), except for certain types that are internal to ClearQuest: History, Attachments, rati_replicas, Groups, Users, AuditTrailLog, eSigLog.

**Sign by State**

The two fields here allow the user to select from one or more of the states available to the chosen entity type (if any), as well as how the selected state(s) are used to determine whether a signature is required. The choices for Sign When are:

- **Entering State:** Records of the target type are signed if the action will cause the record to enter the specified state.
- **Leaving State:** Records of the target type are signed if the record will cause the record to leave the specified state.
- **Modify In State:** Records of the target type are signed if the record is in the specified state immediately before, during, or immediately after the action.

**Sign by Action**

This field displays all Actions for the target record type except for Base actions, Record Script Aliases, and Import. The administrator may select one or more of these options. Since this will be the only
ClearQuest – How do I

criterion requiring signatures for stateless record types, the administrator must select at least one Action if the target record is stateless.

Signature Enforcement and Validation

When the eSignature package is applied to a record type, that record type's forms will include an additional tab containing fields related to eSignature, including User Name, Password, Signature Log, and an "Is Current" flag.

If a signature is required, the user name and password will be marked as required fields; otherwise, they are read-only. If a signature is required, the user name and password are checked to ensure that they match the username and password with which the user logged in to ClearQuest. If they match, then the change is accepted and the signature is logged. If they are not valid, the user gets an error message and no change is made to the database.

Information recorded for each signature

By default, the eSignature package will record for each signature:

- The user name of the user signing the record
- The user's printed name
- The user's group membership
- The action being taken
- The final state of the record
- Timestamp for the action

  - Ability to record meaning of signature: The eSig log will automatically record customer-defined information about the signature. Exactly how the meaning is captured is up to the customer organization and the policies or procedures it institutes to satisfy the FDA regulations. A customer-modifiable global script will be used to specify and format the contents of the eSig log.

Verification that the signature is still valid

A signature is valid for a record only if the record has not changed since the signature has been applied. The eSignature tab will provide a field (labeled "Signature is Current") that indicates this condition. This field is always read-only; it displays "True" if the last change to the record included a signature, and "False" otherwise.

Ability to display current and historical signature information

The eSignature tab includes a field, "eSignature Log", that displays the full signature history for a record. Note that this includes only changes that have been signed; the AuditTrail package can be used to provide a more detailed change history.

Customization

The eSignature package provides a customization mechanism by which its functionality can be modified via user-defined extensions, similar to the various Hooks provided by ClearQuest itself. Extensions allowed by the package include:

- eSignature log format: The eSignature log is captured in a textual format. Each signature is prepended to the existing eSignature data (if any) for that record. The customer may supply an extension to format the signature when it is recorded for each change.
- Control access to eSig_Config records: The administrator may provide an extension that will ensure that only authorized users may create, modify, or even view eSig_Config records. (Ideally, this probably should be done by changing the ownership of the eSig_Config record type.)

Implementing Customizations

The customer can add certain extensions to the AuditTrail and eSignature packages to customize their behavior. To do so, they add one or more Perl functions to the Global Hooks section of their schema. (Adding the extensions to Global Hooks makes them available to any hook in the packages. However, these extensions are not invoked as Named Hooks, but as normal Perl functions.)

Each extension has a specified name, arguments, and return value, as described in the subsections below.

In the examples that follow, the text in Courier is required as part of the customer extension. Text in courier italic illustrates code that might be written by the customer to implement the extension.

AuditTrail customizations

IMPORTANT: To use these examples, create a new Global PERL script, for example: at_Cust_Hooks. Then cut and paste the subroutines in blue highlights below to the global script you just created. The AuditTrail package hooks will look to call these routines by name, so case and spelling are very important!

1. Exclusion of specific fields from AuditTrail capture.

Some fields in a record may not be pertinent to the "predicate data" covered by 21 CFR 11 regulations. At the customer’s option, a set of fields can be specified for each entity type (or even each entity) that will not be subject to AuditTrail capture. Note that if a change to a record affects only those fields that a customer has marked for exclusion, the package will still record the relevant user name, time of the change, and the state information for the record.

Example

```perl
sub atCust_ExcludeField {
  my ($session, $entity, $fieldName) = @_;
  return ($fieldName eq "Description");
}
```
ClearQuest – How do I

Arguments:
$session: The current session object
$entity: The entity object for which an audit trail is being written.
$field_name: The name of the field that may be excluded from the AuditTrail.

Return Value: 0 to keep the field in the AuditTrail; non-0 to exclude it.

2. Audit Trail format

Audit trail format. The AuditTrail is currently captured in a textual format. Each change to an originating record prepends its AuditTrail data to the existing AuditTrail information. The customer may supply an extension to format the data that is recorded for each change.

Example

sub atCust_CreateLogEntry {
    my($session, $entity, $timestamp, $action,
        $state, $login, $fullname, $groups) = @_;

    # Note: This example doesn't record which fields actually changed.
    return "AuditTrail: $timestamp $action $state \
        $login $fullname $groups \n**********\n";
}

Arguments:
$session: The current session object
$entity: The entity object for which an audit trail is being written.

$timestamp: A string-formatted timestamp value. (We pass this as a convenience; the extension may create its own timestamp field, or even omit it entirely.)
$action: The name of the current action that is being executed.
$state: The current state of the record. If the current action has modified the state, this field reflects the new state.
$login: The name of the user, as represented by ClearQuest. (Note that if LDAP is in use, this may be a different name from the one which the user used to log in to ClearQuest.)
$fullname: The full name of the user, if known to ClearQuest.
$groups: A list of the ClearQuest group names to which the user belongs. (This represents only the groups that are managed by the ClearQuest User Admin tools. If LDAP is in use, the directory may hold other group names independent of those managed by ClearQuest.)

Return Value: A string representing the full audit trail entry to be written to the log, including any delimiters or space between entries.

3. Prevent the capture of AuditTrail data

Prevent the capture of AuditTrail data. There is currently no way to disable a ClearQuest package for a record type once it has been applied to that record type. We will allow the customer to provide an extension to disable AuditTrail capture for specific record types.

Example

sub atCust_SuppressAuditTrailRecord {
    my($session, $entity) = @_;
    # return 0;
    # return 0 to enable AuditTrail (default)
    return 1;
    # return 1 to disable AuditTrail
}

Arguments:
$session: The current session object
$entity: The entity object for which an audit trail is to be written

Return Value: 0 to cause an AuditTrail record to be captured; non-0 to suppress it.

eSignature customizations

IMPORTANT: To use these examples, create a new Global PERL script, for example: eSig_Cust_Hooks. Then cut and paste the subroutines in blue highlights below to the global script you just created. The eSignature package hooks will look to call these routines by name, so case and spelling are very important!

1. eSignature log format

The eSignature log is captured in a textual format. Each signature is prepended to the existing eSignature data (if any) for that record. The customer may supply an extension to format the signature when it is recorded for each change.

Example

sub eSigCust_MakeLogEntry {
    my ($timestamp, $action, $state, $login, $fullname, $groups) = @_;

    return "Signed: $timestamp $action $state \
        "$login $fullname $groups \n";
}
ClearQuest – How do I

Arguments:
$\text{name:} A \text{ string-formatted}\ \text{timestamp\ value.}\ (\text{We\ pass\ this\ as\ a\ convenience;}\ \text{the\ extension\ may}
\text{create\ its\ own\ timestamp\ field,\ or\ even\ omit\ it\ entirely.)}

$\text{action}: The\ name\ of\ the\ current\ action\ that\ is\ being\ executed.

$\text{state:} The\ current\ state\ of\ the\ record.\ If\ the\ current\ action\ has\ modified\ the\ state,\ this\ field\ reflects\ the
new\ state.

$\text{login}: The\ name\ of\ the\ user,\ as\ represented\ by\ ClearQuest.\ (Note\ that\ if\ LDAP\ is\ in\ use,\ this\ may\ be\ a
different\ name\ from\ the\ one\ which\ the\ user\ used\ to\ log\ in\ to\ ClearQuest.)

$\text{fullname}: The\ full\ name\ of\ the\ user,\ if\ known\ to\ ClearQuest.

$\text{groups}: A\ list\ of\ the\ ClearQuest\ group\ names\ to\ which\ the\ user\ belongs.\ (This\ represents\ only\ the\ groups\ that\ are\ managed\ by\ the\ ClearQuest\ User\ Admin\ tools.\ If\ LDAP\ is\ in\ use,\ the\ directory\ may\ hold\ other\ group\ names\ independent\ of\ those\ managed\ by\ ClearQuest.)

Return Value: A\ string\ representing\ the\ full\ eSignature\ entry\ to\ be\ written\ to\ the\ eSignature\ log,
including\ any\ delimiters\ or\ space\ between\ entries.

2. Control access to eSig_Config records

Although ClearQuest provides the ability to limit access to the creation, modification, or deletion of records to authorized users, there are conflicts between this facility and the package mechanism. As a result, if the administrator uses the usual ClearQuest access control methods to specify which users may work with eSig_Config records, future upgrades to the eSignature package will become more difficult to apply.

This extension provides an alternate means to limit access to eSig_Config records. The administrator may supply this extension to ensure that only authorized users may create, modify, or even view eSig_Config records.

This extension is invoked during the ACCESS_CONTROL hook for the eSig_Config record; the last three arguments ($\text{actionname}, $\text{actiontype}, $\text{username}) come directly from the invocation of that hook.

Example

```perl
sub esigCust_ConfigAccessCtrl {
  my ($session, $actionname, $actiontype, $username) = @_;
  return 1 if $username eq "admin";
  return 0;
}
```

Arguments:

$\text{session}: The\ current\ session\ object.

$\text{actionname}: The\ name\ of\ the\ action\ which\ the\ user\ is\ attempting\ to\ perform.

$\text{actiontype}: The\ type\ of\ this\ action.\ This\ will\ be\ one\ of\ the\ following:

- \text{CQPerlExt::SUBMIT}
- \text{CQPerlExt::MODIFY}
- \text{CQPerlExt::CHANGE}
- \text{CQPerlExt::STATE}
- \text{CQPerlExt::UNIFY}
- \text{CQPerlExt::UNUNIFY}

$\text{username}: The\ name\ of\ the\ logged-in\ user.\ (If\ using\ LDAP,\ note\ that\ this\ will\ be\ the\ name\ known\ to
ClearQuest, not the LDAP user name.)

Return Value: 0 to prohibit the user from acting on an eSig_Config record; non-0 to grant access to the user.

Click [here](#) to download this WORD doc.

85. How do I – disable the Audit Trail package in ClearQuest

The Audit Trail 1.0 package in ClearQuest contains a sample Perl Global Script, \text{at\_IsDisabled}, which demonstrates how the Audit Trail package could be disabled. These scripts are package owned, and cannot be modified.

The updated Audit Trail 1.1 package introduced two new extensions to the package, \text{eSigCust\_Disable\_eSignature} and \text{atCust\_Disable\_AuditTrail}. This new package is only available for the ClearQuest 7.0 release or higher.

To disable the Audit Trail package, create a new Global Record script using the following steps:

1. Create a New Global script in the Perl Folder called \text{my\_IsDisabled}.

2. Copy the contents of the updated \text{IsDisabled} script below, place it in the new Global script

   \text{Note: The at\_IsDisabled script has some syntax errors which have been corrected. (The sub
atCust\_Disable\_AuditTrail lines should be un-commented).}

3. Check in your schema and upgrade. The Audit Trail feature will then be disabled.

4. This is essentially the same as the code provided in the \text{IsDisabled} Script. To re-enable, change
the return value from \text{1} to \text{0}.

The edited code is as follows:

Updated at\_IsDisabled script
86. How do I – understand why using the renaming Submit action and then applying Audit Trail package might cause the ClearQuest Designer to crash

If you rename the Submit action and then apply packages such as the Audit Trail package, you will receive the following error and the ClearQuest Designer will crash:

```plaintext
!%$ SetAccess failed...
... An error was detected retrieving information from the ClearQuest database.
... There is a reference to an object that does not exist:
... Object Type: Action
... Object: "Submit" of record type "XXXX"
... This error was detected at: ClearQuest Core:adentitydef.cpp:2712
```

There is a section on naming restrictions in the ClearQuest 7.0 on-line help for the Schema Developer help that describes this restriction.

**Solution**

To resolve this issue, rename the Submit action back to the original name using the following steps:

1. Login to your ClearQuest Designer.
2. Check out the schema.
3. For you record type, expand Record Types-> States and Actions
4. Click on Actions
5. Rename the action with type SUBMIT, to Submit.
6. Next apply the package.
7. After package has been installed successfully, rename the Submit action back to the original name.

**Note:** Renaming the Submit action to other that Submit risks future issues when applying package upgrades.

**LDAP support**

87. How do I – understand reporting on which users are enabled for LDAP Authentication

How can I report on which users are enabled for LDAP Authentication in IBM® Rational ClearQuest?

**Answer**

1. Use the User Administration Tool to export the users and search for each user entry where "authentication = LDAP". Scripting tools would be needed to extract these users out of the file.
2. Create a stand-alone application in PERL or VBScript using the ClearQuest API to report on these users. The API method GetAuthenticationMode can return the authentication mode for each user. Refer to the GetAuthenticationMode section of the ClearQuest Information Center for more information.

A request for enhancement exists, RFE RATLC01206610, requesting an ability to query or report on the authentication mode of users. It is available for viewing on the RFE Community Web site.
ClearQuest – How do I

88. How do I - connect to an alternate LDAP host

This technote explains how to specify alternate LDAP servers for IBM® Rational® ClearQuest® to use, using the setldapinit -h command. If one LDAP server is unavailable, then ClearQuest will contact the next server and so on.

**Cause**
ClearQuest in this configuration assumes replicated LDAP directories across the servers meaning that all LDAP users should be consistent across all servers. If ClearQuest contacts one server and does not find a user, it will fail authentication. The alternate server will be used only in the event that the primary server cannot be contacted or is otherwise unavailable.

**Resolving the problem**
The following example is based on the setldapinit topic in the ClearQuest Information Center.

The setldapinit subcommand configures the dbset1 database set for LDAP authentication. The ClearQuest login user name is *bob_admin* and the login password is *bob_pw*. The hosts on which the LDAP server runs are *ldap_host1*, *ldap_host2* and *ldap_host3*.

**Note:** The list of hosts must be delimited with a space character, and enclosed with single quotation marks as in the following example:

```
installutil setldapinit dbset1 bob_admin bob_pw "-h = 'ldap_host1 ldap_host2 ldap_host3'"
```

If users are spread across different servers, check with your LDAP administrator to see if the users can be replicated to a single LDAP server.

You might also be able to use Referral Chasing with ClearQuest to resolve this. This allows references to another server to complete a query if the LDAP server is setup for it. ClearQuest supports referral chasing but only if the base search path does not start at the top of the tree. Your LDAP Administrator should be able to verify if referral chasing is possible.

A request for enhancement exists, RFE RATLC01015273

89. How do I – understand about LDAP Authentication of users in Active Directory Sub Domains using the Global Catalog

ClearQuest LDAP authentication will only search one LDAP tree. In Microsoft® Active Directory, you are able to configure sub domains. However, it is not possible to directly search from the root domain and search all branches. It is possible to search all users through the Global Catalog.

Active Directory is designed so that if you attempt to search from the root level of the domain, it will return a referral pointing to the server of the sub domain that contains the user information you are trying to authenticate. This makes it impossible to search sub domains from the root level. However, Active Directory has a feature called the Global Catalog that contains a limited subset of all the sub domains. This makes it possible to do LDAP authentication of all sub domains users with ClearQuest if the feature is enabled.

**Answer**
You must first confirm that the Global Catalog is enabled on the Active Directory server and if not, enable it. To verify if the Global Catalog is enabled, log on to the Active Directory server and follow these directions:

1. Go to Start > Programs > Administrative Tools and select Active Directory Sites and Services.
2. Expand the Server folder under the Site Domain. Locate the Active Directory server and expand it.
3. Right click "NTDS Settings" and choose Properties from the menu.
4. Look on the General tab of the NTDS Settings properties, there is a check box for Global Catalog. If this is checked, then the catalog is enabled. If not checked, checking it will enable the Global Catalog.

Once you have confirmed and or enabled the Global Catalog, the only changes to your LDAP init parameters are the port number and the base search path. The Global Catalog port number is 3268 for non-SSL searches, or 3269 when using SSL. When setting the base search path, use the top level domain as the base. For example: "DC-IBM,DC=COM"
ClearQuest – How do I

All other LDAP parameters are the same as if you were authenticating through Active Directory. For further instructions on setting up ClearQuest to authenticate using LDAP, refer to the Using LDAP with ClearQuest section of the ClearQuest Information Center.

90. How do I – use LDAP support for secure sockets layer (SSL) in ClearQuest

ClearQuest added support for LDAP authentication in the 2003.06.15 release. Support for SSL with LDAP was added in the ClearQuest 7.0 release.

Lightweight Directory Access Protocol (LDAP) is a directory sharing protocol that runs over TCP/IP (Transmission Control Protocol/Internet Protocol). You can configure applications to authenticate users through an LDAP Directory Server. This protocol helps manage network database information about authorized users on a network, such as user accounts, passwords, and what a user is and is not allowed to access. LDAP is vendor and platform neutral, which allows for authenticating users that are working across heterogeneous systems.

ClearQuest added support for LDAP authentication in the 2003.06.15 release. You can enable LDAP authentication for ClearQuest clients that run on all platforms that ClearQuest 2003.06.15 and 2003.06.16 supports except for Solaris.

Note: LDAP support for Solaris was added in the ClearQuest 7.0 release.

ClearQuest support for SSL with LDAP was added in the 7.0 release.

91. How do I – understand the errors when setting up LDAP authentication for ClearQuest with Active Directory

How do I resolve errors that might occur when setting up LDAP authentication for IBM® Rational® ClearQuest®. Attempting to use the samAccountName as the Common Name (CN) in a distinguished name works in the Active Directory tools, but generates errors from other LDAP v3 tools.

Cause
Attempts to validate the user name with the ClearQuest validateldap command fails with an error similar to the following error messages:

Invalid Credentials: Either the login name or the password is incorrect. The LDAP server returned this error: Failed to Bind ldap connection using the account specified by -D cn=adt_admin,ou=users,dc=local -w ***.
Please ensure that ClearQuest's LDAP server initialization parameters, including -D and -w, are set correctly.
Received the following LDAP error message: LDAP operation 'ratl_ldap_simple_bind_s' failed with error code 49. Description: Invalid credentials.

OR

Invalid Credentials: Either the login name or the password is incorrect. The LDAP server returned this error: Improper LDAP configuration:
There are 0 LDAP user accounts that have
"(&(objectCategory=person)(sAMAccountName=joeuser)(!(userAccountControl:1.2.840.113556.1.4.803:=2)))".
Please contact your CQ Administrator to resolve this issue with your LDAP administrator.

Attempting to use dsquery command from the Active Directory server are successful. Microsoft dsquery reference:

dsquery user -o dn ou=users,dc=local -scope subtree -samid adt_admin
dsquery user -o dn ou=users,dc=local -scope subtree -U adt_admin@local -P password

Solution
The original Distinguished Name "-D cn=adt_admin,dc=local" given to authenticate is incorrect. This should be the full name of that user, not the login name. In this example it should be:

"-D cn=ADT Admin,dc=local"

By correcting this value solved the problem. This was initially unclear because, in this case, using Common Name (CN) attribute incorrectly is masked by Active Directory, which is silently handling this error.

In the case of more complex -D strings, try putting single quotes around the whole -D string. For example:

-D cn=cqreader,ou='Service Accounts',ou=1S,ou=Boston,ou=CUsers,dc=CGroup,dc=com -w password
Should be changed to:

-D 'cn=cqreader,ou=Service Accounts,ou=IS,ou=Boston,ou=CUsers,dc=CGroup,dc=com' -w password

92. How do I – understand the steps to Configure LDAP with SSL Connection

overview of the steps to enable LDAP with SSL in IBM® Rational® ClearQuest® 7.0.

Solution
Refer to Technote 1221136 for background on LDAP and links to detailed documentation. All ClearQuest (CQ) clients must be upgraded to version 7.0 to use the SSL feature.

Details for enabling SSL in the ClearQuest 7.0 release are documented in the IBM Rational ClearQuest and ClearQuest MultiSite Installation and Upgrade Guide, 7.0, Windows, Linux, and UNIX - GI11-6375-00.

The following steps are a summary of the required setup states:

1. Plan for Key Distribution
   Review the ways the key file can be distributed and decide which method(s) to use for the environment. Refer to the ClearQuest 7.0 Information Center on Distributing the key database file.

2. Install GSKit
   Have users manually install the GSKit, which provides the SSL encryption, on any client that will access the LDAP Server, i.e. wherever the ClearQuest Core authentication is executed. In a distributed environment this means the ClearQuest Client, ClearQuest Web Server, but not the ClearQuest Web Application (RWP). Search for "Enabling SSL Encryption with GSKit". Users can validate a successful Windows client install by running gsk7ver at C:\Program Files\IBM\GSK7\bin\. There should be no error messages. Unless the ClearQuest Admin gives the user a keystore file, this is all users must do.

3. Create the key database file
   Run the GSKit iKeyMan utility by launching the file: C:\Program Files\IBM\GSK7\bin\gsk7km.exe and distribute.

4. Configure the Schema Repository for LDAP Authentication with SSL
   Follow the steps to configure for LDAP but when using the setldapinit function, use the -Z parameter to configure SSL, and optionally, the -K parameter to specify the location of the key database file (see step 1).

5. Configure Users for LDAP Authentication
   Using the CQ User Admin Tool or the "SetupCQLDAP" script.
   Note: For a Web Environment, configure RWP to use SSL. See Appendix C in the Version 7.0 Installation and Upgrade Guide.

Trace key
To trace on LDAP related issues, use the trace key AUTHMODE. This is the ClearQuest core key for diagnostic tracing.

Security groups

93. How do I - use of Hook Code to control group access to tabs on a form in ClearQuest

Can hook code be used to control access to tabs on a form in IBM® Rational® ClearQuest®? While this is possible using the ClearQuest Designer, it is not possible to set these values when using a hook. In the ClearQuest Designer, right click on a Tab Form and get it's properties. Within those properties you can assign which user groups can access this tab.
A request for enhancement (RFE) to add this functionality and is tracked by it's RFE number RATLC01036733.

94. How do I - set the field requiredness of a security context group to mandatory

Many customers have called stating they would like to set the field requiredness of the security context groups to mandatory. Here is the quickest and easiest way to do so. (In Basic) The reasoning behind this is when you simply go to the behaviors and try to change it to mandatory the field is greyed out. Adding this script goes around the greyed out feature and allows the customer to implement this functionality.

In the stateless record, create a new Base action called field_req.
In the initialization field add the following script:

```vbnet
Sub customer_Initialization(actionname, actiontype)
    ' actionname As String
    ' actiontype As Long
    ' action is Field_req
    ' record type name is Customer
    REM do any setup for the action here
    setfieldrequirednessforcurrentaction "ratl_context_groups",
    End Sub
```

After checking in the schema and running the test database this is what it now looks like in the client.

That completes making security context groups mandatory.
ClearQuest – How do I

95. How do I - setup security context for multiple, different groups

In traditional configurations, security context establishes access control to a record by group or project with a reference field in the parent record type. For example, one can establish a "projectGroup" security context field in the Defect record type that references the Project record type. Any user groups assigned to the context of a Project record would then have access to a Defect record when that Project is selected in the projectGroup field.

In some cases, it is desirable to grant record access to multiple groups or projects. However, simply setting up another field in the parent record that references the same child record-type will not work correctly, and only one of groups will be able to access the record.

Solution
The security context feature in ClearQuest is designed to work as a 1-to-1 relationship. In order to grant record access to multiple projects/groups, there has to be a child record type for each control field on the parent record type.

For example, if you want two Project groups to have access to Defect, you'll have to have two Project record types (Project1 and Project2). You would then have to add two security context fields to the Defect record type (projectGroup1 and projectGroup2). These each field will need to reference an applicable Project record type. At this point, you will have two 1-to-1 relationships established, and the security context for each will work correctly.

Queries/Searching

Scrubbing oplogs when full-text search is enabled

Technote (FAQ)

Question
Why do you need to scrub oplogs when IBM Rational ClearQuest full text search is enabled? How can you scrub the oplogs if ClearQuest multisite is not enabled?

Cause
Full text search and Multisite are the only Rational ClearQuest (CQ) features that use operational logs (oplogs). Due to database size constraints, you sometimes must clear out the tables that contain these records, as they can grow quite large. This is referred to as "scrubbing oplogs".

Answer
Starting in CQ 7.1.1, you can use the multiutil scruboplogs command to clear out the oplogs table even if ClearQuest Multisite is not enabled. To use this command without Multisite, you specify the "dbset" (connection name) and "fam" (the logical name of the user database) values.

You can scrub oplogs based on date. It is best to be conservative when choosing a date. All oplogs prior to the date are deleted. For example, if you have full text search configured for many months, you might use a date from a month ago. If full text search is only configured for a couple months, two weeks ago can be suitable range. Err on the side of caution; Deleting too many oplogs impacts the amount of time it takes the ClearQuest search profile to re-index records.

The format of the command:

multiutil scruboplogs -dbset <connection name> -fam <user db logical name> -u <cq admin username> -p <password> -before <datetime>
ClearQuest – How do I

See the ClearQuest Information Center scruboplog command topic for information on formatting the date for the -before parameter.

96. How do I – understand that full-text search does not extend to attachments

ClearQuest 7.1 full-text search only searches on records. It does not search data within attachments. A request for enhancement, RFE RATLC01281719, exists for attachment searching capability. It is available for viewing on the RFE Community Web site.

97. How do I - understand the unhandled exception and Java core dump, when indexing for full-text search

This technote identifies an issue that can occur in IBM Rational ClearQuest, where configuring full-text search indexing with invalid credentials results in an unhandled exception error and a Java core dump.

Symptom

When using the cqdbcrawler utility to perform indexing for ClearQuest full-text search, an unhandled exception and Java core dump occurs. The dump and error information will appear on the screen after running the utility:

Unhandled exception

Type=Segmentation error vmState=0x00040000
J9Generic_Signal_Number=00000004 ExceptionCode=c0000005 ExceptionAddress=7EF9F589
ContextFlags=0001003f
Handler1=7EFB04E0 Handler2=7F057A80 InaccessibleAddress=00000000
EDI=0007FC7E ESI=00000020 EAX=00000000 EBX=00176400
ECX=00000000 EDX=0007FC70
EIP=7EF9F589 ESP=0007FAEC EBP=0007FB4C
Module=C:\Program Files\IBM\RationalSDLC\Common\Java5.0\jre\bin\j9vm23.dll
Module_base_address=7EF90000 Offset_in_DLL=0000f589
Target=2_30_20070420_12448_lHdSMR (Windows XP 5.1 build 2600 Service Pack 2)
CPU=x86 (1 logical CPUs) (0x7feec000 RAM)

JVMDUMP006I Processing Dump Event "gpf", detail "" - Please Wait.
JVMDUMP007I JVM Requesting System Dump using 'C:\Program Files\IBM\RationalSDLC\ClearQuest\cor420090203.204804.9372.dmp'
JVMDUMP010I System Dump written to C:\Program Files\IBM\RationalSDLC\ClearQuest\cor420090203.204804.9372.dmp
JVMDUMP007I JVM Requesting Snap Dump using 'C:\Program Files\IBM\RationalSDLC\ClearQuest\Snap0002.20090203.204804.9372.trc'
JVMDUMP010I Snap Dump written to C:\Program Files\IBM\RationalSDLC\ClearQuest\Snap0002.20090203.204804.9372.trc
JVMDUMP007I JVM Requesting Java Dump using 'C:\Program Files\IBM\RationalSDLC\ClearQuest\javacore.20090203.204804.9372.txt'
JVMDUMP010I Java Dump written to C:\Program Files\IBM\RationalSDLC\ClearQuest\javacore.20090203.204804.9372.txt
JVMDUMP013I Processed Dump Event "gpf", detail "".

Cause

This problem occurs when an invalid username, encrypted password, or keyfile value is used in the ClearQuest search properties XML file. The utility is not handling this situation and not presenting a valid error message. This issue has been identified as a product defect under APAR PK80022.

Resolving the problem

When configuring the search properties XML file in the Solr home directory, you must specify a valid username, encrypted password, and keyfile. For example:

INVALID

<repository dbset="MyDBset" dbname="SAMPL" username="admin" password="mypassword" keyfile=""></repository>

VALID

<repository dbset="MyDBset" dbname="SAMPL" username="admin" password="3ncrypt3d" keyfile="c:\path\to\keyfile"></repository>
ClearQuest – How do I

Note: The password value must be the encrypted password, not your plain-text password. For more information on this and other configuration details, refer to the Full-text search configuration topic in the ClearQuest Information Center.

98. How do I – understand the usage of command line interface 'cqtool run_query' in ClearQuest 7.1

The command line interface cqtool is used to carry out ClearQuest tasks that you would normally do in a graphical client. The tool exists in version 2003 on UNIX platforms, and in 7.1 for all supported platforms.

Answer
When running the cqtool command in non-interactive mode, you have to give the sub-command first before giving the login arguments.

Note: Do not use the password as the last argument if the password is blank.

On Microsoft Windows, here is the syntax for this command:

cqtool run_query "<query>" -u <user> -p <password> -d <user database> -s <connection name>

Here is an example of this command execution:

cqtool run_query "Public Queries/All Defects" -u admin -p "" -d SAMPL -s 7.0.0

On UNIX- and Linux-based platforms, you have to escape the double quotes for the query argument using backslashes (\), like this:

cqtool run_query "Public Queries/All Defects\" -u admin -p "" -d SAMPL -s 7.0.0

99. How do I - create a dynamic filter query that would filter on multiple owner login names

To create a dynamic filter query that would filter on multiple Owner login names, you can add the "Owner.login_name" field within the "Select fields to use as query filter" dialog window. The respective filters must be grouped together using the "Or" operator. Select each filter as a Dynamic filter. For example:

1. Open ClearQuest, from the menu bar, select Query -> New Query.
2. Within the "Choose Record Type" dialog window select the appropriate Record Type (For example: Defect)
3. Select OK.
4. Select Next from the ClearQuest Query Wizard window.
5. Within the "Define how the query displays" window, add the desired field(s) to the "Display Format" cells by double clicking each field or by dragging each field listed under "All Fields" and placing them into the "Display Format" cells.
6. Select Next from the "Define how the query displays" window.
7. Within the "Select fields to use as query filters" window, expand the Owner field by clicking on the "+" sign that is to the left of the Owner fields.
8. Add the number of "Owner.login_name" fields to the "Filters" window that represents the number of Owner login names the query should return. To add the "Owner.login_name" fields to the "Filters" window, double click "Owner.login_name" field or by dragging the "Owner.login_name" field listed under "Fields" and placing them into the "Filters" window.
9. Select Next.
10. Within the "Define filters query" window, right-click the filter icon associated to the first "Owner.login_name" field, select Group from the shortcut menu.
11. Click the second "Owner.login_name" field, drag and release "Owner.login_name" field name on top of the first "Owner.login_name" field icon. A second group is now created using the "And" operator.
12. Click the third "Owner.login_name" field, drag and release "Owner.login_name" field name on top of the second "And" operator.
13. Repeat step 12 for each "Owner.login_name" field that is listed within "Define filters query" window.

14. Right-click the second "And" operator that group all the "Owner.login_name" and select the "Or" operator.

15. Select each "Owner.login_name" listed under and then select Dynamic filter option button.


The Dynamic filter window is now launched and a tab is created for each "Owner.login_name". Type the different Owner name in each tab and select OK.

100. How do I - create a query listing active users
The following steps detail how to create a query that returns all active users in ClearQuest:
   1. Create a new query on the Users recordtype.
   2. Edit the query
   3. Select login_name from the Fields listing, as a display field for the query.
   4. Click the Next button.
   5. Select the is_active field to filter on and click the Next button.
   6. Set the Operator Equal value as 1 (1 is active, 0 is inactive), and click the Run button. Right click on the query and select Save to save the query.

101. How do I - export or import more than one query at a time in ClearQuest
You cannot export more than one query using the ClearQuest GUI. There is a command line tool called the bkt_tool that allows multiple query and other objects to be exported from ClearQuest. See Appendix E of IBM Rational ClearQuest Administrator's Guide for more information on how to use the bkt_tool command line tool.
A request for enhancement (RFE), RATLCO1014608 exists to enhance the ability to allow the exporting and importing of multiple queries in ClearQuest.

102. How do I - create a query on the Duplicates and Duplicate Of fields
The ClearQuest standard queries do not allow you to display Duplicates and Duplicate Of fields values.
As a workaround, you will need to modify the query SQL statement, using the following example.

Notes:
- This solution is for guidance only. The SQL statements may or may not work with your schema. You may need to make additional changes to the SQL statements.
- Queries edited with SQL Editor might not run on ClearQuest Web. See technote 1215101 for details.
- ClearQuest queries edited in the SQL Editor do not work in Crystal Reports. See technote 1152328 for details.

To create a query which returns Duplicate parent and child information in the result set:
   1. Create a new query.
   2. Select the ID field to display and select no filter fields. Run the query.
   3. Select the 'SQL editor' tab next to the 'Display editor' tab.
      Note: If you cannot see the 'SQL editor' tab, select View > View SQL pane from the menu. Then the SQL editor tab will become available.
   4. Make a change to the SQL command in the SQL editor tab. You will be prompted to confirm to continue.
   5. Select Yes and the SQL command will become editable.
   6. Replace the SQL command in the tab with the following SQL command using 'Ctrl + V' to paste it.
      A. To show all the records in duplicate state and include their parent IDs in the result set:

        ```sql
        select distinct T1.dbid, T1.id, T2.id as "Duplicate Of"
        from Defect T1, Defect T2, parent_child_links l
        where T1.dbid <> 0 and (T1.dbid = l.child_dbid
        and l.parent_dbid = T2.dbid and l.link_type_enum=2)
        ```

      B. To show all the records which have duplicate records and include their duplicate IDs in the result set :

        ```sql
        select distinct T1.dbid, T1.id, T2.id as "Duplicates"
        from Defect T1, Defect T2, parent_child_links l
        ```
Run the Query.

103. How do I – understand Aging Charts - criteria for selection

When you select the state criteria, ClearQuest is choosing all records that first entered that state during the selected interval.

To see the details of your query, turn on the SQL Pane by selecting View -- SQL Pane. Note for a typical report the criteria includes when "not history.new_state = history.old_state and history.new_state in (<selected state>)". This indicates when the record entered the selected state. Even if the record was in the selected state, it would not meet the criteria during repeated Modify actions where the record state does not change. You may also see unexpected results if your state transition model allows for records to re-enter states. For example, if you want to see all the records that were closed during an interval, you may see records that are not currently in the Closed state yet did enter the Closed state at some time previously.

If you want to see the individual record IDs that are contained in the report, select "id" for Field 2. This works best with small record sets.

104. How do I - restrict users from editing public queries

For users to modify public queries, they must be granted the privilege of Public Folder Administrator.

To change an individual ClearQuest user privilege:

1. Open the CQ Designer using super user account, and from the menu bar select Tools > User Administration.

2. Next, select the user name and select User Action > Change Privileges. Check the Public Folder Administrator privilege and click OK.

   Note: When a user is created, they are not granted this privilege by default.

Upgrade the database(s) to apply the new privilege for the user by DB Action > Upgrade.

Charts and Reports


Cause

This technote provides answers to common questions regarding the Report Server for ClearQuest, introduced in version 7.1.

What is the Report Server for ClearQuest?
The Report Server for ClearQuest is a web server application that allows organizations to manage and share their ClearQuest data-pull reports.

What are its capabilities?

- Basic access control
- Run reports
- Manage reports and folders
- Save and share report snapshots
- Export reports to PDF or Word

Which report providers are supported?

For ClearQuest 7.1, the Report Server for ClearQuest supports management and execution of reports constructed with BIRT and Crystal Reports.

Can other enterprise report providers be used for managing ClearQuest data-pull reports?

Yes. Reports constructed using the data-pull model can be managed using an enterprise reporting server that supports the target reporting engine.
ClearQuest – How do I

What versions of BIRT are supported?
BIRT 2.2.1
BIRT 2.2.2

What versions of Crystal Reports are supported?
See technote 1216371 for more information on Crystal Reports support.

What is the Security Mechanism? (authentication)
User authentication is performed using a ClearQuest database. During report server configuration, the server administrator updates a configuration file to include the connection information for a ClearQuest database that is used for user credential validation. All user validation is performed through the ClearQuest API.

Is LDAP authentication supported?
LDAP is supported if the ClearQuest database used for authentication is configured to utilize LDAP. All user validation is performed through the ClearQuest API.

What artifacts are managed by the Report Server for ClearQuest?
The Report Server for ClearQuest manages reports created in BIRT or Crystal Reports. For BIRT reports, the Report Server for ClearQuest supports creation and management of report snapshots that are saved representations of formatted report output.

How are the artifacts managed?
The Report Server for ClearQuest uses the Jazz API to manage report design artifacts in a Derby database that is provided with the report server.

Can report designs be saved using another database management system?
No. For ClearQuest 7.1, report designs can only be saved in Derby databases.

Are there facilities for backing up the Derby database that stored the report designs?
Yes. For information about backing up Derby databases, see http://db.apache.org/derby/docs/10.0/manuals/admin/hubprnt43.html.

Does the Report Server for ClearQuest support Multisite replication of report server sites?
No. Multiple Report Server for ClearQuest instances can be deployed, but each instance is independent and data stored in the different instances is not propagated to the other instances.

What platforms are supported?
See technote 1294762.

What browsers are supported?
Internet Explorer 7
Firefox 2.0.0
Firefox 3.0

Are report designs stored in ClearQuest?
No. The report design files are stored in a separate Derby database provided with the Report Server for ClearQuest. Only the report designs are stored in the Derby database. When executing reports using Report Server for ClearQuest, ClearQuest data is always pulled directly from the ClearQuest database using the ClearQuest Reporting Driver.

Where are report artifacts stored?
Report files are stored in a Derby database provided with the Report Server for ClearQuest.

How is the Report Server for ClearQuest deployed against ClearQuest systems with multiple schema repositories, or systems with multiple databases created against a given schema repository?
Reports are managed by the report server (not in ClearQuest). Each report specifies connection information to retrieve the runtime data from ClearQuest. While user authentication for the Report Server for ClearQuest is performed against a single ClearQuest database, the reports themselves can pull data from multiple databases.

If you have users in multiple schema repositories running reports on a single Report Server, you must add all users that require access to that Report Server instance (to the database you have chosen to use for authentication for the Report Server). The Report Server instance uses a single ClearQuest database for access control. Otherwise, you will need multiple installations of the Report Server.

Once access to a Report Server is gained, a user can only run a report for which he has credentials to the data source or sources that are in the BIRT report. If you then try to run a report using a data source that you do not have access to, you will get a data connect error.
ClearQuest – How do I

Does the Report Server for ClearQuest support the same scaling patterns as ClearQuest Web? Can you deploy multiple instances of the Report Server for ClearQuest behind a load balancer?

You can deploy multiple Report Server for ClearQuest instances behind a load balancer. However, since the report design files are accessed by Report Server for ClearQuest locally through an embedded Derby database, there is no way to load balance the entire system.

How is the report hierarchy in the Report Server for ClearQuest related to the artifact hierarchy in CQ core?

There is no relationship. The Report Server for ClearQuest is a separate web application and report designs are managed using a Derby database that is separate from the ClearQuest database where the actual data is stored. The report server supports the notion of “Private” and “Shared” reports. This concept is very similar to the ClearQuest “Public Queries” and “Personal Queries” concept. The report server does not expose full ACL capability. However, execution of reports is regulated by the ClearQuest security model which does support ACLs. When a report is launched from the Report Server for ClearQuest, the logged in user’s credentials are passed to ClearQuest in order to execute the queries that a report requires. Access errors occur if the user does not have visibility or sufficient privileges to run the queries used by a report.

What web servers are supported?
The Report Server for ClearQuest is deployed to WebSphere Application Server.

Is user management transparent to the Report Server for ClearQuest, or must you take special action in the Report Server for ClearQuest when users change?
The administrator must initially grant ClearQuest users access to the Report Server for ClearQuest web site. When new users are added to ClearQuest, they must specifically be given access to Report Server for ClearQuest also. The administrator can also remove users.

Where can I learn more about the Report Server for ClearQuest?
See the ClearQuest Information Center.

106. How do I - run Charts and Reports UNIX with ClearQuest Web

The ClearQuest release notes do not explicitly explain how to setup ClearQuest Web on UNIX to run chart and reports. The ClearQuest Web servers on UNIX must use a ClearQuest Request Manager service running on a Microsoft® Windows® server for reporting to work.

Setting up chart and reports to work with ClearQuest Web UNIX.

Note: In this example ClearQuest Web services are using port 1130. Also in this example, ClearQuest Web services are installed on a UNIX server and the ClearQuest Web services and Crystal Enterprise Embedded Edition (CEE) for ClearQuest 2003.06.13 - 2003.06.16, or the Crystal Reports Server for ClearQuest 7.0, are installed on a Windows server(s).

1. Install the Rational ClearQuest Server component on a Windows machine. Do not install the Rational ClearQuest Web Application on this machine.
2. Connect to ClearQuest Web on the UNIX server with your browser, go to Site Configuration, on the Reporting Options tab add the machine name or IP address of the server where CEEE is running.
3. On the UNIX server modify the file: /opt/rational/clearquest/cqweb/cqserver/config/jtl.properties so that the following line has the following parameters:
   JTLRMIREGISTRYSERVERS=UNIXserver:1130,windowserver:1130
4. On the UNIX server modify:
   /opt/rational/common/rwp/webapps/cqweb/WEB-INF/classes/jtl.properties so that the following line has the following parameters:
   JTLRMIREGISTRYSERVERS=UNIXserver:1130,windowserver:1130
5. On the Windows server where the Request Manager is running, modify:
   C:\Program Files\Rational\ClearQuest\cqweb\cqserver\config\jtl.properties so that the following line has the following parameters:
   JTLRMIREGISTRYSERVERS=UNIXserver:1130,windowserver:1130

Restart all ClearQuest Web and Rational Web Platform services on all servers after resetting parameters.

Note: The ClearQuest Web server also requires that PORT 1566 must be open for reports to run. See technote 1256786 for more detail.

Crystal Reports/BIRT

107. How do I – understand about the additional support resources for BIRT or Eclipse

What are your support options for Eclipse and Business Intelligence and Reporting Tools (BIRT) issues that are causing problems in IBM Rational ClearQuest?
ClearQuest – How do I

Cause
Some problems cannot be addressed by ClearQuest Support, because the problem is caused by a third-party tool or technology. Such is the case with reports when using BIRT reporting technology.

Answer
If a problem has been determined to be specific to BIRT or Eclipse, you can use this site to research it further.

http://www.eclipse.org/birt/phoenix

This site is the official channel for Eclipse-based Support. You may find existing defects and change requests, as well as their status. You can also submit new defects:

https://bugs.eclipse.org/bugs/query.cgi


The Crystal Reports installation program defaults to C:\Program Files (x86)\Business Objects, however the following error message occurs:

The Crystal Reports Server install directory 'C:\Program Files (x86)\Business Objects\' is invalid. The Crystal Reports Server install directory may contain only alphanumerical characters, spaces, dashes, and underscores.

Cause
The Crystal Reports Server XI software included with ClearQuest is not supported on 64-bit operating systems.

Resolving the problem
The Crystal Reports XI must be installed on a 32-bit operating system. For more information on Crystal Reports support in ClearQuest, refer to technote 1216371.

109. How do I – understand the frequently Asked Questions for Crystal Reports in ClearQuest 7.1

What is new with the use of Crystal Reports in IBM Rational ClearQuest 7.1?

What versions of Crystal Reports are supported?
See technote 1216371 for information on Crystal Reports support.

Is Crystal Reports runtime packaged with ClearQuest?
No. The Crystal Reports runtime is not automatically installed with ClearQuest.

How do I install Crystal Reports runtime drivers?
Required Crystal Reports runtime components are available to ClearQuest users as separate downloads from the Business Objects web site. The ClearQuest Information Center contains information about the various Crystal Reports requirements and install options.

- For executing reports on the client, installation of the Crystal Reports Report Designer Component (RDC) is required.
- Configuration of the Report Server for Crystal Reports requires the Crystal Reports Java Reporting Component (JRC).

What are the licensing terms for downloading Crystal Reports runtimes?
Business Objects licenses the RDC to ClearQuest client customers. Users will need to register with Business Objects in order to download the runtimes. Read the full license agreement on the Business Objects download site.

The Crystal Reports Java Reporting component (JRC) can be redistributed within your organization. The JRC uses a concurrent processing license (CPL) model enabling the Report Server for Crystal Reports to support 3 concurrent requests. Additional requests are queued until one of the three concurrent requests completes.

How do I configure Crystal Reports for data-push?
After installing the Report Designer Component (RDC) on the client machine, Crystal Reports can be run from the ClearQuest Windows client or the ClearQuest for Eclipse client with no additional configuration.

The Crystal Reports Java Reporting Component (JRC) is required to complete the configuration of the Report Server for Crystal Reports component. The ClearQuest Information Center online help contains...
ClearQuest – How do I

detailed information about the required configuration tasks.

How do I configure Crystal Reports for data-pull?
Crystal Reports can be used to create ClearQuest data-pull reports using the ClearQuest Reporting Driver. In Crystal Reports, the ClearQuest Reporting Driver is configured as a JDBC data source. The Java archive files that comprise the ClearQuest Reporting Driver must be included in the Java classpath for Crystal Reports. The required modifications to the Crystal Reports configuration file crconfig.xml are described in the ClearQuest Information Center online help.

Can I use Crystal Reports sub-reports?
Sub-reports can be used in reports constructed using the data-pull model. However, ClearQuest data-push reports do not support this capability.

Can I migrate from data-push to data-pull? How?
Yes. A migration utility is provided as a separate download to help convert Crystal data-push reports to ClearQuest data-pull reports. Also, the migration tool includes documentation containing step by step instructions for those who wish to manually migrate their reports to data-pull.

Can I continue to use ClearQuest with Crystal Reports as I used it in prior versions of ClearQuest (i.e data push)? What are the limitations?
Yes. The Crystal Reports runtime must be downloaded and installed separately.

Do I need to purchase a Crystal Reports license?
Rational ClearQuest customers can download the required Crystal Reports runtime executable from a website created specifically for licensed ClearQuest users. See the Rational ClearQuest online help for download details and usage terms. For maintaining Crystal Reports report formats and creating new report formats, it is necessary to purchase a supported version of Crystal Reports.

If I have a report format created with prior versions of Crystal Reports, will it be supported in v7.1? How?
Yes. The options for running existing Crystal Reports varies based on the client being used.

- Users of the ClearQuest for Windows client can continue to run Crystal Reports by downloading and installing the Crystal Reports Report Designer Component (RDC). See the ClearQuest Information Center online help for download details and usage terms.
- Users of the ClearQuest Web client can continue to run Crystal Reports using the Report Server for Crystal Reports component that is included with ClearQuest.
- Users of the ClearQuest for Eclipse client have two different options for running their existing ClearQuest reports:
  - Download and install the Crystal Reports Report Designer Component (RDC). This will provide the same behavior that is available in ClearQuest releases prior to 7.1. See the ClearQuest Information Center online help for details about downloading the RDC.
  - Run reports on the Report Server for Crystal Reports. Using this option, ClearQuest for Eclipse users provide the report server URL in the Reporting tab of the ClearQuest for Eclipse Preferences. When reports are launched, ClearQuest for Eclipse launches the report execution request on the Report Server for Crystal Reports, and the rendered results are displayed in the Crystal Reports viewer.

What is Report Server for Crystal Reports?

Note: The Report Server for Crystal Reports is an optional ClearQuest server component that can be used to render ClearQuest reports.

The Report Server for Crystal Reports supports execution of reports constructed with Crystal Reports version 10 or higher. Report formats constructed using earlier versions of Crystal Reports must be re-saved using a more recent version of the Crystal Reports designer.

On Windows servers, the Report Server for Crystal Reports can be used to run traditional ClearQuest data-push reports as well as data-pull reports built with the ClearQuest Reporting Driver. On UNIX servers, only data-pull reports are supported.

How do I run Crystal Reports using the ClearQuest v7.1 Web Client? What's new?
ClearQuest reports can be launched from the ClearQuest web client. The web client invokes the Report Server for Crystal Reports to render the report. Configuration of the v7.1 web client is similar to the configuration for v7.0.1. The administrator uses the ClearQuest Web Site Administration dialog to provide an appropriate URL for the ClearQuest Report Server for Crystal Reports. The architecture for delivering Crystal Reports has changed; however, the user experience from the ClearQuest Web client is
Consistent with previous releases.

Can I use the ClearQuest for Eclipse client to launch reports on non-Windows platforms?
Yes. ClearQuest for Eclipse clients can be configured to use the Report Server for Crystal Reports on all supported ClearQuest client platforms. **Note:** When reports are launched from the ClearQuest client on non-Windows platforms, the report output is displayed in an external web browser.

110. How do I – understand the incorrect alignment and format of Crystal reports in ClearQuest 7.0 Eclipse client

In the ClearQuest RCP client, reports do not appear the same as when they are displayed in the Windows client or ClearQuest Web. Specific problems include:

- Reports being displayed as one long page instead of being paginated.
- Horizontal lines included in the report format are not shown.
- A missing Crystal Reports Toolbar, making it impossible to save reports.

This issue has been identified as a product defect and has been logged under APAR PK33326. There is no work around other than to use the Windows client or ClearQuest Web for running reports.

111. How do I – create a report with running totals in Crystal Reports.

**Use the following directions to create a report with running totals:**

1. Create a simple report format using ID, Headline, and Severity
2. Author the report, using the Author button
3. Drag and drop all three fields onto the details box
4. Go to Insert
5. Insert Running Total Field
6. The Field Explorer window will appear
7. Right-click Running Total Fields, select New
8. Enter a name for running Total Name
9. For fields to summarize, select ID field in available Tables and Fields window, then click the greater than, >, button
10. For type of summary, select Count from the drop box and click OK
11. That field will appear in Field Explorer window under running total fields

Drag and drop that field in the Details Section

112. How do I – understand about the supported Crystal Reports versions for ClearQuest

**The following table lists the supported Crystal Reports Versions for authoring reports with Rational ClearQuest**

**Note:** Crystal Reports service releases for all versions are supported unless noted.

<table>
<thead>
<tr>
<th>ClearQuest Version</th>
<th>Supported Crystal Reports Versions for authoring reports</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>7.0</td>
<td>Crystal Reports 10 Professional or Developer Edition or Crystal Reports XI Professional or Developer Edition</td>
<td>Windows XP, Windows 2000 and Windows 2003 operating systems Crystal Reports XI report formats are not supported by earlier ClearQuest versions Authoring new report formats with Crystal XI Professional requires ClearQuest 7.0.1 or 7.0.0.1 with iFix01 for that version. See technote 1248579 for details.</td>
</tr>
<tr>
<td>7.0.0.1</td>
<td>Crystal Reports 10 Professional or Developer Edition or Crystal Reports XI Professional or Developer Edition</td>
<td>Windows XP, Windows 2000 and Windows 2003 operating systems Crystal Reports XI report formats are not supported by earlier ClearQuest versions Authoring new report formats with Crystal XI Professional requires ClearQuest 7.0.1 or 7.0.0.1 with iFix01 for that version. See technote 1248579 for details.</td>
</tr>
<tr>
<td>7.0.1</td>
<td>Crystal Reports 10 Professional or Developer Edition or Crystal Reports XI Professional or Developer Edition</td>
<td>Windows XP, Windows 2000 and Windows 2003 operating systems Crystal Reports XI report formats are not supported by earlier ClearQuest versions Authoring new report formats with Crystal XI Professional requires ClearQuest 7.0.1 or 7.0.0.1 with iFix01 for that version. See technote 1248579 for details.</td>
</tr>
<tr>
<td>2003.06.13</td>
<td>Crystal Reports 8.5 Professional** or Developer** or Crystal Reports 10 Professional or Developer Edition</td>
<td>Windows XP and Windows 2000 operating systems Crystal Reports 10 report formats not supported by earlier ClearQuest versions</td>
</tr>
<tr>
<td>2003.06.14</td>
<td>Crystal Reports 8.5 Professional** or Developer** or Crystal Reports 10 Professional or Developer Edition</td>
<td>Windows XP and Windows 2000 operating systems Crystal Reports 10 report formats not supported by earlier ClearQuest versions</td>
</tr>
<tr>
<td>2003.06.15</td>
<td>Crystal Reports 8.5 Professional** or Developer** or Crystal Reports 10 Professional or Developer Edition</td>
<td>Windows XP and Windows 2000 operating systems Crystal Reports 10 report formats not supported by earlier ClearQuest versions</td>
</tr>
<tr>
<td>2003.06.16</td>
<td>Crystal Reports 8.5 Professional** or Developer** or Crystal Reports 10 Professional or Developer Edition</td>
<td>Windows XP and Windows 2000 operating systems Crystal Reports 10 report formats not supported by earlier ClearQuest versions</td>
</tr>
<tr>
<td>2003.06.00</td>
<td>Crystal Reports 8.5 Developer</td>
<td>Windows XP and Windows 2000 operating systems Runtime dll files from developer edition require separate install procedure <strong>Note:</strong> Service releases not supported on the CQ Web server</td>
</tr>
<tr>
<td>2003.06.01</td>
<td>Crystal Reports 8.5 Developer</td>
<td>Windows XP and Windows 2000 operating systems Runtime dll files from developer edition require separate install procedure <strong>Note:</strong> Service releases not supported on the CQ Web server</td>
</tr>
<tr>
<td>2003.06.10</td>
<td>Crystal Reports 8.5 Developer</td>
<td>Windows XP and Windows 2000 operating systems Runtime dll files from developer edition require separate install procedure <strong>Note:</strong> Service releases not supported on the CQ Web server</td>
</tr>
<tr>
<td>2003.06.12</td>
<td>Crystal Reports 8.5 Developer</td>
<td>Windows XP and Windows 2000 operating systems Runtime dll files from developer edition require separate install procedure <strong>Note:</strong> Service releases not supported on the CQ Web server</td>
</tr>
<tr>
<td>2002.05.00</td>
<td>Crystal Reports 8.0 Professional Edition</td>
<td>Only supported on the Microsoft® Windows® 2000 operating system</td>
</tr>
<tr>
<td>2002.05.20</td>
<td>Crystal Reports 8.0 Professional Edition</td>
<td>Only supported on the Microsoft® Windows® 2000 operating system</td>
</tr>
</tbody>
</table>
The following table lists the supported Crystal Reports servers for running reports with the Rational ClearQuest Web server.

<table>
<thead>
<tr>
<th>ClearQuest Version</th>
<th>Supported Crystal Reports Server Versions for running reports</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>7.0.0.1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>7.0.1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2003.06.13</td>
<td>Crystal Enterprise Embedded Edition (CEEE)</td>
<td>ClearQuest ships the Crystal Enterprise Embedded Edition (CEEE). <strong>Note:</strong> CEEE installed on 32 bit only Windows.</td>
</tr>
<tr>
<td>2003.06.14</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2003.06.15</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2003.06.16</td>
<td></td>
<td></td>
</tr>
<tr>
<td>7.0.0.4</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Note 1:** Crystal Report Server XI and Crystal Enterprise Embedded Edition (CEEE) do not require additional licensing from Business Objects for use with the ClearQuest Web server.

**Note:** When performing the installation of the Crystal Reports authoring software, log in as the actual system administrator (Administrators or Power Users group). This ensures that the Windows Installer has uninhibited access to the entire system to run the installation script.

**Note:** Crystal Reports 8.5 Professional or Developer when used with ClearQuest 2003.06.13 or later, require the run-time dll files from the Crystal Reports 8.5 Developer to be configured as documented in the IBM Rational ClearQuest Documentation Supplement GI11-5979-05.

**113. How do I – understand the formatting problems when exporting a CQ report to Microsoft Word format**

ClearQuest uses BusinessObject’s Crystal Reports runtime files for the purposes of reading reports in the ClearQuest Windows client. Specifically, the ClearQuest Windows client utilizes the Crystal Reports "CRviewer" component to interact with that report, whether it be for the purposes of printing or exporting. One common use of the Export Report function involves the exporting of the report to a Microsoft® Word format.

ClearQuest 2003.06.00 through 2003.06.12 used the Crystal Reports 8.5 version runtime files to read reports. In this version, it was possible to export reports to Microsoft Word, which would save the file to a true Microsoft Word document format that could be edited by the user.

With 2003.06.13 through 2003.06.16, ClearQuest Windows-client by default uses Crystal Reports 10 runtime files to read reports. In version 10 of the CRviewer component, there has been enhancements made to the Export Report function. Now, when a user exports to an Microsoft Word file, the formatting of the file is completely different. While the data still looks the same, each text element in the file is enclosed in a text-box. This makes it difficult for users to copy or manipulate the data, and also creates the appearance of a border around text when it is selected.

Additionally, while the Export Report saves the file with the extension ".doc", the file itself is actually a rich-text file formatting (RTF) instead of a full Microsoft Word document.

**Solution**

This was initially investigated as a ClearQuest defect with APAR PK12746. However, it was closed because the problem involves functionality changes in the Crystal Reports software, which is not an IBM software product. However, it appears that BusinessObjects made additional changes in version XI of their software that resolves this issue.

Starting with version 7.0.0 of ClearQuest, the Windows client uses the Crystal Reports XI runtime files and CRViewer component. Now, when exporting to MS Word, the user has the option to export to an "Editable" file. By selecting this, the report is exported to a file with the text elements formatted without the use of text box containers, making substantially easier to copy and manipulate the data. It should also be noted that while Crystal Reports XI introduces an "Editable" option for CRViewer Word exporting, the file itself is still a rich-text format, and now also is stored in with an ".rtf" extension.

**Problems & Issues**
ClearQuest – How do I

ClearQuest options in the Rational Administrator are greyed out

- 
- 
- 
- 
- 
- 
- 

Technote (troubleshooting)

Problem(Abstract)
Attempts to create a new project in the IBM Rational Administrator will not work as the IBM Rational ClearQuest options from the pull-down menus are greyed out.

Symptom
Cannot select ClearQuest from the menu in order to attach a project to a ClearQuest database.

Cause
The Rational Administrator uses the old ClearQuest function calls to verify that ClearQuest is installed and to talk with ClearQuest. If you do not install the Microsoft Windows Client for ClearQuest, the Rational Administrator does not see ClearQuest installed on the machine. Starting with the ClearQuest 7.1 release the ClearQuest windows client is no longer installed by default so you have to verify this component was manually chosen during installation.

Environment
Windows

Diagnosing the problem
Technote 1322670 explains that the ClearQuest windows client is required for the Rational Administrator to work.

Resolving the problem
Verify that the Rational ClearQuest for Windows Client is installed under the Client components. If not, then modify your installation and add that component.
Eclipse designer will not start

•
•
•
•
•
•
•

Technote (troubleshooting)

Problem(Abstract)
This technote describes an issue where the IBM Rational ClearQuest Eclipse designer fails to open.

Symptom
When the designer is clicked, the loading screen shows up but when it gets to loading Eclipse core it just goes away. Killing javaw.exe as well as rebooting the server or client do not resolve the problem.

Cause
On occasion the metadata that Eclipse references gets corrupted.

Resolving the problem
Removing this cached information causes Eclipse to rebuild the metadata file and normally resolves this issue.

1. Go to your home directory for your login

   For example - if you log into the machine as Administrator, here is where you would go:
ClearQuest – How do I

C:\Documents and Settings\Administrator\.Rational\ClearQuest\designer_workspace\.metadata

For Windows 7 - The location will be:

C:\Users\Administrator\.Rational\ClearQuest\designer_workspace\.metadata

2. Rename .metadata to old.metadata
3. Then retry to open the designer

If this resolves the problem, you can delete the old.metadata folder as it is no longer needed.

Modify IBM Rational ClearQuest Web inactivity timeout value

•
•
•
•
•

Technote (FAQ)

Question

Is it possible to modify IBM Rational ClearQuest Web client re-login timeout value?

Cause

In the Rational ClearQuest Web client there is an inactivity time out after which users have to re-enter credentials to continue their work.

You want to extend this timeout, to authenticate less often. Maybe you want to set the time out equal to the session time out. That is 30 min.

Answer

You can change the inactivity timeout value.
ClearQuest – How do I

REMARKS

- The MBean: cqLoginSessionTimeout value also defines the inactivity timeout after which users have to re-login.

- The default time in seconds that an Rational ClearQuest login session persists before timing out is 1800 second (30 minute).

- Each Rational ClearQuest session employs a database connection. Therefore if you set this value too high, you possibly consume resources for longer than necessary.

- Thus if the cqLoginSessionTimeout value is 1800 second, but users need to re-login after 10 min. of inactivity, the session timeout is premature.

To test premature session timeout.

1. Verify the value of the MBean: cqLoginSessionTimeout is set to 1800 seconds.
2. Login to Rational ClearQuest and leave the session inactive for 15 min.
3. Verify if you have to re-login to Rational ClearQuest.

More information on MBean values, refer to the following Information Center article.

Setting available MBean attributes.

114. How do I – understand why you are unable to clean oplogs produced by full-text search without MultiSite

When a database is enabled for full-text searching, it is suggested that operation logs (oplogs) are cleaned to reduce wasted space. For more information, see the Full-text search maintenance and scruboplog topics of the ClearQuest Information Center. However, using the multutil scruboplog command cannot not work in a non-MultiSite environment. There are required command arguments that cannot be given to the command unless there are MultiSite components available to you.

Cause
This issue has been identified as a product defect under APAR PK82548.

Environment
This problem occurs in ClearQuest 7.1.0.x, with environments that do not utilize MultiSite.

Resolving the problem
This defect is under investigation. There is no permanent fix at this time.

WORKAROUND
A workaround for this problem exists. It requires the guidance of a ClearQuest Support Engineer. Contact IBM Rational Support for further information.

115. How do I – understand about slow performance in ClearQuest Web 7.1 with Oracle databases

The performance of ClearQuest Web with Oracle-hosted databases is slow. The initial retrieval of records is especially slow.

Cause
ClearQuest – How do I

The problem is caused by an internal query used to access the records. This issue has been identified as a product defect under APAR PK94764.

Environment
This problem occurs in ClearQuest Web version 7.1.0.x.

Resolving the problem
This defect is under investigation. There is no permanent fix at this time.

116. How do I – understand the possible causes and solutions for a 403 error thrown while setting up IBM Rational Quality Manager with the IBM Rational ClearQuest bridge connection.

When following the steps in the Rational Quality Manager Information Center article Setting up integration using the Rational ClearQuest Bridge, you encounter a 403 error in step 4.

Cause
The configuration for server setup and cross server communication setup is not configured properly.

Resolving the problem
To resolve the error, reference TN0039: Configuring Rational Team Concert and Rational Quality Manager for the Collaborative ALM integration on jazz.net. The Rational Team Concert instructions in the above-linked technote also apply to the Rational Quality Manager. Specifically:
Make sure that when configuring the public URI root, you change it to a URI root containing the hostname or IP address you want clients to use.
Make sure the root services URI is correct. To verify, open a new browser window and enter the root services URI into the address bar. You should see the root service document.
Open https://<server_Name>:9443/jazz/friends. Make sure that there are no duplicate/invalid entries in the cross server communication configuration section.

117. How do I – understand the ClearQuest LDAP commands fail when referral chasing is turned on issue

How to resolve the error, LDAP operation ldap_search_s failed with error code 1, which can occur when you use IBM® Rational® ClearQuest® 2003.06.15 or above. This error could occur during the validation step of LDAP configuration with an active directory LDAP server.

Cause
Full text of the error when running the command:
installutil validateldap 2003.06.00 cqweb_srv CQPass cqweb_srv CQPass
Invalid Credentials: Either the login name or the password is incorrect. The LDAP server returned this error: LDAP operation 'ldap_search_s' failed with error code 1. Description: Operations error.

Solution
If you start your LDAP base search path at the top of the tree in an active directory server, you will normally receive a bad referral as the server tries to search all containers at the top level. This is normal. However, ClearQuest will fail validation if a bad referral is received. When searching from the top level of the LDAP tree in an active directory server, referral chasing needs to be disabled. Installutil commands for LDAP in the 2003 (except 2003.06.16) versions of ClearQuest did not allow the usage of the parameter to disable referral chasing. Including the -R parameter at the end of the installutil setldapinit command typically will disable referral chasing for that command, but it is ignored by ClearQuest. The -R parameter needs to be inside the quoted part of the command in order to be recognized, for example:
installutil setldapsearch dbset1 bob_admin bob_pw
"-s sub -b ou=hr_dept,o=ibm.com mail=%login% -R"

This issue was a reported defect, APAR IC47507 in ClearQuest, and was resolved in the 7.0 and 2003.06.16 releases. The -R parameter will disable referral chasing for that command when it is specified.

Note: For older versions of ClearQuest, upgrade to the latest release.
If you are using ClearQuest 2003.06.15, first verify that the user’s information is correct and has the proper privileges.
1. Verify that the user information on the user’s LDAP worksheet is correct.
2. Verify that the user specified during an installutil setldapinit command has the proper privileges to search the path specified by the installutil setldapsearch.
3. If using Active directory, make sure you are not starting your search path at the top of the LDAP directory tree. This will result in a bad referral at this level which will return the error code 1.
ClearQuest – How do I

Where possible, you should start your search one level down, for example: org1.domain.com, not domain.com
If both steps 1 and 2 above are confirmed and you confirm that in step 3 they are searching from the top of the tree, then referral chasing needs to be disabled using the -R option.

Note: ClearQuest 2003.06.15 does support LDAP with referral chasing enabled on the LDAP server. However, in such cases, the base search path cannot start at the top of the LDAP tree. If you must start at the top for a base search, then referral chasing must be disabled for validation to be successful. Referral chasing is not required for LDAP; it normally is only turned on in a large organization where the load on one server would be too great. Referral chasing helps to load balance the LDAP servers.

118. How do I – understand the resolve E-Mail notification in ClearQuest is not working when port 25 is blocked issue

Verify that Anti-virus or firewall software is not blocking port 25. To test, run the following command from a Windows command prompt:

telnet <SMTP server> 25
If this command fails, make sure any Anti-virus or firewall software is not blocking port 25. For more information on configuring Anti-virus and firewall software, contact your software vendor.

119. How do I – understand why the To Groups used by e-mail rules must contain e-mail addresses

E-mail Notification based on rules that have groups in the To Groups field is not working. The E-mail rule is active. Other rules are sending e-mails.

Cause
This can be caused by one or more users in the group with no e-mail address defined. The To Address field therefore contains empty addresses and is not valid. E-Mail address are required for e-mail notification in ClearQuest to complete.

Resolving the problem
To resolve this issue, verify that all users contained in the group specified, contain e-mail addresses:

1. Open the ClearQuest Designer.
2. Open User Administration from the top menu and select Tools - User Administration.
3. Double-click on the Group added in the E-mail rule.
4. Check the e-mail address of every user in the group.
5. Update any users that have missing e-mail addresses.

Update any changes to your user databases.

120. How do I – understand the import Tool fails to import the duplicate relationships between defect records issue

There is a defect in the IBM® Rational® ClearQuest® Import Tool. When importing records that records flagged as duplicates, the Import Tool fails to import the linkage to the duplicate records.

Cause
A user exports defect records A and B from an original database. Record A is a duplicate of B. When the user imports both records into another database, it appears that both of them are imported correctly, with record A remaining in a state of Duplicate. However, in the Resolution tab, there is no Duplicate relationship between defect A and B.

Child record does not show up on reference list after creation in ClearQuest
This technote addresses a problem in the IBM® Rational® ClearQuest Client for Windows, where upon creation, a new child record is not immediately added to the reference list of the parent record. While the child record is committed to the database, and can be added to the list after the fact, it is not automatically added to the reference list during the initial creation.

Cause
This behavior has been known to occur if the child record-type has a field that contains a DB column name of "fldcolumn", "fldcolumn_1", or another fldcolumn name with a numerical suffix. This DB column name value can appear when trying to create a field with a name that is reserved in the back-end, or if there is a schema conflict with the field name.

Solution
To resolve this issue, in the ClearQuest Designer, check the fields of the child record-type to see if there are any that have a DB column name of "fldcolumn" or similar. If so, delete that field and create a new one with a different name, and verify that the DB column name is not "fldcolumn". Once this is done, and your forms are updated, you should now observe normal behavior with your parent/child relationships. This behavior does not occur in the ClearQuest Eclipse based client (RCP) for 7.0.

121. How do I understand the changing a reference list when updating multiple records will take all child record values from the first record and add them to the others issue

When updating multiple records in IBM® Rational® ClearQuest® and making changes to a reference list, all the child record values from first record will be added to the other selected records.

**Cause**

An example of this behavior:

1. The user selects multiple records in a query view, with the intent to update multiple records at one time. There are three records being selected.
2. Record 1 has three Customers listed in it's child-record reference list, John, Bob, and Skip. Records 2 and 3 have only one Customer in their reference list, Dale.
3. Make an update to record 1 by adding Jim to the Customer list. Because multiple records are being selected, you are is asked if all selected records are to be changed. By confirming this, ClearQuest will go through each record and apply the changes for each.

At this point, record 1 will have John, Bob, Skip, and Jim in its reference list. However, when observing the changes made to records 2 and 3, you will see Dale, John, Bob, Skip, and Jim.

122. How do I understand the Error: ClearQuest Eclipse Client Requires a ClearQuest license

Logging in to Eclipse® based ClearQuest 7.0 Client (RCP) fails with the following error message:

```
ClearQuest Eclipse client requires a ClearQuest license. Either the license server could not be contacted or you do not have a valid ClearQuest license.
```

A possible cause for error is it that the time setting on the ClearQuest client is later than the time on the Rational License server. Thus the license received is already "expired".

**Solution**

To resolve this issue, check the time on the client and set it to be in sync with time on the Rational License server.

123. How do I understand the ClearQuest Submit Date is not capturing the time of day issue

Issue can occur in IBM® Rational® ClearQuest® (CQ) where the submit date might not capture the time of day. When using VB Script as the schema language, the submit date times might not be accurate, and might even be on different day, after being converted to GMT.

**Cause**

The VBScript (VB) function `Date` does not include a time component and defaults to the back-end database default time. This is only a problem for VB as the Perl default value does record both the date and time using the `GetCurrentDate()` global script.

The **Default Value** hook that is defined in the Out Of The Box (OOTB) schemas for the Submit Date is:

```
SetFieldValue fieldname, Date
```

This results in something like this for April 4, 2007:

```
```

**Solution**

It is possible to update the default value hooks to include the time value. To add the time value to the code, change the **Default Value** hook for the **Submit_Date** field from:

```
SetFieldValue fieldname, Date
```

to:

```
SetFieldValue fieldname, Now()
```
ClearQuest – How do I

This will result in the expected behavior returning a value such as:


This issue has been identified as a product defect in the OOTB schemas and has been logged under APAR IC40549.

For more information on Dates and Times in ClearQuest 7.0, refer to the online help or go to the ClearQuest 7.x information center.

124. How do I – understand why a ClearQuest installation on RedHat Linux 5 fails

Installing ClearQuest 7.0.1 on RedHat Linux 5 fails, and the following error is captured in the log file:

IHS full installation in progress....; This may take a while.
ERROR: /opt/rational/common/rwp/IHS_tmp/IHS/install failed

Cause
ClearQuest uses the IBM HTTP Server (IHS) 6.0.2 for part of its web services. Additional RPMs are required for IHS to support RHEL 5.

Resolving the problem
To resolve this issue, install the following 2 RPMs, which are required by IHS 6.0.2:

- libXp-1.0.0-8.i386.rpm
- compat-libstdc++-33-3.2.3-61.i386.rpm

After these RPMs have been installed, it will be possible to install CQ 7.0.1, then subsequently install the 7.0.1 iFix01.

Run the following commands to check if these two RPMs are already installed. If they are not found, then they must be installed:

    rpm -qa | grep libXp-1.0.0-8
    rpm -qa | grep compat-libstdc++-33-3.2.3-61

The SELinux feature also must be disabled by running the following command:

    modify "/etc/selinux/config", set SELINUX=disabled

This IHS issue has been identified as a product defect and has been logged under RATLC01248717.

125. How do I – understand the remote execution of Robot scripts through CQTM

This technote lists the preconditions to run IBM Rational Robot scripts on remote computers. The test management solution here is IBM Rational ClearQuest Test Manager. The scripts are from a Robot standalone project.

Answer
First review the paragraph Prerequisites of the following technote to prepare the master computer. Integrating Rational Robot and ClearQuest Test Manager

The remote computer needs to satisfy all the conditions of the master computer, except for the ClearQuest parts. Note, that you need to install Robot and the Rational Agent Controller (RAC) too.

You need to test if you can run the Robot script from the command-line on all computers. You can read about the syntax of the command in the Robot help screen Rational Robot Command-line Options. If you cannot run the script from the command-line, CQTM cannot start the Robot script.

You also need to verify that the .project file contains the UNC paths of the Location and the TestAssetPath.

If this is not the case, you can try the following steps.

1. Unregister the project on both master and remote computer.
2. Change the Location and TestAssetPath in the .project file, so that they read the UNC paths.
3. Re-register the project in the Project Administrator on both master and remote computer.
ClearQuest – How do I

In this way the .project xml file gives the correct path to the project. Now you can try to start the script from the command-line.

126. How do I – understand that the ClearQuest 7.1 record import is missing information that was collected in previous versions

This technote identifies an issue with the IBM Rational ClearQuest Import Tool for 7.1.0.x. There is missing import information and logging that existed in previous versions.

Symptom
Previous versions of the ClearQuest Import Tool saved a log file with the results of the import. The import dialog would remain open after completion to allow you to review the status summary, the import results, the import parameters, and a reference to the log file.

While, ClearQuest 7.1 still shows some information of the import results in the Console view, other aspects from previous versions are missing.

Cause
This issue has been identified as a product defect under APAR PK85085.

Resolving the problem
This defect is under investigation. There is no permanent fix at this time.

This website is published “as is”. There is no warranty of any kind (express or implied) as to the operation of our site, the accuracy of the information or the services or products referred to on it. All warranties are excluded as far as permitted at law. Neither we nor any third party will be liable for any losses or damage that may result from use of the website or as a consequence of any inaccuracies in, or any omissions from, the information which it contains.

---------------------------------------------------------------------------------------------------

SAMECS
Soft Asset Management Enterprise Computing Services
Register in England No: 4824835

---------------------------------------------------------------------------------------------------

Registered Office:
SAMECS House
22 Sparrowhawk Way
TELFORD TF1 6NH
Tel: 01952 248593
Web site: www.samecs.co.uk
E-Mail: support@samecs.com